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O—FZEO0—F 45— A0 hoDbEEL TRTZTIES

5a. make (ko> TRITEN/T/NAS5IAVINRES O ITFAINEFELRET S

ZOFEERDIL, V—Aa—REa ANV TBERCAN T AT BINFIT T B~ Reg e, nl
Ty ANVBFHETDVENRHVET, ZNHOILRHEELRIvURIT, BHEWVOI A Z TR LTI
T&NTa~ U R TF, Fo, a2 A TIPS ITAR RS S Biffakt A% Efg 2B 539012, 7
SLINIOEF G| X Ta<v RS EITRDET,

AA a7 DVERIZ DD EEEO T a ' ALE /VRREIZE > TRE B D720  Z2TIEE DB
WZDOWTZITFILE T, make NWEITINDHEE EARICKERF T~ R I DR IZRR
SNT=OBIZEATENE T, AT O— R AR T IET, 2—RE2a32 73113 % make ZELEIL
T BRENTETAR U RET 7AW Y T T Y ETV X AL 7T HZETT, make % -silent °-quiet @
JORFA T2 a T TIATL CODEA L, ENOE NI T, make 3w RERRIIL TR
FLERSNADINTT DR ENHVE T, make NEITH OV RERRSELHIDTT DI, B4~
Lar BT AN ENSLG A NHVET,

ZOFETIIFAT O i@ LT — 2 —AEBNEZIAFINDD T, A 70D SR E
DOEEINRAIEIT/RVET, Lol make DE /LR BMER LW ey =/ MR ICL<# AT 254 .
V=R T FAJVINTL IR VE IR THY -l -D, U T TarBar _AZ\ESNTOUE, 2o 5%
DB TY,

5b. FFLLVT—58/—XDEMEEET S

Data Sources % A 717 % B & %9 (A==—[Project] > [ Data Sources]) , BEfFDT —# >/ —ADFHIE
PEETHO TR, Tad = VNI LWTF — 2 —2Z BN A2 a8 E T A2, A7 a s o
/240> Data Sources D F 285 [+ new data source] 8 R L £9°, ZiUTH LW oy =/ THY ., BE
EOT —ZEHAETELIRN 8 | BN ATRE A 7 2 a2 X2 T,

5¢c. X100 56 DHHEFZERT S

IR D AT~ 71, Data Sources & A 7 07 DA TTOMEZEIZ/R0ET, EEIZH5, Select Data Source
Type EWVDT UL D A== —7RZ 75, [Source Files] > [Make Based] > [Extract from Makelog] i3
WRUFET,

AA a7 pHOIMICE ST, XA 77 AN —1HEOT —5# ) — AP BN TERIILTODDH 4
IR CTER T, ZOBE T, BFEOT —& Y — A3 T _XCThbhEd, 74— AN ARIC kD
L WNIDNTT BT | DT —5 ) —ANEE RS IV TN A IZD A Extract from Makelog 73
BIRATRRIC S NE T,

ZOHEIZESTERSINZT — 2V —RAUSMNIE, 7oy = MNGEILIZWT — 2 — 2355034 L
NFEREA, TOIDRGEITIL, BINT —2 ) — RGO 7 0y 2 7B L THND,
ComboProject BREA L C 2 D7 a Y=/ M A RSG50 03 72 7 15T, GELIE, =—%
HARD A RT7ay e/ | OFEEZSZ LU TITZSNY, )

5d. X700 DERTEEET S
Makelog %~ ®[Makelog file] 7 +—/VRIZ, 07 77 A NDT VISR T 7 A N2 % NI ET,

5e. BMIDIANNAFH T3 E)—XFF 541 T3 #EF TS

B, Options 74— ARIZZEDOFFIZLET, A 707 ITHBLT %A1, -D, -U DI /A TF T >z %
T_CHBBICHIE S E T, LAL., Imagix 4D TOY —Aa—KROfffr ol L izhas 34
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T ar D—ERA A \ITEPITORWE S T2 TERDEIZAZENTEET, £/, Imagix
AD YV —AT FIAPF T ar A LB SITT LB TEET, GELUT, 2= A D7
FIAFOMESLEA TV ay | OEESRLTTZEN,)

Sf. BRERILI /I AR EITET S

T 5230 AT R OE IR DX~ T Ty b7 — LR EL £, Compiler & Target 2> 7R
JANEE T o3 A TLH—F Y OMBA G DR NHLG AT, TNERIRUET, FEWGE
(ZiE, 3a 2D, WY as RATERET 7 AN AR T HIEEBTTOLET, HDHVIEL, Bifto=a
ARy 7 AT other Z IR L £ 7, other ZRINL725-E121%, Options 74— /LR IZHE BREY 72 A7 2 a0
ERRETALERHVET (5e ),

59. MEB)—NFLE2—LTEETS

Processing Rules # 7|21, A7 Ofgir &G RO A E D LNATINZEHIEH T H—#H DL —/L
DERSNET, V=N EA/a T tRBE5bE TRBETZEZES T, A7 oEXITHEET 5V
— VR EEFRE T HIENTEET, B % O% BB T 20X, H— VE L — O LB EiSE
T2EEITBINDY — VT o7 B LU TTESNY,

SIS, OB LALEL O (A, BUEDRIEE SR LIAL 707 OILBRE RA -0 (T
B 5i). 2D TR > T — VS BT DTS TLED, FERICII T ST, 20 FIAEHRDE
FEEBTRETT,

Sh. X7oO  #MET S
ZIVTA a7 BB DM N CEE LTz, X AT 7 O T iEIZéd 5 Process Makelog #2727 L E T,

5i. BEFLE2—L THE/N—/LFHXRT S

Imagix 4D 1%, A7 a7 WEEROLE 2— T 270 — Ry 7 DY — 2% WO 2 TOET,
ONZFIREINDA L D —2% BRI SINT ) — AT 7 AN D EVANT DE AT TF,
ZDEALTaTNG, TP VMR EE LR T HIENFRE T, D FEITETIRUIZEE . &4 D
7 —4>—A|% Data Sources % A 7 27 DIEMPNZH DI AN ERSNET, ZNHEIVvITHE &
DY —=AT7 7 ANVISTERNS = ODNTIMZ T, 77 ANVERIZA, -D, -UA T T ar0E BT
ONI=DNELE 2—F 52N TEET,
FRICH B2 DIE, A a7 OB RS NS =7 T, ZiborZ i, Imagix 4D D7'ay
7T AL IR (FIE 4a)i2d 5, extract_xxx.log EWIZAMLDT 7 ANVEETT, Bl 2 a2z, a3
AT DEME, 2L ATOFEM, T AL 7N EEEME, BB OB E N EXAENET, 2hbhon
TNNE A 707 ORLER# 2 Data Sources % A 7 107 DA AN F /RS LD Status X7 BT 7B ATE
7
FEROLE 22— b — VOB IEIIAERILEETHY | fifAT AR HEEL 2 = — PRI CITO L ERH D E
o ZZUT, ZOME R JOR G T D)7 EE NS DDVRLE T,

Y—RIT7ANVERENT S

BANE A7 TSN TNDY — AT 7 A NVERFE T HDZ LT LET,

"Include files only if currently found in file system" &\ ) L— L2 MBI CIEEE RO ET, 2575
&y TAL I NFR ORI TLARTOKE RICH DN M STEDBETHNET,

V—=AT 7 AN OMBIRNGEIE, Compiler 27 2SR TTZSW, ZHUT A7 DE DTN
A AFEREAv R EE L DOEL TRESIVZDE RLET, v A FEEIa~ R R OB
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WG, T AT TR TIEEN, ZETFECI 2 A TR AR E TERRWIG AL, A
AT % AT DU ED B D ATREVED DY E T (FIE 5a), = A TEBITRMFEAET HHDD,
Compiler 27 |ZLT23 > TENDRFES ALV 545, Compiler Invocation /L—/L & =y 7L TLIEE
W FRELTEaL A Ta< U RS A7 1ZE PN T0Dav U RE—HL TWDT LA R L ET,
%7, "Commands to ignore at the beginning of line"/L — /L ZAEET AL ERHLBELHVET,

UL, oA FREa~ RS, VY — AT 7 ANV EE RONGRWIGEAIT., BFia~ R
2R 2B 2" Source file suffixes"/L— /L & EEEE L TLZEWY,

AVIRASFHFTLaEHHNT S
= A7 AV YNGRBN S N5, 2L AT T a7 O E T AL Ea—LET,

ZmDEx, Compiler Details =27 Z i R HEFHIAN T, A/ OEEDITEZ, ZINBIRELT-A
Tar b T HZENTEET, A7 al BREL TV A7 ar OIERNLE 80 TRV
A2, Compiler Options /b— /LA ELE T,

F72. Warning 227 b &SSO ZENRHYET, 2231 F1TIZ " unrecognized arg" DY ARISVREN TS
a7 var O REEETDHULENHDLD, WL<OMDA T L a3 Compiler options taking
argument” /L — /TR ERS IV TUVRWFTREME DS HY £,

AV L
EBEOFINEEL T, 7SADLE 2— LR EAT N ET,

V= AT 7 AIVDLREITE FIUCEEM T BN, -D, -U A 7Y ar 28 e 9 2050, i B¢
T AL N OAE DBIIESNAT-0 V=R T77 AV EA L I—R T 4L 7 N O 7 IZx 9 AAE% S A
BRI CTEET,

CD RZINbIE A 7a T WO EDITH ZN LD T 4L 7N DR E TSN — A%
THLDEL TRIESNDNERDZENTEET, cd ZEEENT 217372 541214, "Change directory
command"/L—/ L% FLEL TTZEW, cd EBITICHRT/SADE EHTVD5E . "Processing change
directory commands with relative paths"/L— /LA 8&IRL C, i t)7e SARNRESNDHIICLET,

B %12, Imagix 4D YV — A7 FFA P RTFAE LR — AT 7 A )V DIENT A IR 72N IS 5728
"Include files only if currently found in file system" /L — V&GN T DML ERHVET, L—/VEEHT
FTHEXX, BHEIZL S TRESNDY — A7 7 AV DBINEAL T DD EI0NTIERE L TIEEW, 1k
THEATL. Warnings 77 2B L T, 77 A /L AT AR BONBIRNT 7 A LN E N TH D)%)
ELET, LT, ZOJRRDT 7 A NV INEERIZ 72720 TNDTD TH D, 7 7 A/ SADPMLEEDERIZ
IELSHRR S AU CUNRDNS T2 T2D T oD E s Wi T D ENR D E T, /SADIRRIZ R H D56
TAVINE TN —NVEAEET DUNERHET,

PNAIZEAL T, B9 1 DERTAREADRHVET, RIS TIL, Imagix 4D 12X T I~ 572912,
V=2 —=RPAL 707 DA RREEIT R DGRBSV TOW DG E ROV ET, ZOBRIT, TR
LA SANIEETRIRDT TN T+ —LaE L TNDRE | FR A B TRAELE T, AMrmriz
okt S A4 TIEZR<FARE S AL DI E EAILTODGEIE, A SANVEREEND A 707 Zfftfra— R~
X SALRICEGATIC 2 — LT BRI SR DA /a7 L LT LWL ae — 245 E L CH IRV )b L
NEEA, HDHNE, A7 (TR SARE QDAL "Adjust paths using
vtgSys(Automount) substitution”/b—/L 2 I TEE9, B E HIEICEL TSHIZFELL

1L, ../imagix/user/sample.4Ddefaults 2L C72E0,
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5. B TOCXERSE—FEESE

il ROVE 22— &/L— )V OEIEIRAERSLIE TS, /L—/L DL F (FIE 59)FB L A7 7 OILEL(F
JIE Bh)ZATH 7= TN BTL W R Z AL Tl e 2—3 528127203, 4113, BoNTr—/v a2
OCHBL T Iur % () QBT 2 ENH LN LE 2—(FE 5i) k> THRIc BT b E
‘a—o

BHDHRF T, L — LB B EZIVTWDINZ LML, fERERDH AT 0 s R—AD
(CIC++) T —2—AEFRMMENLBWEYNT Y — A3 — R & AT D E MR LT=\WEE 2 HTLED,
ZIUIEIELARBED FIETIZHY £ A, %12 59 DL 5a lZETR-ST, FIE 5 DRI ALEE
AT T HIEL ARETT,

ERRENTZ ATl RX—AD(CIC++)T — &Y —AEFK &AL Ta—REMT CEXDIRMEIZ o725,
A A7 17 FEo Load Data Sources 227V v 7L £,

A—FEO0—F9 55— 37T Y EAIT7AIVISEMLTRITZITSEE

5a. FLIVT—L/—XDIEWMEFIEET S

Data Sources # A 7 17 % B & %9 (A== —[Project] > [Data Sources]), BEAFDT —X ) —ADHEL
BEETLIOTIERL, 7TaVzNIFHLWT —2Y — A& BN 52248 E T DI, FATr7 DL
ffllo> Data Sources @ T (Z& A [+new data source] Z3&IRL £9°, ZiUuIHL 7 mr =/ MChHy ., BEfFD
TR EAEELRWe) BRI A 7 Y a3 2l ¢,

5b. =T IrDALIT7LIADENEERT S

IR D AT~ 71, Data Sources & A7 07 DA TTOIEZIZ/20ET, EEIZH 5, Select Data Source
Type EVVHDT YLD A= =— R A 735, [Source Files] > [Make Based] > [Add Targets into Makefile] 2
B®IRLET,

5¢c. XA O771/NDEFEFET S

Makefile #~7'® Makefile 74—V RIZ, AT T 7 A NDFEEINAIT 7 AN NTTLET,

T Imagix 4D I8 ESNT- A7 7 7 ANV E T FHLUET 0, ZOEPETIX, BEEO AL I 77 AN FHL
72 L EE A, TOHAITIL, imagix.mak VD)4 iiE D T, IERDAL 777 A NV EFICT
AL ZRINCH LW T 7 A L2 L9, imagix.mak DEAIDITZRD IHTHREL TZE W

include /path/name/of/real makefile

#include Tid7e< include ZfEHL £9°, £ _E T, Makefile 7 ¢—/LR|Z imagix.mak D54/ A7 7
AN ANTILET,

5d. Imagix 4D ASAAOTF L INNIEMT EHI—G S DN—IXEFHEET S

| Make Target 7 ¢ —/LR 1% imagix DEFIZL TEWTHENENERE AN A7 77 A/ T TIZ
imagix LWL RTOZ —5 SEET 25612, ZO7 4 — VR AR O NI T T 50303
HVES,

Se. BRI NLINIBEFIEETS

AT a3 AT RO NVRDX—7 Y T Ty b7 4 — 2% ELET, Compiler&Target 22 R AR
JAER T DA NATEH = DA EDERH DG AL, ENEEIRLET, T2 E
Wi, 3alZRY, e A TR ET 7 ANEAERT D2 BT TOLET, HDHWIL, Bt
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AR Y7 AT other 2N L FE T, other ZIRINLU 7235 E5121F A7 7 7 A MIEE BRI 7 L a & 4g
ETHHENHYET(IMAGIX_FLAGS),

5t. XA OT7PAINEFINTHET S

Edit makefile (2T = 72TV T2IRBET, Z A4 712 D Add Data Source R %707 F4,
Imagix 4D MEESIIZAN T T 7 A MM T —ZIUES — 7 NaBINL . DAL T 7 7 AV DB Tl
ECTEXDHRREITRDET,

5g.Imagix 4D BFDEZ—5 VI FEET S

AT T 7 AL, B ODEF DAL I T 7 AN~ IOl ERSINTND IV ar RH0ET, _N—AH
—F b % imagix EFREL TWODIEAITIE, ZNHAS T 7 7 A~ 7a DD 3 Ok
IMAGIX_SRCDIR. IMAGIX_MAKEFILE. IMAGIX_PROJDIR T, ZHHDEFRITEHRL THEN
F A, Imagix 4D (2L > THEBINIZAERINDL DT, AT 7 7 ANEID O T ICE T 572012
HVFET(THMR),

Z—7 b imagix SFEEL TWAEE . HED 2 1F IMAGIX_SOURCES. IMAGIX_FLAGS T,
ZNDIHEETALERHVET,

IMAGIX_SOURCES
IMAGIX_SOURCES ~ 7% fit AAIT N — AT 7 A )V OUANI BT 5IIEIELE T,

EBRDOAL T 77 ANV T/ —ADYANFRFEL ET, Ziud, SRCS=fool.c foo2.c foo3.c DLHIZV—A
T7AINDYANTERREINDZELHILIE, OBIS=f001.0 f002.0 f003.0 DIHNZAT =T 7A LDV
AR TERRENDZELHVET,

V= AT 7 ANVDYANCRIRSNIZG AL, V— ARV AN B~ /a b/ 55912
IMAGIX_SOURCES #/E# L £ 7, 7L 21X, V—AN LFLDOIINTERS LTI,
IMAGIX_SOURCES ®17% IMAGIX_SOURCES=$(SRCS)EIEL 7,

F TV IR T 7 ANDYANTRRINIZEHEITIE, IMAGIX_SOURCES B2V —A7 7 A /L&
TR T AINMEELE T, 7oLz, AT Vb7 7A/VH OBIS EVOARITC, EORIET 5 —
AT 7AIVIN.cC VPRI T2 L TdEd 54 IMAGIX_SOURCES MD17%
IMAGIX_SOURCES=$(0BJS:.0=.cc) LA HEL £,

IMAGIX_FLAGS

IMAGIX_FLAGS v~/ n%a /SAZICHRINCES DAL, -D, -UF 7T a3 N TR T 589
WIEELET,

EHDOA 77 ANTA, -D, -UA 7T ar BDERIITNDEZAERBLET, B, -1 47 ar
1I-DA T varkfiiol-v /aTIESILDTLEY, 7ol X, -1 77 a3 C INCLUDES &
WO I EWD, -D AT a3 T T CCFLAGS SV W)~ 7|l &8 T35 TLr) (U7
aEM AT AZEITENTT),

IMAGIX_FLAGS DT1%, KB 53 NATERIET 7 ANV O EICH RIS I DF T var %
Imagix 4D 7 F I A HIZIET B TORIH T 2N TEET,

EROFID ST~ 7S EET HET UL, IMAGIX_FLAGS 0471 IMAGIX_FLAGS=-inc/=> /<
AFIRETEIT 7 A NDI A4 [file.inc$(INCLUDES)$(CCFLAGS) D IS IEL £, =o /A Tk E 7
FAILDERE Other LLT-HE 121 (Be BHR) | 22 T-inc DA 7L alIFmEnFti, 20T ThH
AL NATOREBR /e 7 a BRRET AL ERHVET (3a ),
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Sh. 7O EFIZ—FEES
INTTFIA T EEENT AU N TEEL, 72720, a—REHT LI LT 5L, -, -D. -UA 7 =3
YOI EDHIFICET— BN T2 LN DDON 5D T, AT —RDOOESDH 7 vy 2T
O —R T HINILITINENT LIS, DA 21T, IMAGIX_SOURCES D174 (#Z21FT) A
R TEEIZL . IMAGIX_SOURCES=fool.c DLH722 8 LW MTA AR L £,

O REFRNT T AU N CTET-D AT T 7 AN ~DE E 5517 F7 (LOCAL A==—[File]>
[Savel), A7 77 ANEAC, (EHRV 4 RUEZACET, fffT 7 220322 — £,

O—KR#0—K93——Microsoft Visual Studio Z @ L CRFTETSIES

Sa. FFLLVT—8/—XDEMEFEET S

Data Sources # 17 127 % &F 3 (A==—[Project] > [Data Sources]) , BEfFDT —4 Y —AD K E
HEETHO TR, 7aP 2 NIH LT — 2 —ZAZ BN A2 L4581 D121, #AT7as o
JE/fl0> Data Sources D T 235 [+ new data source] ZZR L £9°, AU LW Y =M THY | BE
TFEOT —HEHAEIELIe\W s | BRI eA 7 a3 23 ¢,

5b. MSVC FAaSc O, FEIFMSVC VY a—S 3 DB G %4ZERT S

LA AT 71X, Data Sources % A7 227 OARITTCOEEIZIDET, EEIZH S, Select Data Source
Type LUV T LD A= =2—RZ 75, [Source Files] > [Microsoft Visual Studio] O3&R D g
BRLET, FEO Ty NI EAM T BN 7 7 A VA —R 3 5121%,. MSVC Project Z2f# L &
T Va—Ta 2R (IR 3—Ta> 0 Visual Studio T — 7 A—2) Zr—R 3 521%, MSVC
Solution / Workspace % L %9,

5c. 73 MSVC D/IN—S7FH5F TS

Type 74— /LR OART, AL CTD MSVC D=V a 4R ELET, Bipb/R—Ta0 0 MSVC
TR T 7 ANZAT EFEHL TT Ry 2V NOIERPEANS DT N—Val B 5L &
AT T DO HEFESNET,

5d. MSVC Oz OFZ7 AN FEI-(FV ) a—32 71N DIEFEEET S

Imagix 4D TiL, 2—RIZBETDHERICES T RFED T 7 ANFA T PEEINE T, 77 ANFATTE,
Type & MSVC Version O#FUTI > THEZRDES, 72& 21X, MSVC Project & Visual Studio .NET %132
RUT5A . BEMT oD 7 7 AVZ AT X veproj 7 7 A MZ7/R0 &, oS ivb.veproj File 71—
JVRIZ, MSVC TAERSNI=7 a0y = 7hD . veproj 7 7 A VD 5E /S A% AJLET, lE D77 A
JUiE, project.veproj V)44 ATl AL MSVC 7'y =7 7 4L ZRICHVE T,

MSVC Project A1 27 7 A/ (Windows B 5E T CO A Al fE) 28R L 7235513, Makefile 71—
NWRIZ, 7ay = NHIE MSVC TARSNIEA I 77 ANDSERS AL AN LET, BHEZOT7 74
JUiE, project.mak LV H4 BT Tl B2 MSVC 7y = 77 4L 7 RIZHY £, project 1 & MSVC 7
1Y = 7D RNV ET,

Se. YT NI FANIZESETAL ORI ZIEETS

TV RA NI~ H L TODGEITIE, 2 ANV BRSO DA VT N D~ X T 7 A )V
ETe AL I N—RF AL RN T BIEHAY, MSVC 70 = 7 bk iE T I R [T > TWAZ LD
VET, ZOHAEITIL, Imagix 4D 7 F T A T~y X 77 A VDGO DI, ZIHDT L7k
VaEBH R ET 20 ERHVET,
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Options 7¢—/LRIZ, -1 (F721%-S) #E3C-Idirname Z > T, ~ X 77 AN EEFLET AL IN DT 4
LINIZ AT LET, NIRRT AT L TOEONET A, -l EHETHLT AL 74 EDRIC
1L, A—2% ANZ2WTLTEE W, T AL T4 ERD-1 EORJIZAR—A T TSN,

5f. SAN/LVMSVC O OFDREFIEETT S

Configuration > 7RAR w7 AT, EJLR L0 Visual Studio 7' 0¥ =7 hOFR EZ RN F 9, ZOER
AW (T 7 HNIDFEEID) THE WO TYH Imagix 4D 7' ey = 7 hD T — 2 NFAIND EXITIE,
MSVC 7'uy = 7 OB DR E NN SAVE T, Y a—a TIIBIEORENH I Hsn 57
B, ZOARRy T ATFIHTEEE A,

59. REGINANIREEITET S

23 AT R OPENR DS =y T Ty 74— b4 EL £, Compiler & Target 1 ARy
JAZGE BT DL ATEL = DB G DE RO LG AT, ZEERLET Basz i), #
H 1% msve_win 23R £,

5h. B 70X FX8—ISEES
I — RERNT T AU N TEXT-5, #4722 ® Add Data Source REZ 527y 7 UF9,

O—FEO0—F¥5—F (7RI EELTRTETREava)

5a. FLIVT—L/—XDIEWMFIEET S

Data Sources % A 717 % B & %9 (A==—[Project] > [ Data Sources]) , BEfFD T —#>/ —ADFHE
EEETLOTIF L, 7aY =M LWT — 42— 25 BINT D2 L2t ET DI, XA Tl o
/240> Data Sources D F 28 % [+ new data source] 8 R L £9°, ZiUTH LW oy =/ THY, BE
FDOT —HEAEIELIRWN =8 | @I FTRE A 7 L a3 iz ¢,

Sb. FAFOTEE LI GEEERT S

PABE DA77 1%, Data Sources % A 712 DAHITTOIEHIT/DET, FEIZH D, Select Data Source
Type LV VDT YLD A= 2— R A 705, [Source Files] > [Dialog Based (Java)]z i8R L F9,

5c. EHTARDY—RXIT7L/NEEET S

Source Files #7123 T Directory 74— /AR ZEHL, YV —Aa—R23H57 1L 7 N D4 HiTE AN TIL
E3 AN

) — A=K T 4L I RINZIR N> TODEA . Directory 74— /LR D3 FiZdH 5 Analyze
source files in subdirectories ZF|fH 322N TEES, ST LIV a—RR 1D T 4L I7REZDH
TTAL IR (BEOZEDOYT T AL IR)IIRB>THDEGE | i AL T AL 7N D4 FiEZ 0
Directory 74— /VRIZA DL ET, BMELIZWYT7 T AL 7N RSB L5E1E, Eib% Exclude ¥ A7 1
TIHEELE T, V= A3 —=FREDISNTT AL I NREED NI DAL TN L~ T, T L7
Wa—REEGTT AL 7N T LI FIA 5 A2 BN B A REE BV E T,

Source Files 74— /L R|Z, VY —AT77ANVDL4RTEATILET, * DL FDI%/ M —ATPEES L,

Bz 1E, *java £ HET AL ZRINDTRTD java 7 7V —EFRRESNET, EEOLFIT/H
—UNE BHTRY S TATTAZENTEET, class 77 A NVEIRETAMLEITHVERA, 77
AL, FBE LT java 7 7 A LD ENDINZE S TA R —hESb.class 77 A V% H BN FITL £ 7,
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5d. Java BEREFIEET S

E5(Z Source Files #7128\ T, Y —Aa—R D Java S B2 fEE L9, T HOSFEREN
Language 2 7Ry 7 AZY ARSIUTOUR, 2 A 3R £77, other 23R4 %L Class Paths 4~
\Zd% . jar Files DRI Import Settings (2, BIZRAVIZ —cp A7 L al Z4RET ML ENHVET (FIE
5e),

Se. 7R —RHHBDISIIZFAINELL jar FZP1L/LDBZFEIEET S

5c IZREIR L7251z, B IXHIRAIIZ Imagix 4D IZK L T T AT 7 A NVERNT T 2L HR 3540
FIHVFER A, ROV, VY —Aa—RDA LR =L L T ANV —RENTZITAT 7 A V%
P _R&E 7T ANRAEHITIRE L £, 24U Class Paths #7 CHE &SN £,

2712 %[ Import Settings for .class Files] D453 C, V7AT7 7 AND AL R —NFEEZRELET, A
VIR MERDMENTR GO java 7 7 A AIFET D6 . ZIISERSNZI T ASR|IZIY, class 77
ANERRGET DT AL 7N BHIEISIVET, DI T A% E T D0 EN DY AL, Additional
-cp flags 74— VR ZEHCEET, -cp IS ERETET AN L ThENEE A, -cp&T AL IR ED
M, AR—2% ANE T, TALZRIL ERD-cp EDORNTEH A— 2% AN TLTZEW, Windows B2
FTBEIL CWDE . T4V 7NAIZZE AN EENHEEIT dirname & &5 HEFCTH A, -cp
"c:/program files/ include" D XHIZLFE T,

2712 % [ Import Settings for .jar Files] D77 T, jar 77 ANV DAL R —MHIEITEET, ZIULE
Fhax B 7 7 AV (FIE 3a 25 ) ISFRIR SV TR jar 77 A /L DT I S4E T, Directory 74
—/LRIBLO Jar Files 74— /LR OB EIZHET D.jar 77 A /VISA L IR—bSHVET,
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T57 —X3ERSINETA, BT DI IZ-nosys O B EEDIRNETT,

Z 7 ar i, Data Sources #1717 @ Source Files #71Z&%% PP Flags 7 ¢—/VR TN, DV NE
I IRATRET TANETAIAA T T 7 AV TR E T HIENTEET,
-oFilename  fEbT#ERA T —H 771/ Filename |[CEXIA L FT

T FIAFEBIRINIRNT SIS — AT 7 AV | S OB E XM DD — AT 7 A )L
WZEFENDA~NIF T ANDIE A DN TE T AT 4 IBMRIE T — 22 LR LT, B LTHEZL
ONDLDIE, VAT AL IN—RT AL TN D~ Z T 7 AV TF (-nosys A7 var -S A7 var
DIAZH)

O T ar MERSIN CWAEXIZIE, TR TOY—AT 7 ANV R N E T AV T 557 —H0n
H—D7 74\ Filename ISV E S, ZOAT v aAd, (RO AHRMEZ TR T DIZDITFIHTE
LI TVET, -genvdb AL ar AT AL AR T LET,

A7 aid, Imagix 4D D2 —Y AL H—T A AEEL ULy hESER A,

-Rdirname  #include 77 A /L& L b T 4LV R THRZE T DRIIC dirname THRZEL E9,
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T FAYIX, #include "filename" B LERFEFICHIR L, FT-R K O-H A7 vavzillL THRES I
729 _RTOT (L ZRUT filename ZR R L F3, T THRONBZRWE ST, BL T 4L 2R
(""" THREL, TN THEE R ONSRWEEAIZE, -l M-S ATV ar THRESNZT AL 7R TH
FZLF£9, #include "filename" Ti372< . #include <filename>723Mii FH S TWVAEEAITIL, HL U MF AL
IR (" MIEAF T ENET,

R CHRESNIT AL 7NIE, A7 ar ELTHHRESN TWODIEE CHREZEINET, ZhHDT 417k
NI AT DAL I NV—=RFT AL IRIEL T, -SA T v ar THRESNIET AL 7R ERT IO b E
T, INBDT AV INET TV r—ar A I —R T AL NELTEOIWZIE, -HA T Va2 L
FT, FOHEDOFENZOWTIL, -nosys 47 v ar OIHEZRL TTZEN,

A7 a 1%, Data Sources #7127 @ Include Dirs %712 %-1, -S Flags 71 —/LK | HH N Tz )
ATHET 7 AINVEINIA I 7 7 AV THRE T HZENTEET, Windows il 7714 FIT/R O T
FETS

-Sdirname  #include 7 7 AV EFRZR T DT AL 7N DUANI dirname Z BN 5

7AW, #include "filename"FTLEFE S HEROE, T -H X O-RA T var#ilL THRESIL
72 _RTDOT 4L 7 RT filename 2R L ET, L THRODGRWG AL, IV T 4L 7R
("") TREL, TN THEE ROV EIZE, -l K-S AT var THRESNIET AL 7N T
LU ET, #include "filename" TiZ7e<., #include <filename> M IS CWAEEAITIL, AL T4
IR ("NEIAF T ENE T,

Imagix 4D 771 ¥ h3#include <filename>&#include "filename"% X5 9-2D1%, L T 4L R
BB TDDEIDE T D701 TEE A, A INV—R T AL I N ET TV r—arv A —
RF 4L ZRIELTHE S 9 DHI2IE, -Sdirname L0 -Idirname 2 AL £9, ZDHEDOEEIZOWTIL,
-nosys 47 ar DEEZ L TIIZIN,

7> a4, Data Sources % 717 @ Include Dirs #7712 %-1, -SFlags 74— /LR | DU NIALY
77 ANVTHRELET, Windows iR7 74 PIE/S bZIF T ET,

-sfx  -gencfd & O-genqcef 7 —ZIC BT DAV 7 7 A VA ISR RE A AT £

W | -gencfd M UN-genqef A1 F THERSNDT —HIT, A RIOREI TG T DAV T LDy —2
T AN KON E T 7 ANVERICHERGE T DT 7 A MRS E T, D78, — RO EE B
VAT ACREENECDATREERHD T, sk A7V aid, ¢V — A7 7 VinbERSN-T —4
.c_stx DR FEEFF O 7 7 A VTKEIISND IO, 77 A N4 D IR _stx 2Bl E 7,

7" a3, Data Sources % 727 ™ Source Files #7123 % PP Flags 7« —/VR TN, HDHU T
I RATRET 7ANETAIAAN T T 7 AV THRE T HIENTEET,

-sysincfirst < >IZE->THREINDLG X T7A DN, -| TALZRIDRHINZ-S T 4L 7R &R
RLET,

AL N—RENTZT 7 AN DG AR ET HEE T 74V NOEETIX- AT varb-SA T varn
FHESNTOWDIERF CA 2 NV—R T AL I ERERLES, 77V r—Tar~y 2774V Hiinclude
"appfileh" DI A L 7 NV—REFjL, AT LA 7 N—R 77 AV include <sysfile.h>D L5121 7
J—RENTWDEA . -sysincfirst 47 > a3 2687 7 A NVDIRBEPA L 7 )V—RT 4L IR D
FERRE R OB Y) B SNBSS DT, L RIOE RO T ZENTEET (22— LD A
TIA LI N—=RTF AL IR ET TV —ar A 7 )V—RTF 4L IR |OR® 7y ar 2D B8N,
A7 a3, Data Sources #7127 @ Source Files #7125 PP Flags 7 ¢— /LR CiIBINT 27, &
DNEIT A TEET 7 ANEINIA T 77 AV THRETAIENTEET,
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-traditional S 60 Kernigan & Ritchie # A 7L 7 AR —RLE T,

Imagix 4D 7 FTA P TIHFLAE DEE . 2—R78 ANSI C £7213 10 H VY K&R C # A7 L7 M YEHL
T HMEINEL—FRIFELTH, CI—REMTCEET, 72720, FFEDOHEREFHE TIX, 2 2D
AT LI MEOEWEDE D H BRI N2V A A MR~ 7|l G ENTCONET, T 74V T
X, 7FIAPIL ANSI C R —hLCWET, A7 a4 58 KRN R — S E
T, ZOF T g Tk -kr ZREONH T2 TEE T,

A7 ai X, Data Sources % 71 ® Source Files %7 12&% PP Flags 7 — /LR TN, HDHUNE
TNATRIET TANETAI AT 7 7 AV THRE T HIENTEET,

-trkmem  ARERIFEFERAL ROEBEEFNENBIOEE L TEILE T,

-trkmem A7 > a i, AR E R T A2 & DRI DZEH) D AL 7373 imagix-csre 142
STEDIDNTRNT ST, TDHD =P AL H—T 2 A A TBNTEIRIAINDINCHELF T, T
T A/VEOBWETIE, BEEEEDLDITR 2 DEFEL GEMLET 2, £ 5L TRIZED AN
Z 1 OOBEHITHEA L GBI £, Bi121E, varl & var2 &) 2 SO ZEE structA ) [RIC A%
Fih | structA IZA2 73 memA NG FNTCWDELET, V— DT 74V OBMETIE varl & var2 &
B A BHLET 23, varl.memA & var2.memA z —#&IZL T, B memA L TE X ET, Zhuldo
T =D OFARHIZEBWT, MIEOMRMEEL TR/ DT —F R — A TR BN L HENED
HELDHZEIZRDET, LHLenb, memA OFE L bEENZNHNTBHILIZWNGALHHTLED,
-trkmem A7 > A KD FE NV EBLTE, varl.memA IZ var2.memA ST BB THHEHRREN
7,

# 7 ar i, Data Sources #1712 @ Source Files % 712%% PP Flags 74—/ /LR TBINT 250, &
DN A TERET 7 ANVETINIA I 77 ANV THRETHIENTEET,

-Umacroname <721 macroname Z R /EFICLET

ZUET AT DF T a-U ERIL T, v /aiEfiix, 7 74P LD — A —RORiLELD—
HTY, ~ZulRIEROM., L& aL (L FES#ifdef macroname IZL > CERINZ T vy
Oa—RIfErSiEE A,

# 7 ar i, Data Sources #1712 @ Source Files #71Z&% PP Flags 74— /LR, HDWFEALT T
7ANVTHRELET, Windows iR 7744 I3/ b= T T ET,

-uaggr  BARDT7 7 AICERS NI BN DI T AE R 2 DI TALRIRLUET,

I ATOFEMER R EETIX, 7 e — LA BRIDSE A S, Rl AV (FEATRIRET 7
AV, DLL £72137A4 7 I IZH DR CA RIEFFOT X CO i 77 AR TAThHLHE RSt
F1, L, BEOIL S VBRI E N7 Y 2 M B R LW AL HHTLLY, FDX
e DAL A VELZ IV TIRAR, BRI % ThD 7T AICRIC i BT AD A HiH

HRHASN TLEIZERHVET, ZDOXH724 Bl DE 2% -vaggr 47> 2L -> ChhIE T A28 T

TFET, -vaggr 2MERHSNDE BARDT 7 A NTE RS2 T X CO R L7 T AL, T2E X RIC44 R

ThHoThR A DITATHDHERIRINET,

7 a1, Data Sources % 7 17 @ Source Files #7123 % PP Flags 7 —/LR CiBIN9 50>, &
DT SATERET 7ANETANIA I 77 AV THRIETHIENTEET,
-unique 72577 A VIZEFES I typedef Bl & O typedef A7 LT,

imagix-csrc Y —AT FIAF DT 74V OEWETIX, EHEL-AER D7 7 A R4 RTT
TEFESHT- typedel) 137 07 T30 7 EOFUEMEZIT)-72HDTHY, [FU typedef ZE KL TV DL
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TELET, B2, REWAE T 7 A )NV A7) —RLIRNIINTT D202, EfliZs typedef 73
— A7 7 ANTBMENDZERDHL B LNER A, RO A~ Z T 7 A EFTHIEE TR
THa—FT 4L T HARTA L L CTODEA T, -unique 47 S a a2 35221280, [RC4
A2 EF ORI 2 IZEFESINTZ RN F 72D typedef E L THROIND I T HZENTEET,

7 al X, Data Sources #4717 ™ Source Files # 7|22 PP Flags 74—/ /LR CiBINT 50>, &
NI A TRET 7 ANVETAIAA I 77 AV THRIETHIENTEET,

-vms VMS SFEIREE BN LET

RO ST L FEHE CICH B FE DUV DODNDF—T —RILIREZZ T £, ZHHDOIEIED
2<%, T ATERE T 7 AL D#define keyword i3 AL CTHAR—RSVET, 72720, —FOHLHE
I T#define THAR—RIILT BIMOY R — M BELELET, —HOF—TU—RIZOWNT, ZDOHHR—h
FHEMTAON-vms 7T a T,

BARMZIE, _align GEBI 1) LY align GERI1) B SHE FOMHICOWTHR— MBIMLET,

F 7 a1, Data Sources %1 7117 @ Source Files #7125 PP Flags 74—/ /LR CiBN, &5\
L INATRET 7ANFEIANIA I T 7 AN THRIETHIEN TEET,

-vuid AT T A AR U HOWT VUID 2R L E T,

TaYx VM TARF 2 A NAER T D56 BHFIL 1 DO/RAZT R TORF AN EEET,
ZDGE . T A= AN RENDLE NAS—TF AN 7 TTE SN R VERBI - NED 2
THNFET, KX AUMNE 1 2Oy a TERSINDTZD % HTML ~X— TRICHERBI 23 S
nEJ,

-Wid A7 ar Tk, 7 aY 2 ZhRe— RSN EE TR Y — A2 — RO ICE Y 27 74
EA OB NERSNET, 2SI 7y sy a OB OBEAEMERESIL, B
S 0530 HTML R 2 A MERKAS FTREIZZRD E T, B0 I K OHE 53 DR F 2 A MERLDFEMIZ D
WX, 77 AV [imagix/user/doc_gen/sample.dg_Z 2L TL7ZEW,

7" a3, Data Sources % 7 7™ Source Files #7123 % PP Flags 7+ —/VR TN, HHU T
T INATRET TANETAIAN T T 7 AV TR E T HIENTEET,

-warn TR TOT FIAPELEL IR F4

YV —Za—RDOfENTH  Imagix 4D 7FFA FL/ —Aa—RZDb 0, HH T —REENTIcf i ESns
~IAEFRK OA TN —R R LS TAEUTAE CE T BRI —ITHEI ZERHV ET,

FIFIVNTIL. TFTIAFIEL ATV —R T 7AI)VIN RO, HAWNIT I 2 H RT3
72O a—R & TINARy T T ANBENHHE ST HELRREIC OV TO AT T— Ay —U% K
LEd, -warn 7> ar w428 774 PIEHERET R TIZOWVWTAY =5 IRLE T,

Ga i TL, HETHT EOERRTIFT—%2 5| SR REE, Y105 HIZREEET 572D 12-warn
FFvarEERALTHEWTLED,

F T AI O RICH NI TWET, 5 Ay —1%, Show Warning Messages 7 77k > 77 A
[Z9E~> T (LOCAL #==—[Display] > [Show Warning Messages]) Analysis Results 7 (> N7 CH/RE/2I1X
TANZIINET,

PFR—FENTNRNF S ar

Imagix 4D 7F T A&, ViR—FLpWA T var aESNDE, TNE~/EFRICEHBLET, 2L
ZIE, -ansi lZ~7v_ IMGX_ansi_ #FEFSH, -XclX_ IMGX_Xc_ DEHFEELI-HLET, A7 T3
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L DIRDIETEFITENZENS<ASClI-value> IZE#aSNF -, 7222 0E, TFHIAPIA T var-
XCH+ZEJET L w7 IMGX_xc$43$43  NEFESNF T,

ZOZEHT Imagix 4D DL A TR ET 7A N TO IV DL 7 A VA7 a0 Off i IZ 28Kk
MWERT-EET,

-H. -1, -RF/-1E-S TRLAT AT 7L aild. A VN —R R 2% R T LIRS L, FAR—EI TN
F 7 arbidRashEE A,

WESLENTZ ANSI C 7l I3 S FEOHIKE . JOHLW CH+EREOHERHVE T, 72721, <D
BEFFED CIC++Y 7 "y = 7 132N H DMK 2 72 L CQOVER A, Z2UE, OEDIZIE (C D K&R DA
DIIND) EFEDOHIE B IAELBININTZF DRI TR =T BEDLINTODNET, OEDITIE, 273
IR ERZFE~DOIEEEZ YR —RL THBENH T,

Imagix 4D 7 F 7 A X2 LIZEF O — R &g A< AR J- 570 ICBRF SV E LT,

L DEE . ZOVR—NIBBENCAEL ET, Imagix 4D 7 F T A FILY 7 - =7 DT P i<
DOFER S FEE R ERZTR L ET, 72X 0E, B K&R RIS MAF & A U4 #F0) HFTL L
C++Hla X N (INE Ca—RT IR —hSnuE 7, £z, Imagix 4D 7F 74 i35 L <pa <
ATRFE S REPEEL VAR — L E T, 72E 21X, — 5D VAX 2 AT R O BAZ L SAF 2 E TR
DHILTND, RV D7 TO X F$OME A (nagme) b ALBEL £,

X —U—NIEIROGA 2, Imagix 4D 7V 7 oty 53— A7 7 AL &5 8] 73 CICH+ — A —R|Z
B DI~/ EREMHTHLERHVET, T2, $5%<D CrrArar "7 3F—T—
K near & O far 2, ANSI C TIZEHZE SN TR TH YR —RLET, ZOHAITIE, near KON far %2
D LFHNTEZZ H~ I/ ER AR THIZENTLEY, 57T, FERIC, Imagix 4D 775
AP IFIT—RORNZHHENSE TR THTLLD,

IOLle~ra@ A E R T DX, ThoE 3L SATRET 7 AV DIRNCELDOPNBIZATT, &
ITIUR, YAR—b T2 AT, Ehae—EERTHETTT A AEIETL2OLESIT0E
I, BilZ& R 5121, . Jimagix/user/cc_cfg DT 4L ZRID.inc 77 A VEBIRL TIZEW, E0biT,
bor_win.inc & O msve_win.inc 7 7/ /UEZ D XH7e~ /g £ a5 %<& A ThET,

—EBDOSFEIEEIL, ORI ETCITER T HIENTET, -gnu, -msc [HFHRDOIHNC, TFH T4
Tar MU R U AR LEEUET RIS EA T a1 B, 2hb oA
Ta ., #pragma cmdflag -msc D EH7RATZIBINTHI LTI | a2 /A TERE T 7 A /AT AA
LT EMTEET,

TS T TS

FERIZR B A B LT HFREILIRICIE, T AL TAL TRy T Ta—RREENET, Z<Dasr A
FIX, CIC++Y — AT 7 A NDIRIN~D T 2T Fa— ROtk AR — L E7, Imagix 4D 7714
FATA T ] T FHBRLIOELER AN, JALD CIC+H+a—REfET 5 L CA 107/
TINRREA RSN, BB N M T ET,

ONEDITIE, A TAL TR/ T TN RERMEO—H TlEWNZEbdh-> T, 2—RDOFFEDITH CIC++
TIERLALTAL TR T T THHEENERTHIZDI L DRIy ST FZE NV RS T
F9, ZNSOREREFEDO—ERIE, WV DIRIIZIBUW T Imagix 4D 7T A P2k~ T H BRI
RSN ET, IFD OB ERITIBEMIC S EOMOE S EF JET DA REM RN H LD T, FEDT T
AFAT L ar IMEHIN TODEXIZO AR — SN ET,

L FO7 43—~y bOE—1TX, 23U Imagix 4D 7 I7A P Ick > TRy FENET,



s T —SIREE 41

fasm (....)
#asm <...>

#asm "..."

LUF OBATOMKEFR L, ST T IAPICL> TAFy TENET,

fasm
. EEOEDT. ..
#endasm

#pragma asm
e fEEOEOIT. ..
#pragma endasm

asm {
... [EEOHKOIT. ..
}

-noendasm A 7> a2 fE LRV ED

#asm anything else on this line

IFARFT Y7 ENFET D, #asm S#endasm OFE DITII AT TENFHE A,

Z DAL ATF = AT 7 AN DR T ADA L TA L T2 T TOIRINT RIS TOD K
EREBLILEAREICLET, ZODIZIMEHShD 7 +—~y NIRDIEY TT,
ASM declarator part declaration list {
- AEROEAT. ..
}

THOLT-BEEE DY AR —RE, BI%4 declarator_part DFEakb &6, -asm. -gnu., -msc 77 A P4
TariEELU EHFIRETY, F—U—K ASM IX, -asm 47> a A KRR asm, -gnu 47> aAEH
FEIE__asm, -msc A7 a A HIRHE _asm £7/2id__asm (2720 ET, ZOF—TU—RFHR—NL, -D A
Tar i@l T, HHWNIIL A TR IE T 7 A /L Didefine statements 2L, v/ EFR AT 52
LIS THRET D2 ENTEET, 72exIE, A7 v ar-D_asm=asm &-asm 47 L al A BHHE T
AT UL, F—7—K ASM [Z_asm T asm THhEWFEH A,
HIOED FEL DAL A TIZL S THR— IS TNT, WL DD 7 +—~ MCflE A RE7e, J<
FANONE LR HVES,

ASM OPTvolatile {

.o EEOERDIT. ..
}

ASM OPTvolatile (
... EBOOTT. ..
)

ZOMMERITHE—ATOT +—~y b TS ET,

ASM OPTvolatile ...

Imagix 4D 7 F 7 A Y DO R DOV — ML, BEERITHEHIN TODDEFRICA T var, -
asm, -gnu, -msc L THMNIRDET, F—U—F ASM L, LEELDIHTAH T a2k >Tasm,
_asm, £721%__asm ZFL 9, OPTvolatile +—7—NK{Z volatile £7-13E MG T DL ENHVET,
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RTALER

T RATDGELRU T, I—RATOF 1 B CIE, = —RZRHLEL | fiFLe CIC++Y T =7
WAL £1, ZOBPETIT, #define. #ifdef. #include DXH7RRIAIRIE SN BE S, [*&*/TlIsE
NIZa A MNIERSNET,

V=2 —R & IEMEC BT 5729 Imagix 4D 7T A1 das AT 0MEH 35D LRI UK Ho—
WEMBELLET, THIA VI~ T 7 AOVERT G A ERHET, £, (#if, #ifdef 72
ED) KM E AR S THERASNA~ /N ERSNTODNEID, LT, EFSNLTNDHE
L7z6, EOINTERINTODDL BB RHYET,

BE ., ZOFHRITT)V vty A7 T ar BBL T A FIZESNET, ImagixdD 774 F3[F
Bl %% L E9, -Idirname (Windows 3 A7 A Cid/Idirname) 13142 7L —RF 4L 7R DR EIC
ERENET, 2NHDOT AL ZRITIE, UARSILTOBIIAIZ, #include A7 — AR CTEREILTVD
NOBTFAIVPRBRENET,

FIARIC., 5% -Dmacroname £7-1%-Dmacroname=macrovalue X2 AT DA FREIC~ /0% B35
THEOIERASNET, ZNHO~7aERIT, IHIZ, #ifdef 2L DOFMfEay A a5 O
FUEERFE T ATOIEHSNET, D47 T ar-Unacroname &, 7 F 74 I Lo TRk, <
Ik REFRICLET,

HTALER Ky ONSRALE D )7 24 TH 281280, Imagix 4D 7 I A Hix~ 7l B4 5582 G H A AL
THIENTEET, RDOIH7e 5B 2 THELL,

/* TrANVDE 1T */
#define macroB(x) funcC (x)

void funcA(int x)

{
int y;
y = macroB(x);

}

TFFAYIE, funcA 23 macroB &1 92 (FEOYH 97) SO TSR EEBIZ, funcA 23 funcC ZFFON 3
LUVIOTESRZERRLET, T —Z 7 7AW ET-. funcA 1255 macroB OFEOMH L E funcA 12k 5
funcC DFEMHLAEBIZ 71T H TERILZEVIFEROZ ENET, ZORED, VR ALBRZRIND
BT BT AE ML, <7V r—aahiib, LDt Use Browser 5 4 A7 L AT LR L
PEHAZSIN TS T R TOYT AR R T HeEIEHINET,

aAVINLSREIFAIV

Imagix 4D 7 FF A Fixa L AT L CWNVET, Y7 T =T Za S ZEE U IR 512
X, 2 FE T2 — MBI Imagix 4D v b7y 7T ALENHVET, TD'y R T w7 D
FEERDDONAL NATRET7ANVTT,

limagix/user/cc_cfg THROMBZDERET 74 /ViL. Imagix 4D 7 F T A Y aa—R Dz 73 A Ui fE
T oL AZERRRICEMET 201y Ty T LET, ¢V —Aa—REFLIOT7 7 AL, 7T 7
APFITRTER 3 5DOL DML F T, 5 112, stdio.h DEHRT AT b~ X 77 A N BTG ET
FIAFIHRLE T, Zhud, koI ESET,

#pragma cmdflag -S/usr/include

9210, AU A TRET 7 AMITL AT L THR— NS NA S FEIREMIELE T, 7282 0F,
%< D CAr /I ATHF—U—R near &P RN—FLET, ZIUTAL A TIZLDAEVEIFHTRELET
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DN, VTR =T OREE IO ERLHVEE A, I OEDDHITF—T —R byte T, ZIUTHEYE
CEBUTIIHVERAN, — DAL AT Lo THAMERENTOET, 2L (TR IET 7 AV
1, v 7/uEFEs typedef 2R L . ZNSDIEIREZR D INTHIETHZ A ATREICL T,

#define near

#define byte char
typedef char byte;

IRAT I 2L —ar OF 3OFIBIL, AL SATINVAT Ly X T 7 AV AL T L X0
A3 o~/aE@RIZERLET, LIXUIE, 20 34T~ F T 7 A NIV DB DS — v " AT A
HIZY 7 by =T HEARTAI N e Ty T ENET, TDLHp~ X T 7 AT, A TFHE
IVRENDZ—T I MISEDLWWAYE T 7 AL DY —Aa— RO s a2 455912, #ifdef
_1386 DI RFEMHATE T SANAR TN E EFNET, TDOIHRBEER~ /BRI T ~ATRIET
FAIVDIEDTIRD IR T D2 LTI, 2L A TRET 7 A ML THR =S ET,

#define  I386

EFEROXF—U =R K OB~ 7 g2, LIEUIEa ST DR F 2 A DRl S E
T, F—U—R, SR, FRESE~I/0, HAVNI~I/EEBICETAHEREIEL TIZE,

Imagix 4D (21%, L/l ATV DL DL A TRIET 7 AN BHENED Y T v 7 & T
WET, YT A TEFHTE5EITE, EOA N ATRIET 7AVEE VR EREEICEITHY
AT DB T 7 AN DT KT DI D UAEE L TIZE, 34 LW a T2 453
BT T2 TR TI2L — TR DO SATRET ANV BT AR LT IERS
RVDITTIEHVETAN, AR THILEEBTTOLET,

T34 DIEE

Imagix 4D C/C++7 T APITMSLL T2 FAT 7 7 AV THY, 7 FITA PO EN, 2w R0 %
U CEEITHZENTEET, 72720, EAB RIS T 5720, %, BN Imagix 4D = —H 1%
— 7 A ADNEN ORI S VET,

Imagix 4D > — /UL, AL A7 ay = M 2HE AR L C, ERSIDT —F 7 7 A VO
FTZRE 927 FIA4 AL v T ey NUET, VDO LERER——E DY — AT 7 AV EfRITL, ED
AIN—RT AL TN ERRL, EO~IaEREME AT D0 I% Data Sources ¥ 4 717 (A==
—[Project] > [Data Sources]) THELET, ¥ A7/ OLEM TERSNIZET —H Y —AIZDONT,
FEEDT —H) —ADKENIF AT OFEPTITWET, HMO_EERIZHD Type A=a—R T,
A==—@ Source Files €7 a 2% 4 DO HDOWTNHNZLE ST Imagix 4D C/C++7 7AW
DEENSINET, ZTTERIRUIART ALK X ATl Dbl DFRRIEDLS>TEET, XAMT7ur
ZIERS D FIEIZOWTL, ZO~=aT VD /ZEDIZ) DA, K ONRILEENR~ /L~ [ 2 2 1
LCL7EEN,

Options & A 712 (A==—[Tools] > [Options] > [Data Collection]) D&% &L — IV ZEEIBET 5
T AT L E D3RR/ Y | Data Sources % 7 17 D4 Options X 7 (ZFERSNDHT T4
WA T ar OF 7NV RNREDT-DIEHLET,

CIC++ - 4 FOT B THITEITS

ZOFHETIL, 7T T3 Data Sources # A 727 DR EITHE, —WF AL Z—T = A A/ HE
HINET, XATT TR, T T2 — AT 7 AN BT DAL INV—R 77 A NOGHT, EHT2
~IOEFRREFRELET,
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ZDHEATaT X, HDOFEDT AL 7RI —A (¢ e Depp) 77 AV, BT, HDOFFEDT 4L7

N K OFOFT _XTOYTF AL I NI DY) — AT 7 A Mg Z R — N ET, V7 NI T BEEROT ¢

LIRNZFEZD 5> TWBEEAIZIE, T AV IZMNCT oA &840, EET 20 ERHVET, 0D
AL, £o-oF, Data Sources X A7 2/ CTF — & — A& BT 52820 ET,

72120, ZOT 4L 7N ORE T~ (h Eizidhpp) 77 A Vi@ snE A, A2 70 —K7 74
IV ORRFEYEATIL Include Dirs # 7 CHREL £7°, 1 2l%-1dirname %-1, -S Flags 74— /LRI AT 5
FERHVET, ZHUIEEOE DT AL TN L TITHZENTEET,

%7z, Directory 74— VR THRIELIZT AL 7N DT XTOY T T AL I NIZH D~ F T 7 A NV AR R
4 B& X%, Search subdirectories for header files DF = 7R v 7 A& R AT A2 LR TEEY, 72720,
ZOF =Ry ZAERIHLTEG A2, 7 T 4L 7N O R T DIAFFZHlE 5 213 T/
F7, 2O, RICARIO~NE 77 AN DEESHGE IR, N IEFEIC/2 A FTREMERHVET,

XLOTFAINERERL THEITZ{T5

ZOBIRBAIAA 7T 7 ANMNH = b DB b BIILET, LA C ZHEBEIRTHEE120T, A
AV 77 ANEAFE ST/ TN 2T VR THNENHVET, ZOHIETIE, LA T T 7 A /LA —
P RINEBIZFEBRD Imagix 4D 7T A VA EEI L £,

AT T 7 AN ET TIZ, I—RETL ANV T HEEX I RANT D) — AT 7 A)b ~ B T7A )L
ERRBT DA IN—RT 4L 7N KO T 5~/ @R EVANT DA 774~ 7ain G ET
VWET, Imagix 4D (2> TEIIS DY —7y ME, ZRBBEFO~/m RICEARENE T, BEHL,
Imagix 4D DRESY — 7 NfRETHONERHHTLE), ZDT28 | AT 7 7 A NAZE—7 > MBI
L7c&EZE, =T 4 RIMETESIVT- AL 7 77 ANZE DD, FHiL Imagix 4D #—77 > hOIEIEIZE]
T REEBICRIRSINET ([/2CDIZI B HR)

B—LF I NINAA T 7 A NATBIIS AL, Data Sources % A 711270 Options %7 DR E N AL 77 7 A
IVDOBRTENA L IN—RINET, ZOF T2 arkdbbTER LT, Tay=/ b — 2% HAT Hill
(2, HLIZ Options # 7 Ca% E& A BT 5721 TR AT 7 7 ANEAEET HLENRHVET,

Data Collection Options 2 17227 Make %7 D% EIZL- T, Imagix 4D % —7" > M3 i INZIE NS
NDFEZDNT, —HOEFELHCTEET, IDIT, F—7 Y rOBINEHT 57 7L —hD7
AP ARG ARETT, 77 L—hX, kLA T imagix/user/mk_trgts (ZEALTUVVET,

MSVC Project F7/&MSVC Workspace/Solution

ZOHFIETIE, Imagix DX —47 > e A 77 7 A B ITT 50 Tii7Ze< . Microsoft Visual Studio T4
iz a2 I NE T a—at DB T 7 A AT N—RT 4L IR RN TR EFR
BT A RAMH L X, PP/ a—ar (DETONR—2 a0 TR — 7 A — ) &
1ER% 9 %&. Visual Studio TIEZDIEHRN T 7 A NV THEMNSNE T, TNHD T 7 ANV D T —< v heAk
#E7-1%. Visual Studio /X —T a2k »> TR/ E9, MSVC 24 452D J577%1%. Windows Kz Y
Unix O J700 /73— a0 Imagix 4D TEHC&ET, 7272 L 3—va 5 LARID.mak 77 A /v Z A~
2l 45881 Windows 23— gL MBLELZ R0 £,

Microsoft Visual Studio ?™/3—a> 5 KT 6 Ti, .dsp 77 AL Tld7ed.mak 77 A /VEE L T
R—=NATOG AL, 7Y = NI A 77 7 A VIZ BB AE RSV E R A, MSVC O Project A=
=—"C Export Makefile A== —%38#IR 925 &, Visual Studio |ZAA 77 7 A NV EAERSELHZENTEE
T o AT 77 AV | project.mak LW )4 BIAMFITHIVET, 72721, project IX MSVC 7'y =
JhDAHTTT,

LEBD, MSVC CHAMINIZAA T 7 A ML, EOEWEA LT =T — N EENTWDLIERHY, £
D7z, MSVC Project #FIHL CT —F#% AL R— N LHET DL, 2T —NRRENDLIEDRHVET,
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MSVC Project ZFl|HHL T CIBEIZ S D072 EEI2IE, DOS VA4 R DI~ K747 nmake -
n -p -k -f projectmak #3479 HZEIZLY ZNRTT—DHDHA T T 7 AL S TAELTZHDNED
MR DHZENTEE T, MSVC Project 2R HLIDEL TWTRRSINTZDLFEIL =T — Ay —
VIRERSINAUL, MEIIA T 7 7 AMZRDVET , ZOGEFA T 7 ANVEAEIET D0, WDk
ERIRLET,

FIS51 Y DEB % (BEHT7%) DER

9 TIZ MSVC &4 I L TV B354 121E. MSVC Project %7213 MSVC Solution d 55 NVE IEAf# H
TLX), 2, ZOHLEITIE Imagix 4D 7'y’ =/ MSVC 7'ay = 7 hE 3V a—a Obhbip
HEFICRASETRLIELE S T, Imagix 4D 7' vy =/ b7 —H 2B AET 1217 TR TLEY,

CIC+H+a—RTHAT T wlL TN ZATO FIEL . A 77 7 ANV B LT TIEIC D8 T
WEAMNCFIRMNE S TT, 72720, WREARRE DDA T 7 A NV % AT 2 FABEREE CIE3E

ZLTWAEAITIE, O LR EREET Imagix 4D OF —ZIVAEL FIHT HIEIN, A7 77
AT Imagix 4D #—4 b BN 5720 1L KT WA F#EZELN T, FANINWZELHDHTLEY,

B LDERR

AU T7 I DIEHT

— %2, Imagix 4D 7 FFAFIET 77 A NVDIANIANNY T T 7 AN A I —R T ENLEIIHD E

H e .Co.epp 77 ANV K OA L IN—RT 4L INEFRET HIEICED | ~v & T 7 AV )Minclude 27
— AU M@ L CEAEM EII IR A 27— R ENAUE, ZBIE HBIMICr SN E S, ~v

BT 7 ANEYANT DD, 1282 C EI2E CHY— AT 7 A MIA L VL —RENL T, T rP =2k
IZBIMENDISNCT D01 TEE A,

SRFALIN—RTFrL O ET T =304 O —RFr L IR

I RAT DA ERERIZ, Imagix 4D 774 ThH, AV 7V —R T AL N DY AN ELE T, 7
FIAPIL, #include BTALEIE S IZHE L A7 NV—RF 4L IR ZFRESITOBNEIZ . #include
2T — AN TR ESNIZARIE AT AT 7 AP RONDLETHRBELET, T 74Tl RD 2
DDA LY N—R AT —h AN 5 Imagix 4D 7T A OEMEL, 1 87210 B2 E9,

#include "fileA.h"
#include <fileA.h>

TFANRINI F—T —ar~<—I THEN TS EORT —F AL, T IAFITET L b
T AL ZRNIT fileAh ZRBLET, TNEBRITIE, HEIZEBLOLDOAT —RANCHL T F TP OENE
IR T HESNIAL IV —RT 4L 7N ORI ET, ZORBEIT, Fg)D fileAh 23 Loh
LHEThEET,

FEDA LI N—RT AV ININ AT DAL TN —RT AL 7N ERBRSNADIDITHE TEET, £l
(21, imagix-csrc ELEhRFZ-1dirname 47 > 2 Cldza<-Sdirname 2 L £9,

-l TIIRK-S B ALIZEEICTEZONDHEIL 2 5BY, Wi Lt — AT FIAFOA T v a izl
RLET, 5 — DB L -nosys 7T a AZBRLET, -nosys 47 v ar ity hSiLTnbde, VAT
DA TN—RT AL TN ELTHRESNTZ T AV I NI D~ Z T 7 AL, FRITSIVET S, 7 — 477
AMTERSNT | ZONFEZFETHZLILTTEEE A, 2070, -SI, stdio.h DIHIT, —ixITIE
BILDIN~ T T 7 A NG T A IV —R T AL N O EIER T 2287 TOLET, 9
T, TRV =T DT —H N2 FIROIRNT = TEINTITT L TLL,
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INRE

S & -l LD DiEE, -sysincfirst 47 L al il SV TO A EIZBIIVET, -sysincfirst 4
TarEfRET DL, < SITEo THRESND Y Z 77 A /UTDOWT, -l TAL IR DRINZ-S T AL 71
DFNTHRINET, FANTOEFIELT,

#include "appfile.h"

K0T PV r— g~y BT AV EFEEL.

#include <sysfile.h>

\ZEV VAT D~y BT 7 A N A I —R L TODE A, -sysincfirst 47> ar Ml C&Ed, —
DT IV r—a o BT 7 AV —E DY AT b~y BT 7 AV EIC L T2 - CODIEA 1T~
BT 7 AN DELRE MR DIZ T, 2O T a NI THINL LIVERT A,

Windows (3324, D727 TOAN—ADM &R —RL, Flo, RKCF/NLFORBIRHY EE A,
Imagix 4D 7 FF AV DILENHT->Th, D RN BIERL TR UL BN ERHVET,
RDEI72P1EHE X THELLD,

(1) imagix-csrc -IC:\Program Files\Include -ox File.c

(2) imagix-csrc "-IC:\Program Files\Include" -ox File.c
(3) imagix-csrc "-IC:\PROGRAM FILES\INCLUDE" -ox File.c

AL N—RF 4L 7R C:\\Program Files\Include |21, AX—2Z2NOEOEFNTNET, ZDIH
[CAR—AEEG LB IIE TN —T —ar~—7 TLOUBERHVET, 207, (1) TIHHT
TT7—AEL, (2) TIZIELLEHT 23 T E 7, Windows 13K SCF/INSCFO X BIN2NDT, (2) &
Q) IFFILH DL RS ivET,

BIBOR 1%

C KON CHHIBIEAR A2, DFD | B AE O T 7200, WEAETNZBITLEEDO= R TR A
DIRA L 2ERZYR—RLET, Imagix 4D OV — A — R BEEHER) RN 2 2 2 ONEDD3, 7
FTAF DL A L Z OFHIAE OV THHIE T D #R T,

BB amieT —2LEbIilty FaNOEBITT N TREER A 2Ll Ty —ranEd, BfE. £
DFHIFHUEF BN T T NT, BEEARA L INBIFO D (TREVED D) b DL L TRiERS
9, HOEBDEIBRA L 2@ L T LZ2ATo L TR, T OBBUT RSN A L S B a PO
HT DL TRRSNET, TORER, DR ORAETRA L 2~ SHITTZDELUTARAS
NDAREMEDHL T N TORBANEFFOHUBR AT E D8I L > TEEN R — WY — 2 o2 L
INCEET, TFITAPITOLD DA L Z DRI BN A Z ~DARABIBBFL | 5[ $EL T
MESNDBIBARA L F T BB L £,

ZOFER, FRNHTHU LS N OPEBRA L 2480, BABRA L 2 DBLS I3 B A L A %
FFOMEIEREE IR F AL >TUIF T, TTIAPIRALBBLET, 72720, ZEDEHII
BRSO (b b BIOREA B3AT — MU MIRASNDSGE) . EIZBEEERA 22550
2LV OETICE G T 2RAL E0HLTE . HDOWITIBEA MG 1 Bx Bl TESNDSE 12, 7
T3 AL PO E NS FTREMED & 5T N TOREK O BER A 22 FoRLE S, —#oO if
LXK TR SNOBEEA YR T 27 i ar bn— Yy 72 L LS LT E A, 7 T4
T, BRI RN A 2 IR B AL 5 2 Lb TE R A,

WO ATHMLEEI NS E RLET,
// BEEORA B ~D MR
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int fool();
int foo2();
int foo3();

typedef int (*£fpT) ();

fpT x1 = fool; /] HERIND . BBRA 2 ~EEAA
fpT *x4 = &x1, x2 = x1, x3; // WERIND: BERAL A ~DRA K
int *v;
fpT all[]l = {fool, foo2, foo3}; // KWHIND: BAEERAZOES
fpT (*a2) [1 = &al; /) ABELEIND . BEEORA L2 DEY|~DRA A
struct sl {
fpT fp;
double w;
struct {
int cnt;
fpT fp2;
} si[3];
} s1 = {foo3, 2.0}, [/ RIS BBORA L 2 hE e iE R
s2 = {foo2, 3.0, {{2, fool}}}, // WHEND: BIERAL XD TR
*spl = &sl; /) AEIEIND s BAEORA L 2 E G e IS IR~ DR A A

struct sl s3 = {fool, 0.4, {{3, foo2},{4,foo3}}}; // WHINh5

fpT gool()

{

fpT r = &fool;

if (v) return r; // AEESNZR . RYE
else return foo2; // MBI ROE
}

void goo2 (fpT &fp)
{

fp = foo3; [/ ABESIR N AN NTA—H
}

int barl ()

{

fpT locfp:;

(*x1) () // AEIND

gool () (); // ALEREIZRN

*v o= 2;

(sl.fp) () s /] AEEND

x3 = sl.fp; /] AEEND

*x4 = foo03; /] AEEND

(*a2) [1]1 07 /] AEEND

goo2 (&locfp);

(*locfp) () /] RPREND JALBRE R0

}

int bar2 (fpT p, fpT qg)
{

if (v) p = foo3; /] AEEND
if (*v) p = x1; /] AEEND
(*p) () /] AEEND
xl = foo2; // NS
x2 = spl->fp; // AEEND

sl.fp = fool; // AEEND
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x3 = gool(); // RLBES 7R
a(); // AEIND
}

int bar3()

{

(*all[*v]) (); // LB D
(*spl->fp) () ; // AEEND
bar2 (fool, foo2) ; // WIS
(*x2) (); // BB
(*x3) () s // AEREILD
s2.s51[0].fp2(); // AEREILD
s3.fp(); // BRI ND
(*s3.s1[1].£fp2) () // IS
(**x4) ();

}

7o 8. EOBIBMNBEETR A L A Ko TREON I E D ATREME N B D0 & F~ 34U, Imagix 4D D7 —
HR—RCEBIZEL OHFEABINTHENTEET, TOTDITIEL, LD HELELT, £H091E
WEELT — 277 ANEERLT DHERSVET (A2 — RO T —2 OB OEEMR) , H9
DEDIE, V—Aa—REEETHHIETT, BERA 2L TE DA ES DD D>
TWAEAITIE, IRD X722V — 24 TZ BN THRIFIE, Imagix 4D R3a—/L V) —& 58S HZEN
TEET,

#ifdef IMAGIX ONLY

FunctionPointerType fp = {funcl, func2, ..., funcN};
#else

FunctionPointerType fp; // fp OBEHFERE

#endif

Fio BEEROSGEITIL, BIEUI A S TREETONLZEICHIEEL TSN, L3> T, ik
RN FEC TR D ST OOBEREH DN S LI —VENET, FUES/7aA 7L
ARSI ERTA (72E 2 1E, FPTR x =foo, y =X;),

Microsoft Visual C++®DHHR—pk

247515 Himport

Microsoft Visual C++Tlx, COMBIDEFHAEAA T TAT TV T DIENTEET, TNHDEFE
IZ. Microsoft [EH D7V 7t yih5 4L 77 47 Thhtimport Z# 94X, V—Aa—RTHIHT
xFET, BlaRLET,

#import <libraryname.tlb>

MSVC 2731 Z 1 3#import 7 AL 7T 47 IZE o T DN D T 7 A NAA T o PR — L TOET, &b
IR DINEA T TAT TV SAFY (M) TF, ZOMITH R — SN TND T A VAT, FAT
A[REEY 2 —/b(.exe), X AT Iv 7V 7F7A47ZV(dIl), BEOLL FO LT progid E721Z libid 128~
THRBISNAIATIAT TV ENEGEENET,

#import "progid:my.prog.id.1l.5"
Ejals

#import "1ibid:12341234-1234-1234-1234-1234" version("4.0") lcid("9")
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Imagix 4D DY —AT7 FZA WM #import 2~ REMF T 5% 2L _ATIZEV ARSI xHE T2
FHEAT Ty ANEA L7 —RLIEHELET, libraryname.tlb 7213 libraryname.exe Z 5 EL TV 5
#import 7 (L7747 _Lﬁﬁ‘ék /‘—XY‘)“7/("7L I libraryname.th LWV RTO A~ X 77 A )V %
BWLET, 77 ANDBEODDRNGE | T HIAPITIROEE A — V% AR L ET,

cannot open file "libraryname.tlh"

Hh BRSNS T20121T, -1 A7 v ar BIO-S A7 v aill>T Imagix 4D Y —AT7 F I A YFIZE
SNFA I N—K /\7< _%zhﬁl*%ﬂ’ﬂéﬂfb\éz\%i)!i@@iﬁ“o L= o T, ZD X7 Ay r— % fif
WTDITNE, ET T 7ANBIFETDNEIDET =7 LET, 77 AVBFELRW S, MSVC 22
NRATHEFATUTT 7 ANVDAERERBDMLENHOET, tlb 77 ANZA TR, a7 A Z L@,
KT H.4h 77 ANV E AR LET, exe Al 77 AR EDIMDZATIZONTL, th 77 A /VEAE
RS G EVERS RN G A DBV ET, TERSHZ2W A1, = —R% Imagix 4D (2 — R 5%
(R X — DR ET M, EEOLZA N 77 A Videxe 77 A /VTIIM TRV ENFEALET
T, AT TAT V4 OIRUT progid F3E O libid 2 H 3 5E ., XFIGTD.4h ~o 2 77 A L3RS
N2 2 B0 T Imagix 4D Y —AT T4 P TlIhR—hShTnEt A, ZHUCBELCGE
L< I, Microsoft D~==7 L &SR TS,

tMh 77 AV T DI NS TEE Ay — VN SN A . -1 A7 v arZBme 7
TANDIENESINTNDT ALV NEFRE T DN ERHVET, WHFIE, MSVC PA=VEV/ANS-Fel kS
MSVC U —J A=AV 2—a DT —ZY) — A —R T 56 | A7 arBLO-S A FLar i
HENIZAE RS IVET, IBIND-1 47 a1, Data Sources % 712 @ Project # 7 (Z#% Options
TA—NRTHRETHIENTEET,
2L DOYE | EBEA~YZ T A (Hh)Zid#include T AL 7T 47 BNEENTED, 2L A TRAERKLT-
AU NNBEENERSNTND 2R Z T 7 AN ZFZITTRENTNET, BB Ay —I M th 7
TV T M T 7 ANV RODERNZEEIRL TOWDA ., i 7 7 A VHBFET D ET =
7L, MSVC 2 /(5% FATL T, 77 ANDEREABDVERHVET , Z<DEH | RoONb7R
W7 7 A VT Imagix 77— — AT HA I Z 72 T2 | R THORWER A,

Imagix X &5 B ERSN TN THY —Aa—RE2r—RJ 52 LIZEE L TLTESW, #import 77 A /LA
ﬁr)b DIRNENYEIE DI RIZ Ay B — U PR SV IT UL B A ERIL T, YV — A — RO 3

SE T LTne BRI ZEMTEET, BT, ROMDRWT 7 AV 5% 5272 LT WA
61.’& TIUOD?%ZF774’/V%5@@J7‘£% AICIERRL . EDT 7 AN EBE D~ X T 7 AN EBITA TV
—RF 4L N D 1 DICEEL £,

OSXEM Husing

Microsoft Visual C++ T, D EITEY 2 — MITERSIVTNDL VRV OfE 2R — 5720
D9 1 DO FIENREESTNET, #using 7V 7mtut7 L 2770714, Il .exe, .netmodule,
BIOOb) DB 77 A M ERINT- L VRN ~DBBATREICLET, HlERLET,

#using <mscorlib.dll>

Imagix 4D Y — A7 FZAH M #using 2~ L RE BT HFE ST~ H T7ANDA LI —R%
R ET, file.dll 245 7E 3 DHusing T 4L 7T 4TI BT 5L, ) —ATF TP filedlline £V )7
TANVERLET, T ANV DB RODERNGEITAERSNOE S Ay E— L FO LU T,

cannot open file "file.dll.inc"
#import 7 AL 7T 47 DIFALITFRD, MSVC 2234 T3 #using T AL 7T 47 ICHBE LI, H

BN~ F T 7 AN TR L E Ay =T HENEDIR T 7 AN FETERL, Soni=77
ANE-SH T arFi-d-1 A7 ar THRESNET AL ZMIZEIMLERHET,
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ZDOIDNIBIENDIHH R I72 MSVC EATEY =— /L% mscorlib.dll T3, Imagix 4D DOEEEIZI%
AU T B~ Z 7740 ELT mscorlib.diline 238 FNTNET, ZOT7 7 AT a4 Tk
T ANDT 4L 7R ThD. fimagix/user/cc_cfg lZHVE T, ZDOT AL 7RI H IR BRAY72-S 47 g
ko THRESNE T, L=2s-> T, #using <mscorlib.dll> EWORFED T 4L 7T 47 ISBEIZ R —b
SNTWET, ZOHIIZ72BH-oT, ZOfMD#using 7 4L 7T 4 712k R — MBI 523 Tx
E5a8

EHDDLL EOSIRDI RN —NA2AR—F

2 ST OREERZRENE T, 7 a— b BRIASE A S, [/l—a AV BN (BT RTRE 7 7
AV, DLL F7213747 I IZHDRICA RiAFF 2T X TO R B 77 ALRICZ 7 A THLHE S
4, Microsoft Visual C++t =D /L — /UZHEWET, FfTEY 22—V E/21% DLL OFNZE UKL
Imagix 4D D71y =7 MARRL TODHERY | ZOEMEIZT 74 /L b Imagix 4D Y — AT 7 A F D)
ECHR—bsET,

LU, O ANV E ST 7 0 = VM ER LT WAL H DL TLEY, TDII7R4A
BT RAVEALIZIBW TR, EERIZIEB 4 THBI7 T AR Ul EAL7 T AD L B OMED
NCLEIZLEDNHVET, ZOXIRAFIDE LT — AT FITAPDA T ar | -uagyr (2=—2772 4
BNCESTRHIETHZENTEET, -uaggr DM HINDE, Bl 77 A VICERSINTZT R TORK
N TTAL, T2 2 RCARTCTHLTHEI & DITATHHEH72SZIVET,

ZHUC Ko T BT AD L B O 221 B+ A1FE AE O RIEIC L TE £, LA L Microsoft
Visual C++ T, fx BN T ARG aL RANVHENL OB R Z# 2 T THZENTESINTOET,
MSVC TIIHEIEMAED dllexport LN dilimport [2& - T, B ED 7T A% 453 DLL L CE#RT D
TENTRETT, £D X727 F A%, 150 DLLIZE» TEFRS L, FNO0ME SN Do DLL N
THEHEINET, ZO—FH T, B@HFOIVIATHIZOEDD DLL &L TCH &R RiESvE7,

Imagix 4D 1XZ D I 7 RPUT ST HZENTEET, Wi D7 T AR LO4 piOE A FRET 51
1L, -uaggr A7 v ar wflE L2 T U7 E A, JEIRFERED dilexport 35X O dllimport (2> T

ESIIEITAD DLL ZYER T D — D77 AL L TRARZSNADT2DIZIE, Imagix 4D DA R7myx
I MEREZE 228N HERES IVE T, ZOFEIETIL, & DLLIZHI A @ Imagix 4D 7'ay = 7 hhME

RENET, 20K, Hx DTy csipariralc/MNIfGEShE T,

ZOHEIEDOLY 1 OOFHIE, 120 DLL 2T AW EIC, fERELTE A O ey =7 by
F—HASNDHZETT, ZLC B DOETEY 2— /L e DLLICE Do T- 3V AT AR T~ 0
BAIT, AR 7 a2 VML TENNATRET T, v AR 7Y =ML TRELLIE, Yo —H
HARDI TPz e T —2NE | DTar R T a2/ OIEZS L TLIEEN,

IS5—REBLETF AP Ayt—D

Imagix 4D 7 F A YL, FXIZAL A TDIINCTERIREWRMATZATWE T, EHOTL 34T 1D
BERICHEISILCWVET, 2072, 2—RIFSERICT AV ATRE TR CHIT S E T,

Imagix 4D 7+ 74 YFIZiZ, SrEMEIZ OV TOE MM O=T—3T ERRINHVET, 20572/
IR EIIRE SR IE Y — Aa— RNl TAELREEZ BNET, UL, 72z —A
I— KRB VERETYH, ~ X T 7 ANVDRIE, AL I N—RT AL I N ORIEREIRFRE, HDHWIE
ATALERFE S ORI A T 5~/ @O T T —IZ L CTRIENELAZELHVET,

TFIAPE, T LEHE L TNDY —Ra—R DR TRESCEITER EORTEICH S & £DfY
TR T D707 —RTIERAIZREIL , T2kt £, botERARMEOEAIZE, 2hb
OHAITIZF S TIERL, TFHFIAPFIIMITIEARRY T LT, HHID T/ —Aa—R LRI 205
NHDLHLNER A,
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TFIAFIE, OLMENRI DL, =T — Ay — VIR ET, AvyE—U1T Analysis Results &7 ¢
VRUICERRSNET, 7 74/VE T, IVE KRR A=V RERINDINT > TOET N,
LOCAL A==—% % &7 4L ([Display] > [Show All Messages]) . &5 Ayt — U8 FRINHIHIC
THIENTEET,

B E DT —D RN ZfT I D84 121E, Analysis Results 7 4> R CEDTT—0D _EIZ~T ARAY
R BRIV I THE, T4 RUNR A= DERNGT T — N DO FoRIZEI Y £5°
(LOCAL A==—[Display] > [Show Error Analysis]) ., Analysis Results 771> R \Zi%, fEHT LR
DIFRIEINARSL DI, T —F =LY — AT 7 A VORI I > T DN FE 72 S A F R
SET,
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Java J—KRDEEHT

Imagix 4D 1%, B7READY AT DOEEL DY T = T R AE AN E T HZENTEETA,
ZORNTRBEERDILY — A —R 77 A NTDEDOTY, V—A—ROMETIL, Imagix 4D D7
FIAFIZI > TSN E T, CIC+H DT FFAFIZOWTUIHIO | a THALCHVET, 22
TiX Java Da—RDTFIFAPFIZHOWTEHALET,

Imagix 4D @ Java DT F T AL, 2 A ZLILBTZEEEZ L ET, a7 3MT7DIHI2, V—AT 74
INDSERTRE IR 24T, =R OT_NTOURAETLET, 72720, 2 A3V B
Lo TEIT7 7 A IAENDA T V= I N7 7 AN E LR T HDITKIL , Imagix 4D DT FF A4
1% Imagix 4D DT —Z _X—AZB— RSN NENDT —FZ 7 7 ANEREESNDT — X7 7 ANV EARL
77,

Imagix 4D Java 777 I Java {14 Second Edition 35X O* Third Edition %7K~ —k~L £, 77
TAFIT Java ) — AT 7 AN ITAT A BED jar 77 A VO A RE T, £o, T IAY
ILEEDERO DI TAT 7 AIVINHIH L, A RARRCHI L - L A, jar 771 v
MANELTHRESNZSGE. T I4F X jar 77 A MZe DT X TOITAT 7 A /VITDOWTEFD
TERAHLUE T, jar 77 A /VINO R A £ zlib [EHES N= 7 T A7 A v bb S E§,
ZEDOMDIERE T IEZ TR — STV ER A,

Imagix 4D O7 FZ AW, Imagix 4D DT —H X — A=Y A L H—T 2 A ANLINL UTZRIT7 74
LT, ZAUE Imagix 4D D—H AL H—T = A A DIEEIT 520>, FIHERNZa R IA 0D
HEhTEET,

T A OEXEAToay

Imagix 4D @ Java D7 F7AH X, Imagix 4D DT —Z_X—ZAJ R—F A L Z—T = A ZAPHINEL
T2 FAT7 7 AT, fimagix/bin DT (L7  NIZEN VTN T IROIECEERLET,

imagix-java [option...] file...

7272, option XU LLE® imagix-java 47 > ar (L FIZEA) | file 1O DL EDOY —2T7 7 A
NVDFERIALL ZSULET, WHEIL. BRAH LD java DY — AT 7 A )VIZT T, TR L5

file DVANMIBERE TAT7 7 ANE jar 77 ANV EFOHDLIENTETETR, BFEINLIX, VY —Aa—KN
@ import classname 7 4L 77 47 OfERL LT, BILOVEIZ imagix-java ELERFD-cp 77 A/ A%

T arOREREUTRTSET,

Imagix 4D O7 FFAFIXLL F DA v a AR —R L ET,

-cmmdFilename  Filename 7>~ RAaBNML £,

imagix-csrc V' —A7 FIAPIIaA~ U RIAFAT7 74V TH, -emmd 7 L a B HT52L T =
<RI AT a BRI E T HZEMTEE T, Filename TIRESN-A T v ar i, a~v>
RIAHIETHRELIZA T Y aAZBINENET, Filename 2NMEEAT THRESN TV 554 . imagix-
java I Filename NOR DTG, A7 v ar tA b THEEIREBIS NI CEEL £,

-cp Dirname  Dirname &2 7 A7 7 ANV D7 T A/SADYAMIIBINLE T,
-cp Filename  Filename #7727 7 A V&R $ 5 jar 7 7 A VDY AMIIBINL £7,

TFTAYF IR — AT 7 AT I T import classname 7 AL 77 47 IZHE&H &, -cp A7 v a THRE
SNT=TRTOT AL ZNNBLO jar 774 /LN T classname.class £V ) 7T A7 7 AV EZRLET,



s T —SIREE 53

-cp DT Dirname il E, TDOT AL I NINITTAT 7 ANARFBED FEHET 4L 7R 720 T,
classname N/ 7 — 4, 1% Dirname 275 A SADH 7 F 4L 7 N ELTlbET, Filz T,
Dirname 77 A2 X273 some/dir THY ., import classname 7 pkgA.pkgB.classC THo%E . 7745
I%/some/dir/pkgA/pkgB 7 1L 7NN T classC.class Z¥RL £,

-cp DT Filename 2354, jar 77 A /L Filename (2857 T A7 7 A )VIMENT SNV E T, T 74V b
T jar 77 ANV HICH DT R TDIFTAT 7 A IV DRI OWTDT —Z B ERRLSET, -impmin
FTvarEE T AL Y —Aa—RIZimport T AV I T AT INDHITAT 7 AN DN TD I, T —
ANERRSIVET,

FAULIZNBIWjar 77 ANDa T, -ep A7 v ar O R ICa~ U RIAANIRRESNDIER
THRBEINET,

-genflowDirname 7 (L 71V Dirname O 7 7 A /VIZHIHT v — K N F —F 7 0—F — X e EXIA I
ESSIR

TFIAFIET —ZEWNEL T, TSz —Aa—ROFIf7a—t 5 —27a—|CdAE RBXL
CLR =M BT 52N TEET, ZO7a—TF — I T4 7 A IBURIE T — 2 D3RSI T
WHEZAEIIRNZ, 77 ANVDEEITHRFINET, -genflow 47> a3z nbo7n—7 —F 77 A
NOSGHTEGIEILET, Imagix 4D 3Z0DT —HEfRER CEHIHTTHITIL, -genvdb 7 —H & T L7
RIZRZNFEIT (-genvdb T —#EW51) THS, cfd EVHDT AL 7NN DGET 2R E T 2L ENRHOET,
-genflow 47" > a Ml SN COZRWEARTE, 7a—TF —X3AERSI T, 7a—F v —h, FHEVY
—. HHl7e—2r77  RORFEDOLR—MERSIVERE A,

FTavit, T — AL BT AEEIZE B EYREIET,

-gengcfDirname 417KV Dirname D7 7 A /U BB BLT — 2 2 EXIALET,

TFIAPFIE, Y —Aa—RF =y & FATL, TSI — AT 7 ANV DL R T B AN v 7 &
EIETHZENTEET, ZOMBEEIT —2E, =TT 4 IBRIBET — 2 BEMIS i Cndls
ALTHNZ, 77 ANV DEEIRAFINET, -genqcf A7 L a IO OWEE BT —4 7 7 AL D
iU E 9, Imagix 4D NZDT —X & RFE TEHIHICTHITIE, -genvdb 7 —X &7 (LR
PRAN[FEL (-genvdb 7 —Z L)) THD, qgem EWVHDT 4L 7 NINOGT A48 E T D0 ERHV E T,
-genqcf A7 L a MEASIVTORWEG AL, SWEE T — 2T ERSIVT | ETAFE D AN 7 A
RLAR—RBMERSER A,

FTarit, T2 —AEBNTAEEIZBE By RENNET,

-genvdbDirname T L7k Dirname DT —H 7 7 A T E R A EZIAHLE T,

T FTAFEBIRINIRNT SIS — AT 7 A/ e ONE B E XM E DD — AT 7 A )L
WZEFENDA~NIF T ANDE A DN TE T AT 4IBMRIB T — 22 LR LT, B LTHEZL
ONDLDIE, VAT AL IN—RT AV TN D~ Z T 7 AV T (-nosys A7 var S A7 var
DIAZHR)

NN

-genvdb A7 > ar MEHIILTWADEEITIE, il x DY —AFT I~y F 77 ANVICET 57 — 2137
4L 2K Dirname OHNL U727 7 A TSNS VE T, D728 BTN AIREIZ /2 DT, TR
BT TODOHETT N0 4T var a0V E HIERHVET,

FTaAd, T Y = AEEINT HLEICA BRI By hSIVET,

-impej AR —RENT T TRE RN TAT 7 AV THRREEL, IRIC java 7 7 A /L TR L E T,
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import class 7 AL 7747 3 —Aa—RNICHEBLT 5L 7T IAFIE DI TADEREZRLET, -
impej 47 L ar MEHENAE, TFHIAFITRMN -cp AT v a il UL EE FFESNTZ T AT
TANRNERRRLET VT RAERDGITINT TAT 7 A M RADINBIRWGE X, 7T T A IR
%0 java ) — A7 7 A MHBT 57T AEF#ET~ET,

-impcj. -impco., BL-impjc DA L a AT EWICHAY T, 47> 213 Data Sources % A7
12 M Class Paths # 71285 Import &—R 2 RR v 7 A TRIREN £ T,

-impco  AVIR—RNEINTZITAEITAT 7 AN TOHRRBELET,

import class 7 AL 7747 3 —Aa—RNICHBLT D8 7T IAFIEDITADERERLET, -
impco A4 F L ar M FENDE, TFHIAFIIITAT 7 ANDHRIE T EBBELET, 7T FILfEr
KIRD java Y — AT 7 A VTHEBLT 577 AEFRET X TEALET,

-impcj. -impco, BLO-impjc DA 7 L a AT EWICHAY T, 47 2213 Data Sources % A7
7' @ Class Paths #7122 Import &—R 2 RR v 7/ A TEIRSINET,

-impjc AR —IENTITREFEAN java 7 7 AV THRERL . IRICV TAT 7 AV TIRERLET,

import class 7 (L2747 Y —ZAa—RNICHBLT DL, 7FIAPIZDITADERERLET, -
impjc A7 > arpMEHENDE, 7T IAFITBRANSENT XSO java Y — AT 7 A NVERHRET, 77
ARTEFZDBFID java 7 7 A /W WLOMBIRWGEIL, 7T 7AW id-cp A7 v a Al T iE R E
SNIITGAT7ANNTITRAEREIRBLET,

-impcj. -impco, BLO-impjc DA 7 L a AT EWICHAY T, 47> al 1% Data Sources # A7
17 ® Class Paths #7128 % Import E—R 2L ARAR v 7 ATEREE T,

-impmin  jar 77 A VDAL R — RS TCWRNT TAZH L TT —Z & AR L E8 A,

jar 77 A E-cp AT 2Nl E o TT T IAFISEBISNE T, lFIL, jar 77 A VND TR TD U7
A7 7 AN T DT —2E T FTAFIZL o TEESIVET, -impmin 47 ar MEHSNDE, fif
Wt G774 VIZ import class 7 AL 7T 47 N B I T AT 7 AL CO I, T —H DL S IvE
R

-impwopkg  import 7 AL 27T 4 7N o\ — U A B L EELER A,

import 7 4L 77 4 7 Z T LR ) — AT T IAPIIERRA L R — M &R java 7 7 AV ET2 T
IFGAT 7 AIAZDUNT Ny —VEE O TREELEIELE T, -impwopkg A7 L a3 S
TWBG AR DORRFRIN KL T DL ) —AT I W java 7 7 A NV ETNZT TAT 7 AV DRRFRIZ
BT — VA ERLE T,

-incFilename &7 7 A /VOfENTBRIARFIZ Filename A2 27/ —RLEd,

-inc A7 a Ak, T T 24 — A7 7 AL O AT import Filename 7L 77 47 ZiB L& &L
RUCBEBHVET, 2F, 77 AVAREEESTICT 7 ANVORNT T IEEE R T HZENTEET,

ZOFTva AT EEL T, BHlRET7ANEAL TNV —RTHI2OIfEHENET, FRERE 771 /V
WZIXEE , SHEHOBREED jar 77 AWK 577 A SAa< U RNE £HCEY, Imagix 4D 774
PIEI— AT OB O Java FREREATI2L — M HZENTEET,

Filename /& Data Source %7 122 ™ Source Files #7 (2% % Language =12 R 7R v 7 A

C. ../imagix/user/java_cfg ND 77 A VinBEIRSIVET,
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-javad  Java LAMESCEERL T, Y —Aa—R&EffTLET,
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i
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AT 7 AN O H T 7 A VLR AR FE CTHRDDT 7 A ATHEISINE T, 20728, — O ER
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FERRIET T ANV TIRE T DLW TEET,

-vuid  fEAT T A AR IUIZOWT VUID AR L £,

TaYx IMIE T AR 2 A MAER T D56, HEIL 1 DO/RAZT RTORF 2 AV EEET,
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WL, 77 /v, limagix/user/doc_gen/sample.dg_% 2R T72E0,
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47 al X, Data Sources #4712 Source Files #7287 Options 74— /LR TiEINT 57>,
FER E T T ANV THRIE T HZENTEET,
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-warn TR TOT F A PEELZIRLET,
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LTSN,
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YA T ar OF 7 xR EDT=OIEALET,
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Java - F1/7OATEEL THRITEITS

ZDOFETIE, 7T 7AY1% Data Sources Z A 7 17 DR EITHE, —P A L H—T = A A DHEHE
BSET, XAT T TIL, T T 5 — AT 7 A BT DI TAT 7 ANDGFT, f#lTT % jar 77
AN EERELET,
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Zazr4 /)L 7—% - tcov, gprof, Fa7r71>

Imagix 4D (2L o> TUEES I, KARSNDIE RO LT — AT —ROFHIFFHTIZIES<EO TR, 2
D=V E CICH+Y 7 T =T D FATHEM T 4 —~ LV AT OV THH LD RAUEL . 75D
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TAIFAINT—EDY—R
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LET, Unix DFEITT77A /T DOWTUL, b RAT 47 732 Unix 2273 A Z % L T tcov & T gprof
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L BT ORI ORI TS E ., Imagix 4D 1% Unix B25E T2 Windows BiBE 72> 2 B4
7e<, teov, gprof, E£/o1E7 077 A 77 —HE 0 —R$HZENTEET,

AN O —R 57 =2V =T, AT DAN v I AL TRV ET,
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il 2 DEIFLA E NS T R FATEN T E R RLET,
Unix 4777 AV - tcov L2 gprof (347 =
Windows SEAT7 7 AV - T T 7 AT (TA L TNV D EINXTA LT T T W
Time (E7THF/E)
18 2 OBIEUCF oS IR 2 RR L E T,
Unix FE{777 A /L - gprof 2,3
Windows EAT7 7 AV - 7077 A7 (B A7) w3
Frequency (E75&E)
1 2 DRABNFATENT L EFRLET,
Unix 1777 A /L - gprof 2422
Windows SEAT7 7 AL - a7 7 A7 (B BEEA) 23

Unix BTI77M41LDTOT7AILT—E2Z BT R /84U

tcov & gprof Dlj 7 —&Y —ADGAEICH, VY —Aa—Raa AL 5L XA 7 v ar ay
FMAMENRHVET, LI TIELD T, 2 A ZIFAT A REa— R &Y — b § 5281280, e, 7
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a7y ANAERE T D7 7 AN EER T HIECEY, T a7 7 AT — X et T HREBN TEET,
tcov DG EITIE, K — A7 7 A MBI & OFER: (d) 77 AVRBVET N, gorof D55, 774 /WiE
FAT7 7 AN BIERTOEDTT (gmon.out) ,
HE . XISTAEHA T a3k O@En T,
tcov
Car /(7 -xa
C++ /317 -aFlzid -xa

gprof

Ca A7 -Xpg
C++ 273147 -pg 71T -xpg

INHDI A TF T ar DL, g AT var BNy hENTWDE, YT AIENTEEE A,
AL NATTZ T DFAIRE R TEZDOWTIL, A A IORF 2 A PSR TLTESNY,

Windows {777/ DTAI7AILT—E2EBMT S /8M)L

NET LV, 3—2 50 Microsoft Visual C++T7 a7 7 A F1 A+ 5121%, 7774007
EEINIL T ey 2 NNV RTAMLERHOET, 7Tu7 7 AV TGN T HI2iE, ey =k
DBREZATOT DV IET DTN TT a7 7 AINETIF 2 IRy I AT = 7 ANNET,
HIFLLTZ 2 DDOTALTIT a7 7 A FERONT N E LR LTV E 2R, W77 XX 7 F
INMZLUCEITI 7 AN ZE AR LRI IEZRDER A, TV 2V DR EL AT AT DY 72T D—i%
BT AV TT NN TERE LR T DT 2o IR T RCTF 2o 7% A, FRZAT el O CIC++42 T D —fik
AT IV TITEFDOREINIT TS T LT —F_R—=2 5 (e T o 7 ERORE U CRIRLET,

FEL<IZ Microsoft Visual C++D 2 —HHARZS L TS,

TOI77ANT—E2DERK

WA T ar ey U CTHI AL, Y7 =7 %2 FE4 7L C ImagixdD 235 ~_57 a7 7 A
NT —BE T DERHVET,

ZOEXF FHARTWT AN =R EALET, EIT77AV2FE T 5L, #RIT A BRI L O
gmon.out 7 7 /L (Unix) E7ziZ.pbt 771 /L (Windows) |Zfli#E S ivE 7,

Imagix 4D 23, EIT7 7 ANEFATLI-T T b 74— A ECEIEL CWDGA | fEROT —X 77 (/v
DOEET BT 7 ANT —ZENETHIENTEET, ZORRITL, T —F 77 AV OERE )T 57
DT gprof £721E Microsoft Visual C++1—7 VT 4 D—ER72E | ZD 7T 74— - Cff A Al HE
AT AT —NERIRALET,

B, AT ANT —BDOIART T T — MENT ATV WA ImagixdD X, E 0T — 2%
0—RFTHIENTEET, ZOGAITIEL, FITT7ANDRAT AT T I T4 — L ETTHALT —
BT 7 A MDD OPILERAATHONLERHVET, ZIUZLY, Imagix 4D [ FEEL TWA 7Ty
F—b TR REA R = DN TEET,

MBI R T AR LT e T AL T — ORI L E T, e~ o N R RV
LA THZENTEET,

gprof (gmon.out) DIGH

gprof -b executable gmon.out > results file
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7'a7 7 A7 —4 (executable_rootname.pbt) D54

plist /t executable rootname > results file

tcov 7 —# (.d 77 AV) DEEITIE, FHRAIMLESHDET A, FELUT gprof v == 7 L —UF
721Z Microsoft Visual C++D 2 —HH AR ZB L TTZEN,

TRIFAINT—EDAUR—

7 —%>— A% Data Sources % 7117 (A==—[Project] > [Data Sources]) Zf#i L Crn—Rr4252L
MTEET,

T =5 =2 — RN BIEFFIZIE, fRHVET, Tl T LMERERITT 0T 7 AVIERPE—R
SHBRENZ, Source Files |2 LAFRHT T IEOWT AL GEINS Vi Aud7e0 4 A, Imagix
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FTAHIENTEET, ZHUTED FBAEDO T a7 7 A NVAFEREZ ANy VAR TEE L TE 2 —T 5288
TEET,

gprof 72137 a7 7 AT 7 —HEA LR —hLEIEL TV, LS FEAT I 7 ANEETLIZT T T +
—24 BT Imagix 4D ZBH{ESETWD5 512X, T R7 7 AL T =S DOu— RO, S50
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T CICH BT E T > TODIAIZIL, gprof Result File 7213 MSVC Profile Result File 2 L %
T o IRRT Ty T — BBAFEEA T TS AT, BIUBIE B 8B C R R A S A a1
A= B EIZTICROET,
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T7ANL, ENENDFITRERZIRAEL ., BLDOBHLIATOR R, FIFEOMAGDOEEZE 2—F
DIENTEET,

THUCID, SESFR T T AV T = N OIS D DR EYR T O L TE R, 2 HE (K
TAFZA LTI AHIV) FEATOHA toov, gprof, (N MSVC 7'u7 7475 —XaL 72 DEEITE-T
XFET, Gprof, a7y AT Tl EIT77ANEFATTHENNCT —2 77 APy hsivET,
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tcov D.d 77 ATV hESNER A, FIT77ANVDSEFETEITHE, TORBFITRBELET,

Manage Profile Data % A7 0/ (21%, 7 AN — 2% FATT DRI tcov 7 — X 7 7 AV a T~ TR
LT DHEREN DV E T, ZHAEFRIHTDE, tecov T —F 7 7 A AT LU DT ANELTORE T D I S
WHIEWTEET, 207D DALy VAl & OFT AN —AZ LIZBIHAHTGBRBRL | #3524
INTEET, AT, ZOED, Fu7 7 A VT =L E TR T 7 ANV OBIEDON R —T
TOREEELHVE T,

D ORREZF AU, ERiL CT AN — A% FATL, & FATORIC teov 7 — X & AL,

TNENDOIATRIHERZ TS T HIENTEET, 2D £ T, Manage Profile Data % 1 7 =2 % F| H
L, RIEWFEREFEEL CTRAZENTEE T, IRAFESIVTODIATOREFIL, (ERITE, Fio, £ T
HLRHZENTEET,

INHOEREIISESERE THHTAZENTEET, FFEDY 7 N =T OE B NIT—R DT 3 —
2 VR RIE TN LIV AT, FDOY T NI T DRI AN—D a0 N DN RICT AN,
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— ADFERE T AUT LNV TLLED, F7-, —BOT AN —ZA2{ED IRy PEFLDTRIUL, T
ARNDFERES TR T DZENTELTLL) FTITBEEDT AN — AL DAL TIRAA VTN
BRETHIET, TAMN I LT HZENTEET,
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BIEDE LR - X4 2F74 /L (Unix DH)

AT T 7 ANERNTI TN =T HE AR T DG, ZORNITay = 7 T — 2 _— R ZiB N
LIEWVMERE S DET, LVbIT. ZOBHRIZE DY — AT 7 AN SANTEHZLIL>TEDAT
VIR T7 7 AN (0 Flzitob) ZENART D, FEDOF T I N T s ANE) T B TE
DFETT77ANEENVRTENERRLUET,

ZDERIIA T 7 7 AN B L TUNEETHENTEET, A7 7 7AVfENTIL, Data Sources
A7 vr (A==—[Project] > [Data Sources]) C Makefile Contents D5 — 2> —2Z B INTHZ &I
FoTHELET, make 2w RIZESTEDE WL SNV DAL T 7 ANVNLIVIRNL IV DAL T T 7
ANEEOHTIGEITIE, BF RS L SV DA I T 7 ANV TT —ZINEE TR E T D721 THRAIT
7

AT T 7 ANACE FNDAL AT R OV THEAFBIFRIE, Imagix 4D DO =—Tl% Depends On BafRE
L CRURENET, 25D Depends On B2 Includes BRZAHTEL . Y —A3—ROMEHTIZ L~ TH
BB SAVE T, Includes BAfRIE, E D~ F 77 A NINE DY —RAET NI~ H T 7 A TG i
B LET, Graph 7> R C Depends On F7-1% Includes Bdf# % = — 951213, Files DT 7R
WG QLA DIDNTHRE T DMENHVET,

AA DT 7 AIARNTE, A7 7 7AAZAE 5 make 2~ RO AR—T A2 X > TREVET, Imagix
AD [3¥ AT (A==—[Tools] > [Options] > [ Data Collection]) ¢ make FFOVH L& EF5 L . make,
gmake 22X D55 E D make 2~ REM 0 EROET, A7 7 A ENTIE Unix il Imagix
AD THEMHFTRETHY, 7TV R T A —LDRAT 47 73— a D make L O GNU 73—z make
Y R—RLET,
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F—ZDBEM - vdb T71/L

—#%IZ, Imagix 4D 7 —H X —A L Imagix 4D 7 — X AL I XL > THERSINIET — X7 7 A )V fifi

HLET, 270, Y7 =TI T 5RO T —4TC, 1) Imagix 4D 7 —#aL 7 X 2> TEIZH
RENTELT, 2) 7ay=/DOarTXANDRTRAMEDHLLONHIUE, H o THERL

T =BT ANEA R T HELTEET, [lx OFT —27 7AW, 2RI 1F&7
P T — 254G a1 52N TEET, Imagix 4D DI H 74—~y MIKIGEL TWATF —F 77 AL T
HAUZ, Imagix 4D 2L > TA LR —hTHIENTEET,

BINLIWT —2&28&Te7 7 A V&AL 7-5., Data Sources % 711/ (A==—[Project] > [Data
Sources]) T Vdb File DRIZIRIRL , 77 ANV DERNALZRELET, SAAITHFNIH D EE A,
INTBELIZI 7 ANDT — 4N T —H_R—RA I —R&H, 2P A Z—T = A 2% ML TR
5912720 £9, Update Project Data %7-1% Regenerate Project Data DF§RER FEATL 7= &(2iX, D
T AT OB A RONLTZT T, ZEAGHIUL, B TLRTIZZRVEE A,

RN T =T AN LR T D= AL TR, BEERA 2B A E R BN 556, 7k
7 7a—RE/IZ FORTRAN 728 | I CICH+a—R~DT I I DONTONEHABINT 585672
ENEZLNET, BIILL FICEITT T, =TT IBRIEERIS BRSO
%..Jimagix/data/vdb/schema.vdb £ 8§52 3 CXE T, Imagix 4D DT —HET VK NEDT +—
<Y MIDOWTESIZEELWME#RIL, Imagix Toolkit THEffEE 1,

72T 5a—F

Imagix 4D Ti%, FORTRAN, 7t 7 7L il 5B CHEESNca—RLEbITE SIS CICHiEs
XN Java DY —Aa—REFHRBZENTEET,

Imagix 4D 7 FFA FIXESIZZ D CIC++B LW Java DY —AT7 7 A )V ZINA L 7 —REi3A
VIR—RL TSR T 7 AL E LG IR £, M5 552 Voo 7 7 A W RIS T B DO RE
RHUIE, A7 ZVBEE OO LERERICEES N E T, BIBOE S, KOENDBEO IS
DPDHALV AL RGP RHZEINTEET N, FEDOLDODEFR, KOO T OREE RH5Z21%
TEEHA,

B EDEENAT DAL TOIUL (R — A RO T SFEYLIE | OTAZ ) | Imagix 4D CIC++7 7AW
1L —T—NR asm £72iE_asm Z il L CRAISNTIAL TAL T/ T T2 BLET, 7T 7437 &
VT Ta—REAR T L, TR T T T 0y DR TN AT E T,

TR 7 Ta—RiLEE O U E OR LT/ T =< ZANE O B A F2E 5701
HENADT, ZIVTHRIZIR D T, 72720, CIC++ Y/ —Aa— KRB ONHE =870 1252
BOT vy 7 7a—RZT ITURALIEWEBIZEEHHTLEY, ZOEEITIE, 77U R ER G R E
BT —HT 7 ANEEK L, ZDT —HT77A/V% Imagix 4D IZA LR —h 52N TEET,

WDEH7RT 7 T7a—REEZ THELLD,

PFPROC TRAPO8
PUSHF
CALL DWORD PTR CS: [OLDO08]
CLI
PUSHM <ES,BX>
LES BX,CS:InDOS
CMP BPTR ES:[BX],0
POPM <BX,ES>
IRET

ENDPROC
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PFPROC TRAP28
MOV CS:TryPop, FALSE
MOV CS:InPop, TRUE
STI
CALL START
CLI
MOV CS:AllowPop, TRUE
MOV CS:InPop, FALSE
JMP DWORD PTR CS:0LD28
ENDPROC

TIREAINT DT, T T Ta— R TREBER P HB T 2500527 7 AV DY
175 5% 5.2 DU HYET, TRAPOS % U8 TRAP28 78 C 1—F"C #4124, _asm_Trap08 % 1}
_asm_Trap28 LU CREON S AL, IRD IO 72T TIERS VD vdb 7 7 A VAR T HE L ET,

GD /#root/usr/examples

GD /#root/usr/examples/asm

GF /#root/usr/examples/asm/foo.asm
SP /usr/examples/asm
</#root/usr/examples/asm/foo.asm
Gf ./ _asm Trap08

S1 2

Gf ./_asm Trap28

S1 13

>

LATBIE, LW U RVBER (G) SNDZE, 2DV RART AL IR (D) ThHhHZE, TDL R
VTV N TRV IBrootiust (28 ENDHTE, FTo, DV RO L REITH examples ThHIEEIRL
F9, 24T HIZ IROFT AL ZRIL~Ub asm IZDOWTCRICZ &2 M0 L £9,

STTHL., VRN T7 AV (F) T, foo.asm LV O£ AT THHZEZFRITIX, RILZEAMDIKLET,
49T HIE, I b oL foo.asm D3 A (P) DJg % usr/examples/asm (2>~ (S) LET,

51THIZ, <CTHAED, HrLWVEHE 7L ar DD L 2D I av BNV R
[#root/usr/examples/asm/foo.asm (ZfE sS4 CHZEA/RLET, Mroot [T/ XADIEFVEERL, HEiC
T H D24 MgEE E 9, Windows Tl /#rootc:/examples/func_ptr/foo.c D X572/ A% 3528
HTEET,

61T HIL. FLW AR DBER (G) DTl TDOV AR () ThoHZE, 2D R hy
VRV foo.asm DAL eI ay (DITEENDLIE, Fio, BLOI LRV D4 i _asm_Trap08 T
HOHTELERLET,

74T BIE, AL R R 0 _asm_Trap08 D17 7= () @4 2 122y MS) LET, OFD,
_asm_Trap08 |XE DT 7 A WMZLA, ZNDERSINDLT 7A/NVD 21TH CTEHRINET,

8ITHL9ITHIZ61THE 7T1TH O#DIKL T, RO DO EZH L OITE SR ELET,
1047 B CTHAED BV a2 foo.asm & TLET,
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T—RDEF

TV INIT A= AEIBINTHE V= Aa—RPNER S, Y7 =T L Imagix 4D T —H X —
ALDFEHDBANNDZENHVET, TOHEITIL ATEBEOZEHIZLY, File Editor 74> R DI LR
IVDEBNEZ D72 EDIERPENET, 7Y bDT —FR— 2R FH Y —ZAa—RICE# ST 5L
XL, T AR RO B E — A — R 2RIZT 5 BHISNEH DT T T A0 EERET,
EBIC, TP 2 IhDIERE AT DY TR = T DB EDIRREE L MRS T IEICH, FEiE B E)
D ST NHVET,

IO FIEITRINL GHAGDOEHZENTEET, 72&x13, H HIZ Update Project Data #§8E% F
B TREOHL T, =Rz 21 2V A XV REEHIE L, &M D cron Va7 L LT _TOT
— X~ R BEIICEIT T AL T, 7 AR —AE R R HBE T 52N TEET,

AVOVAVBI / REEH

T =)= ANERINIIG AN DHT =2 FIUET DA TV AZNT —2INEIE, A=2—TC
[Project] Z 4R L . Update Project Data O F&#EZ 1@ L T ATRE T,

V—Aa—RT —HDOGEIE, ZOT —FOFIEFIETIIROREZ O HLARVET, Java TOX A
T ZAE IUTRYT | CICH+T DX AT 17 %Al L7 fifdT . MSVC Project (2Dt L E 721
MSVC Workspace/Solution (2L AT 17 1% W CIEES L= 7 — &Y — 2D 4 . Update Project
Data Zf H1 2L, 7 —HIERAIEIOINER IMEESNTY — AT 7 AV HHWIA L 7 IV—R 77 AL
MEIESIZY — AT 7 AT DWTOAHFIESNE T, 7L 21X, O EDD~Z T 7 A /WD HZE
ERMRDNTZETDE, T—HIZD~H T 7 ANV EEEN ET IR E T CICHY — AT 7 A
JNZDWTORMEESNET, A 77 7AWV ZAE A LTt J7 5O FE X, Data Collection Options 47
AT AT DEEE AT T 7 ANV OREEIZ L > TRV ET,

ZOMDT =52V —AZLoTIE, ZOT —FDOFNEETHLIUIEED AN EITV R EA, 2L
ZIE, TV 27T =2 — 2D OEDH Makefile Contents (3341214, Riil=] Update Project Data 5
7-1% Regenerate Project Data Z LB L 7= & ZLARRIZE DA 7 7 A NVINEHSIVTCODG D H, £
I OFHAIAENET,

Source Files B X DD T —#) — ZTONWTH L TH T — 20N FINE S AU, Profile Data @
T =2 —=2ZNFRe—REnET,

Regenerate Project Data (37" X CHOTF — XA FINESEE T, ZHUTKY, Ty =/ NIEFEIZHHDD
T =) = ADEHOREENFIEL . T —H 7 7 AN DREESNI=T — 2 bR 528 TEET,
7120, TRTCOT —H)—REH 5T TN 20T, Update Project Data JOIFIEA 0 ET,

FB  HREH

TFH)T Imagix 4D 7'my =/ b7 —& & H 3 5L &%, Update Project Data }z UY Regenerate Project
Data DEEREZE L £97, b A==2—"T[Project] 23R 4L, EHAIRE T, /o, T —4V
—AF ANV EFEBE AR O T a A0 —ERELCHBIICHIET 2L TEET, Th
ZRATIUE, SEbWRWE X 7T/ THIERITIZ LN TEET,

v RIA DT —EOFIUEEAT) FIEIWL D0V ET, £O—5IX, #)72 Imagix4D 77
TAYEa~ R INBILTT7 7 AV EL CEBEEEN T2 515 TT,

ZAUTEXIZ, imagix-csrc 7 TAVEALEN T DAL T 7 ANAZH—F I NEBINL , A7 T 7 A )V %5
LT C/C++a—RDIENTEATI FIELRICTT, AT 77 AN E L TRRNTEATY FIEZEIRL Tvd
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YA 1ZiX, imagix M OY imagix_update DFERD AL 77 7 A /AN DD Z—7 Y "RV ET, Zilh
MENTEI, I—RDO5ERIRFRNT e A L TV A H VI T b 75 L E7,

ZOFETIE, cron Va7 F3KBE /LR 227U 7 M make -f makefile imagix DX H7ea~ 2 REB0
LET,

AT 7A@ L TR 24T T IEZ L TORWEA T, 3~ R0 D bIEHE Imagix 4D 7
FIAFEREBTHIENTEET,

L7>L. Imagix 4D A AZE B¢ A7-Di2-cmmd 47 a4 L THBEIICT —ZINEETTHOD N
BEOIRL MBS ETLL), ZOJ1ETIE, Imagix 4D 133y F B —RTREIL TEIEL, FHES
Niz—#HDOa~v R FEITLE BT & TLET, Imagix 4D (20D (—#) 07 vy =/ i, 37
RCOTAY 2N —H e ERSE LA ROy NARETHIENTEET, JHuzkh, 7my
I —HIEF O 7T LRI ET,

ZOHETIE, cron Va7 FdKBE /LR 2277 NI imagix -cmmd ecmmdfile DT AL b R
BILET, NyFE—K, KO emmdfile D7 43—~y FOZERNZOW T, K —FHARD £/ ##%
ZRLTTEEN,
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Zasror)y—X

F— AR Ao — R U CRT 2 3479572012, Imagix 4D 13— DT —F_R—2&H L £3,
ZDHIBNODNE, FFEDIRNT NELREN TND LIS, ERIZGU Cr—REnE T, T 4—~
A& HL T D=0, Imagix 4D 137 —F _N—2& AEVICn—RLEd, [EEHHE T, EFICRE
W BT T BT T DEED AT A — =T =% DD T AR AD— BT A AT DL
BRI T 2 2Lb TEE T, T —F_X— Y —ZADYEIRED 1202 T 4 A7 O Gl ez 6 -9
D& HENERIEL 720 $hE (2155 20 f5) ol 52083V E T,

DI AT EFRE DR —RA471d, Options %A 717 (A==— [Tools] > [Options...] > [Data
Collection] > [Project Resources]) D% E (K HIISIVE T, SHITEEE (ZHIlE 3 5121% 4Ddefaults 7
7ANEEHALET, GELLIE. [imagix/user/sample.4Ddefaults # 2R L CTLTZEWY, ) 2O —RA 713
Imagix 4D Dty ar Ok L £97, R EL T A KBS EHI21E, ZE%IC Imagix 4D 27— AL
THA—7 T o0BERHYET,

a7 T AT A EBMREBITF ATV SNE T, ZOFERIL, 771V, 7TA, BT T7 HH

HBWIEH, Y —AT TP 77280, Imagix 4D OFMT & RICB T DFRKRO KE 73 D Hatf 729
HOTT, a7 T —FHDOATVOMEEIX, a—RNTOV LRIV T 4T ) DFERRITEI S TR
720¥E9, Imagix 4D TILiEH . 400 /725 1000 FETOXE G Y —Aa—R%E 1 ooﬁ’m Tz IRT

JLBRF B2 L3 TEET, Imagix 4D gD 7 ey =/ ha— R TAEVEEWRIZLIZGE,. 277 —

BDYARZEHT 1 oD IR, m— VBRI T AIE R OINE L N5 é:fa“ ZIEAT
D& FAT AR FEAT DUV O DI AVE T, 712, Flow Check LR —hD—fiZn— 1 /VZEE D

F—BENVELLET, BEARVZROT 2F B OFEL, VY —Ra—FESEL . AN AT AT hE
Blx DT ey VN ERR T HZETT,

AN I AL —=AF 2 VITERILE 2 DT —FRX—RA RS NET, a7 7 —Z L3820 AN v
AT —HFTERIZISC Ca—RINET, T 74V T, fERERD AN v I AT —H_R— [T AEV|T
n—REINET, BER—ATETINDZD, T —Z T ARXIE D AN 7 AIRBLRESFUTONDDNK
FLET, R, T—F A RIBRBLEaT 72D 12OV A X THHEEESINET, L
7=MoT, 100 55500 B ECTOXE G/ —Aa—R&2 15O a2 VN TR TEAZ LIZAnE
7, AEVOLEEEIL, Project Resource g% iE (C LV HITK CEE T, Large 7213 Very Large IZEET 5
&, 7BV =IMNI 300 T 800 H DO XN G ENLLHAEBHVET, ZNEHIT DI, TAAT T —
AR—=2%fEHLET, ARVDOROVIZT A A7 EE T 28, ANy 72T —2DOHHEHRIZB VT
2-10 5L E£77, Very Large IZERESIL TN DA BUE T 2D13 4347 0y = 7MIRL T 1R
0TI, 2[E BIZAN w7 AEHRN T By = 7N I — RSNABRIZIE, ANy 7 ATBRICAE T —40 0
HEFEHLTHLD, FEEICo—REEIZATI DDt A A X020 E T,

Flow Check L-7R—h& Calculation Tree (2 HEND T —H# 70 —T —Hd, 5§ 3 DT —HX—A IR
FEINET, AN I AT —HL[FRE, T —%7a—F —ZFE RIS Cr—REh, dHESET, &
W a— LT —H 7o — AT IIIE T B HECHY  FR LRI E ATV 2 LB LET, T — 47
0—7 —X DV A XL, FEr—IVER O, BBEFIROE., YAra~TF v 7B L OBRIZE
ST, AT T —HD 515 20 512720 F 9, L7223 C, Imagix 4D O7'ay = 7T, AEUBEFHY
W FESNDIEAICT 74V RORERL T 20 Ji 7035 100 5D L ad e —Aa—REZALPECE 528127
VET, ZOIIRBINLO T By = 7 NE, fENTITRE RIS 230D AT REMED BV £97, Large E721% Very
Large [ 2R ESIVTUWNDE FRNTZN 5 {505 20 (503~ 5 FIREME RSBV ET M3, 7'ur =/ bt
100 5725 500 5 DSLNZETHRL T ZEMTEE T, ZOHEDO T o= 7 M T, TS T -+RERTH )
MDAREMERH DT LIZEFEE L TS,
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Imagix 4D 1%, #HHETH L), b —F =T BTHDLH), HHWLIHATHS C, C++, Java DY 7L

=T DN, R 2 A MER., BEXOSEE LB E T, a—RDOTI0V 7Ltz B ekl ., KR
Biie7a 7o b BT a7 I A RKNOTar T8 W r T sk RRSBRTHIENTEDE
NI TWET, ZOY— VR AT UL, BL_XAOT—FT7F v )bl &« OEEDEHI2 7 1

T2V IET, HHPHL UL TOY TR 2T DHRRENLE 22— HDHWIV AT T 4778l
DNAIRECT, Fio, filiERES, 7 — 2L, 77 AA RS V7N =T OSES Ml AR IAE Y

2T LU THAE T2 TEFET, Pl I02 0 B IV IEMIZHERETAZ LN TEXAIOTRS

FERAEFEMELEEY VI NI 2 T DR MEHES TN TEET,

Imagix 4D O i EfENTHEREIL, 7 b =7 OB OHERFE BRI 31T AIEERI B FFE 1AL
T, BROMH, # A7 DOEE), BLOERALNS DRI 5 ORI A2TTHOZ& T, =
—PIIVTNEA DFLIA TR D v VT ZAX T < VT ALy MESIVTe VAT LTI D 55 %
FRRDHZENTEET, V—AF =y 7ZH A3 UL, PIRMEB L ORHEIZ OV ToORRE LA D=
—F 47 EORINEFE R THIENTEET, ZL T/ 7= T AN w7 AL, B T o A2 EHL
T ANE GRS JORSFHEIC B T RN ORIl Y E AT 7= S22 TN = 7 O B R E T 59 A
THEBHET,

F7-. Imagix 4D [ ZAEROMNT, T—R DU E 2— VAT LR FHI BT DR 2 A hOIERIZ D
TeVE¥EAERIBIZAI YR, RTER° HTML 72 E DL TR 2 A M BBV AR T 5281280, IE
e TR O MATRML £,

PLUFCiE, Imagix 4D NENVRENLEEMEL /2D 7 —5FE 7 U OWTIHLE T, 207 —4%, 7’1
7T W BLSEEST D120 DA RIRIEMICEHT HDD, Imagix 4D +—HF AL H—T = A ZADFab
WY,

FEE2 Imagix 4D T A AT L AVL 3 DD/ RRT DIV TNET, Main 23X RS T A A7 LA D _EER

FHRNZHDET, Main S UEBE L — WA L H—T 2 A AD L BEE/RE 5 CTHY, —HDT A
TULATA RPN EENTOET, ZNHIFENE I, B OV 7y =7 OFEE ORI A3 LD FE L

PR TEDLIONT, H LSV TCWET, Y — L 2T 2BR1T, SHIGELGRE T 272012, Zhbo
TR D RERVELTZD, IBINOA AR AR BN LIZDTEET,

2 OO 3L E LT, Main 233 /L D 2T Project 2%/, T2 Symbol 7SV 2380 E£9,
Project /SR IVZITFENT S ALY 7 ) =7 OEFLPHIZBIR T 5 — DX 712k T o v s —v
S HDIREIVET, Symbol 2SI E DS AR BT A5 RN & ETRY, ZDIUR
JUAZDNWTELD B Al A FRE T DD SLOEN, TS —ar b 2—L LU TORER R
LET,

ZZTIE EHARER S TED T A AT LA R O YDA = A LZOWTHI AL F9, ZH0R08
I FELTENSE SRITHRE T A2 DIEIAENZHLOTHY LR —MIHOWTL, LR—F
RICETDEEFERIVREINCNVET, TAATLABLOY Y O EBEOME 5 %578 3 D ci7s
JEX, TAAT A2 Oarha— BT A I0RE e a2 (372 Imagix 4D OMR i E Y
~IVT(FLF—) 22 RS2 528TT,
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F—HET/L

RO oy = e IS E . $o, a2 /NI T —H Y — A% BT 5541213, Imagix 4D D
ART —HR—=AZHBICT =R —RSNET, 2EEL T, 20T —HX—X X, V7 =T
(BT DRI BDT — 2B —HRFESNE T, Imagix 4D D2—H AL X —T A AL, Z DT —H
BT 4 IVEINT RIRE NS THAER L DOHAIE M B G0 DR IC B C X5 7= 6T
IRT AN =R LDEELEZTRNTLE,

ZDFEART —HR—AIA TV = I M DT T 4T IBRIEED T — 2T Ve HLET,
Imagix 4D A2 SADY T T =TI ZDOWTEF DT — 4 I—RDRDY RN T AT 4)
Z O EORAFER (BFR) | 8 &% D ARV EAT DA OIFH 8 ) — 2L 5128, #2758
THIh, ZNROBITA BRZRFIELL TRIRENELT,

ZDOT —H R AT FESFR L VAR NBIEE IR GRFR L £, 72220, int O XD 7 AR T — 212
WREST, 7740, TALIZRIEWST=EDFE T, HHDDY TR =T a iR—3 U Moy RV EL T
WET,

ZNHDY R TENENOLOBEROES THO T ARV EBEM T HIVET, 72E 2R, U
OOEERESIE, Tl EOT7ANNEDERML PESEE LN, EOIOREREZINNAS
NRELTEDD, FHUCESNWTED LR 0 — )L OF RIS A AN EFREINTNDD, ED
JORBBNE N u— USRS DO EFRIE T D0 S ST A BE AT TODTL LD,

Imagix 4D |37 — & _X—ZDfE & DL LR HDONWTEEL D BIELINEL T, ZhoDBMITE
BOHIEPICREANOITHIRE , RV OSES F45 2T L E 9, Imagix 4D NEET D)8
P, 2RO IR TV R NVOTRNZ LS TR EVE T, 72210, 77 AMZOWNTE, 77 A3 —
Ivvay, BEHAREOBRMERIELET, ZIUCH LT, BBO BIEICIZZ O A 7a~TF
JEMEE R E N EENET,

SURIILE

Imagix 4D (3 < D725 ARV ZGRFR L £, 20— LD ZLOE T, (B E, 5~ D
RN E TN —TICEEDTWET, HAFEO T 7 AN (A I T 7 AN AT V2 TN T 7 AN F
— Y MIEA T T 7 ANFNTE B RSN E T, Z OOV RV T — 2T FRT Y —RAa—Fk
FEATIZ Lo CUUEES AL, TS NET,

Directories (5 (L7 }) FALIN) DI FE I ET,
Files(Z77A /1) NAFV ¢, e, FAT, ~o & TAT IV AT AT V=
INRE DT 7 ANEGIRET,

Namespaces / Packages (4 RiiZE[#// 3w /r—20)
CH+TITL ATZE M EFFIE L, Java Tl S r — U ERE U E

T
Classes (77 A) TUTV—b IR KGR, R REEE B ET,
Functions (B%%) RIS ON—F v VB A5 AT,
Macros (=27 12) YIAERD I HEGHET,
Variables (Z545) B OBIBORA L 2% 8 E T,
Data Types (5 —#7i) Bl FIEER ARA 2 FRTEFRTL, typedef 7oL DRIA5;

#iﬁ—o
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BERE

BIRIZ, S T2 DY U ANV OEIF IR Z FAITR L E T, Imagix 4D D7 —H#_X—R TR D LH72
FRAAGERELE T, BROEON R EY | BfRT — LY — A3 —REHTIZ L > TUES L, S
ET,

Aggregates ((Efk) /TR 1=>27TR2
IFGAR2NITAL DA SDEEILLEDITNDHIEERL
E3x 8

Base Class of (JEE 7T R) JTAL=>TFA2
TIARDWITAL BRA L CNDBZEERLET,

Calls (FFOVHL) B => BA%k
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Flo, VRN EBHE RO Y AR DRI BR AR L T I 7B A28 TEET,
ZOHGENL, FT AL TTTUURNVERIRLE T, £D 1T, Add #7172 T step/full
up/down DWW HNEFI L T, BIILIZW S LR L O BIIERINES L TWD Y RS D R A
SR LE T,

Add #EEIL, AN EZDBIEIZIE SV TEMT 228 ATRBICL £ T, Imagix 4D X, V—A=a—R
MOHT RV R OEROTERAZINE T L&l x OV R VT ASESER B LR L E T, =
NHDBYEIZIE, AT BRED T RNV DIERFLIRIG, RNV DT 7 ANVALE, TZZT 74
IWINEEENTZONNODRE | HEVEETII RV ET, SESERLONEENET,

Add BERETIL, S AR EZNOD BHEIZEE SN T TV ZIIDNTHZENTEET, Add 1%, FEELT-
AL ET DR AR ST X TOV RN EEELEDET, LFiI7RE ., —EHORBMEIZOWTIL,
glob AZ A NVDJEBA(ER) & FEH T2 ENTEET,

Fm RBLEV VAR TS -5 RV BAVTIRB LT VARV o T e A
URNVEBINTHIENTEET, 72X, Graph 74U R 2B 1 BRERRENDINNTHEL T
WHEEIT bar LV I T ALK LT ELEL LD, MRBDFER, 7T 71UE, 7T A bar DITAT AV
NITY 7T RTOREEDEINSNET, T, 77 AL~V DB 2—T foo LW HBIEA R LT
Lazi, B foo DERE G L7 AN T 7 ITBMESNET,
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AEHT

Graph 7> R Cffi Al 77 T URSREIR, &) TR CIAFIAIZ M 55728, £72 Imagix 4D (218
RN BT E 5D ELKLEL DB LIVEY Ao BIEIDO T AD Iy 7 T—fiki)/e s =) % 3 RSET
T HIZIE. Analyze #EREZ LT 2L 0 TLED,
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FDMD Main /¥LILDY—)L

Imagix 4D DT —H _X—ATIL, AIRESADY 7R = T POIEES D IR #IR T — 2 DD B ET,
ZOT—R%, 7T AORAEES 58 HZR RIS 5073, Imagix 4D DL —H A7 —
TxAADER B TT, TO2—WA L H—T 2 A ATlcb BERER D H IO N DT A AT LA
TAVRTTH), BT 4 RNTFINEI, AEL TNODBY 7Ry =7 Offl # ORI B fEA T 52912
E LS TVET,

Graph V4L R ONEEME T 5 Main 2L LD LRI, V7 Ry =7 OZ Ol i
INFREIVET, Flow Chart 7> R X B N IOl i1~ m—% R L £ 9, Calculation Tree (21,
BRI 2,V — A3 —FOF L T T DM ERSNET, File Editor 7> K713y
—2A—RNEZOFEFRLETH, T IS R O £,

Imagix 4D @, FE KOKED 1 213, ZNSDT A AT L AT RS> TREBNC & B TS HRES
NADITMZ  ZIHDT 4R T X CHHBIGER L CWAEZATT, ZNODTFT A AT L AT/ A
BETEHATIIET, V7R =T 2T IR L TR RO DN TEE T,

Flow Chart 94> K9

Flow Chart 7 t> RXY 7 by =7 OBN THEL T 2HIH 7 n—, 372bb 7 mroamyy 7% XoR
LET, HEITOY —Aa— R bilb I 7B B O 512X, —F > ORNE ey 70 J0iH
WARHRIZENI DI e HNET,

Help A==—"C Symbols 2R § 5L, K THEHIN TRV ETHT U 1 RUBRRIILE
T SWitch LD L7203l I ZE TRBISI, 3—R DAL TA Ty 2T E S TRRSNET,
EEEOHIE 7o —13 AR E SRS ER TRENET,

Flow Chart ©7¢> K71 File Editor |28 822V 783 TCUVET, Flow Chart EOKFEDT R~ D
ARA L 2B TOv 358 %75 File Editor D5 —Y L3 — A3 —R _ EDZDL L RLD
B ~BEILET, RIS, STRARALERY — 22— LICHARIE T/ 74 %L, Flow Chart ™7
AR DG DYV RVPIRTANATA R REINE T,

Flow Chart 7 4> R C Vertical DL AT NRINT 5&, KFDLDIZY —Aa—ROERZ(1THZ
ENTEET, ZHUZL, Flow Chart 27V M A5EA 12T EITME R T,

Flow Chart 7t > R 13l 2 D BN O 5 272 il 7 v —2 R AR U E T, #EE ORI E 723> CTHil4E
Tua—& P OEA 2, Graph 742 R ® Control Flow £ =.—%F| L %9, Control Flow £ =.—
IEHIGL ~L3 1EERE E230 Flow Chart D7 47— /L D— % RWET N, V7 T =7 D IDJRVVED
SR DG A fR L £,

Calculation Tree

Calculation Tree (21, Z2EOBITEMEIZET S, sHEICET A ROBFRINET, FFEDEED
EIZ B DT X TOEHDORAEZTIRDZENTEET, File Editor D7V IRy T T T A=
—OEENT 585413, Calculation Tree |21 XIRINL 72— RITO BRI OEI TS BT HRATZT N ER
IRSIVET, O Caleulation Tree Tid, BT AU ET DT X TORADFEHTEIL
7,

Calculation Tree 7t R, SR BEOIEZ R MHE 2R T —1HOE 2— TSIV TOET,
Assignment Flow £ = — (21X, FHEIZEHEENDLT X CTOMRADREEN T T7 4 CEKRENET, 7
TINDOBLIANEIY 7T HE ZDORFEDIRANCETLFEMNT T77 D FORICEREINET,
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ZNHDOR AL, FXT Assignment List B = —ZH FRSINET, ZOHE FRADTXTOY—A
1T FRIFBMRAOBANY AMNZERENE T, VARDIEF AT U ME, RADT7a—%2 7R ET,

Variable Dependencies £ =—(ZI%, FHHA KOOI LI @AW~V D7 TT7NERRSNET, FHHEICH
BT a— L =TV T AR INERS I, T OB B ORI BIRE R 52N TE
F9°, Assignment Flow £ =—Tld, $FEDEEE /I TEAF R OFEMN T F77 O FIicFrESnEd,

B hENTWBEELT Variable Table B = —[ZH RARS AL, il 4 DR ANITEV L THILTWAEEICK
O"C\i}:y)%ﬂ\i—#o

FRENDIEREMMDT A ATV AT 4RI EOF A BR D=8, Calculation Tree [T —HF T AR DZ
DO THASINTWDMDT A AT VL AT 4 RUEE DR T, [Tools] A= —IZE £ TWET, 72720,
Calculation Tree (ZEANTIE BT RIFILDHNT, KEDT 10— LT —X 70— DN 3L EEZ/20
F7, TRV MOBRRIZ LS TUX, ZOMHT CRIEREBIEDNFEAELET, SOIZZOMHT Cldn—7n
VISR BE I DRk N LB T2 BT Caleulation Tree Tl — Az —KRZ-locals 47 =TT
TEOMLENHVET, ZO2—VFHARDITFIAPOREL LA T ar | OHEEZSRBL TIZEN,

File Editor 94K

File Editor I%, Y7 U =7 OZh=RAYe 5t A0 | 3538, e A BT A3 FXF e TRAELL T, BLFED
VA —RERUET,

Tar T A~OEE, O I s TUEESET, IAVNMIBEOT—RZDOLOLTKBIEN
F9, LURT, FOEFRITNV TR AFAL . 2OV — L OMMOFT A AT L AL IEO G Ta—FT 1
VITENTNET,

INANR—=TXAND L7 — A —RFFEPR— S ET, AOW e rAL BT T I
T5&, HLW File Editor TIIZZED YR BERISIVTCNDT 7 ANV KM THE FNA—T U ENET,
ZOFHEIL, 1T Imagix 4D T A AT L ADWT B RIEE T, Graph 4> R Flow Chart,
Metrics LR —hBLE DD LR —RDT 4 L RTINBH TV Iy 7§ 52T, ARSI TNDY —
Aa—RERHZENTEET,

H9 D, Next Reference. Prev Reference D7 A2 T8 AITH HiEbLHVET, 7ML —2hHb
ZNHOREERATHE, OEODL U RLORILL TCOER. B FFOHL., AR, FEXIA
Fr, HONIEH I TN TODG AT 2T X UAFIC A T IENTEET,

File Editor TiZ. Imagix 4D DL R —FDW KON L > TR ESNZY —Aa—R{Ta 777 TRt e
WCEET, 77 AN_N—ADY —AF =y 7| ZHTHEE L, 7o =T Mfr&EET, Ka—H
HARDF —HFF )L | DIEICHIESNTZY —AF = 71Eik e E O a—F 47 o z2FREL
F1, BRENDY —AF = OWEHITHZLTTEEE Ay T Z =T D3 [N T FARD
e~ ARA B E B R T, Shift F—& Ctrl F—Z LR NH~ T ADLERZ L A4 L LT
BAM721) Information 2 — LAV, VY —AF 2o BN T T 7 S THODLDIZ BT AIE RN FRS
nEJ,

FFED Flow Check {285 CTLAR— SN2 BIE DY — A3 —RIZDOWThH, YV —A3—RDLED T LD
AAHHICIN 7T/ 52 LM TEET, FRIT, k4 72 Task Flow Check (28> Tl — RSz Rz
FHRD72IZ File Editor 2 L T/ —Aa—R&ZLEa—F 55, ¥ A7 THEAI TRV B Y
— A —RZREE CEIURIER ([T NLHDZENHHTL LD,

File Editor (32 —R DY 22— I T a—ROEEICHFIH T2 L3 TEET, Imagix 4D 1T H
TR TBLET, 72720, BEE1THE Imagix 4D DT —H_X—ALY —2a—RED R 2394
HZERBHVET, T —H~X—AL, Update Project Data %, <3 Regenerate Project Data D#§fEE >
BIEZEST, HOIEO T/ —ARa— LRSI ELZENTEET,
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Y—RI—REDEE

Imagix 4D |X, T — X X—ADAE & DL RIAZDNT, DV LRIV —AT—R DR TEDII
TWDGANC BT DIERERMLE T, 207X, ZOV RV EREINIE I TODIET
DINA, T7ANV ATEFLEENET,

ZOERIT, T —H AL R— T HEXTY —Aa— R BHIRENE T, 207D, ZiUTY—Aa—

RN IRAT ST L E DL RN DG KL E T, 77 AV DS TATER 5 THRHOTNDHEE,

F72 Imagix 4D =T 4 ZINV IR N AT T —a—T 4 T L TWVRNEEITIE, T F R A HRICT
FANEEIELTZZ 5 RLCWET, T —Z~—A%, Update Project Data $, <3 Regenerate Project
Data DIEEER WA Z EICE > T, HBH7D T/ —Aa—REFRMISELIENTEE T,

BB T S DEH

774 /VRTCIL, Imagix 4D |3/ — A —R DO FK7R(Z File Editor 2 L9, 72721, WAWALIAL
ASTMREEZATIEITIL, File Editor KOO T T 1 #%A IL72<72 02 LbdH D TLL), EDHEIT
I%. Options #1717 (A==—[Tool] > [Options] > [File Editor] > [Alternative Editors]) TT7 (4%
FRETHZENTEET, Unix BRBE FClE, EDITOR OBREEA I T T 4 2 &5 EL TOALE,
Environment Editor D& IR TENARINT L2 EH TEET,

Imagix 4D I Other 74— /LRIZASj& Iz~ R4 L, command filename ZEEBIL £, 72721,
command i Other 7 — /L RIZ A J1&N =<K, filename 137 77 A LIHEL TWDY VRV EE TS
TrANERLUET, TTAXORE 7 0B RT7 71 /1 . [imagix/user/user_ed.tcl TEIEL T, o h/L
DITEFHZOHIENTEET,
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BT D E9E

Graph 71 R iL, dilfEgdE, 7 — 2 ik, 77 AL | V7Y =7 O S EX E ol i 208 A < A
T 57O OWIERIERER 2 COET, T 7 EIERUIZ0ME/INLTZ0 9528 T, B O AFBIMR
RN T a— S VERNEFNEERT DT AN DI TSN TWAETA X kD, 7 — X
JBERIRL, 77 ANDA L 7N —RERE BT 52N ATRETT, Y7 =7 O FEI i %7
FT4TIIVTHER B IO R 5 Imagix 4D OFEREIL, REHER T,

Analyze B§REIZZ O REZ B BIAVICATHOH O T, i L CitbdliZe FEUZ Lo T, x5l D L AR VI B
L CHRAE DR Z B SN DG 7 77 2 AR CE E T,

Analyze # (707 Tk, —BEIZOE 1L DDFFET LRI T A —HALET, ZDT L ARMTDNT,
—HEDOR N 27 YN ARESN TOET, ZNHDZ TV FL VAR LVORIZE A THY, ZL<DFEY
FVBIRIZHEATT, BlzIE, 77 ADI7ZVIIE, D 7T ADREER XD OND T TT7 8N E
FNTNET, Z7RIZ public DAL NBDDHTGE 2D T T 7\ IEE NG EL, BE AN
NI T ADNERD B L > Ty MDDt A RSN G T E R L ET,

TZYDUWNDNE, 8 2 DL RNV EDORRE R ~ET, Hil2 i, BEICkd2720 1 5TiE,
— DT RV — IR U725 2 OB EDIZH D, HOWDHREH L SAZFRFELET,

B LT ANCELNITZT T 71285 T B L O A8 S 2 R HO I LB~ T OGN
RSN DZERHVET, O TRWIEEIZIE, BEIAERSNZ7T7% V7 =7 % KOG 3
Bz DT R ELTHIALE T,
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LIR—RRBU X)X

[Tools] 2 O*[Reports ] A== —7pblid, WIS DOIERT A ATV ATALRINZT 7 EATEET,
Imagix 4D DT —H_X—R|ZIL, VTR = T POIEES N AF 8T — 2R EENTEY, 2607 ¢
ATVATARTNCEY 2=, H =T oA 2% CT —HERHTEET, 2D 2 5Dy hDE
WL [TOOIS] A= 2 —nB T 7B ATELT AAT LAV RN, ZOT — 255 E E R
THLEDIMEHAL, a—ROREDE &R E TEHILETT,

ﬂ ZXFL. [Reports] A==— 5[ i T& 25 Reports 742 R & Metrics V4> R ClE, 7 uy=7h
ERIZONTOEBRPERENETS, ZNODFRITTH— I ASNDTZO DB D TILZRL <D
/EI\ DT A AT VA DBFARIIBEINZ, Imagix 4D 233 TITINEES I IAFI/ 2 T — X OfFHT & L EE
EATHOMERHYET, 26D [Report] A== —IHH O BHIYIL, — A 7ho =7 OFEDOE 2B
FTHHE R OF =y 77328 FrEDORIEIC SN Ty = VRO BLE DO AR+ 222 T
7

Metrics 742 R 71E, SHIZLE 2— DB MR A R DI ENTEXDINTL VRNV EZ DY TR
=T AN 7 A>T/ —hL ., T 7467 LE T, File LAR—R % O Class Summary L AR — k&, 5 —
HR—=AEENBIH LT — 22 RICEED VTR TIZOWN TR WL L OREHEZ TR L £9,
Source Check LN —MIgR & E R a—F o7 ORISR WL E S, 25, Bk, N OF 277
a—F o7 TE, FHTHAABRDI T NAA L TR = TIZDOWT, IERRT — 2 J OVl 7 v —
(B9 B RED M S ET, Include Analysis LR —R Tl 77 A /b E~yZ 77 A )V ORIFERIFRIZ
B3 2 O ARR e AT S RS R RS E T,

ZNBDTAAT AT 4R BARTIEZ—ROREEDE 3 ~D T 4 — A AFATOIET AN, Imagix
AD DIEYEF B/ —T al D3R — Féhfk@ Tool T4 AT L AT 4RI T BLDOHATEIAZSSIZ
FARDZ LM TEE T, Import Report FEREIZLD . 2T B —2ab B LLRNCRIEL 2L AR — IR L
T HIENTEET,

Metrics 4K

Metrics 71 R71% Imagix 4D 23V 7 N7 = TN TATOE EHIHIE OFE R AT T 51727 1 AT
VAT R TY, Z2ICERENDT AL IR, 77V, Laize, 77 A, Bk, ZHL -~ LD AR
VI RZDOWTNE, Az — G PO T —2ET )V |OIEICHRABHVET,

Metrlcs TAVRDTIE, BFEDTRID R RNV E  fETLTZWE o TNAY 7T =T AN v 7V AD S
IZEHoTUARR, V—h, Wil o 7N 3228083 TEET, A==—TAH Format OER L CTIE, 1789

ELTCWBIRNTIZE L 7= R R A IR T 22 L3 TE 9, Graph 2R L 7= EICEREINH AT

ENEND AN 7205 EAL K OV IAL O BEIZ L CE DI H L0 % R TOET,

ZNHDORIENL Metrics 7> R T (LOCAL A==—[Display] > [Threshold]) . A1>® Graph 7«
>R @ Options #4712 (A==—[Tools]> [Options] > [Metrics] > [Threshold]) CHE%ETHIEMN
TEET, ZZTRELZBMEIL. Graph 71 R &45% | Imagix 4D Db 5 AR w7 ZAFKR I
SNET, BROREEICEDOE TINOORMEZREL THEI N TLLEY,

VIR =T ANy 7 ATETE LIZ, I—ROVF AR FxFH ETAEHEE AR, A b SRBRAEEL<
LTCWDLZARE | a—ROEAERI R BEREBERFE 4 DO IR D28 TaEd, BAFEMIRH .
IRE I 223 CTAN) 7 2258 TR, BAFE DER EEA 1300 | ITERYZR B O [ Z N3
AU, ENEIOVRGIBEIETHIENTEET, VTN =T AN I AL, Y —AF =y 7 LG T
THIHTHZ8ICED, VY7 Ny =27 KO m e 2D RRE O FIZESLHET,
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File Summary BT Class Summary

File Summary |7 0= 7 MZEENLT 7 ANV O EZ TR £, T K OFT AL ZRIC > THERL
o7 =25 RIZELD  A—NTEKL A ANED 2 Srb7 7 ANVO YT ARIZE T HIEHRERRLET,

Class Summary | £ 7 0 = 7 M & M50 T ADHEE AR L £9-, B OF AL 7RIS E > THERHL
1T —2ERIZELD | A O HDI T AT A HRERRLET,

Source Checks (Y—ARFxv%)

Source Checks Cid, K —HARDIF —XET NV | DIV —AF =7 | OIATHALIZ, 77 A1
—ADY—AF I DE I B IZHIGT AL R — @R THIENTEET, ZNHDY—AF = 7%
et EA O a—T 07 EOBISNERR WHLET, HLAR—NE, 7Rz DR T 7 AVIZETZD -
T BEDY—AF =7 O E AR ET,

ZASEITRNC, File Editor A=a— KON 7 AL ETOST ADAG I IRy T T T A= 2 —THIH
AREZRY — AT = 7L, FEEED T 7AMIDONT, TRTDY —AF =7 DI &Y AR ET, File
Editor V4> R TH V) —AF = 7 OFINMNIT o X —FA L T CRRESNET, V—AT = 7T,
VINT 2T AN 7 AL AE O TR 5281250, Y7y =7 R O v AD 2RI 5L E D 1)
i RVASE S I

Variable Flow Checks (Z#27A—Fxv%)

¥ T7a—F o713, VTN = TINZBIT DO BT A ERN /2 M EFFE T 5, LAR—RD
Ty NCT, BN (m—v T — 27 a—fET) OB O L (Fa— L7 — 2 7 a—fEiT) 12

BT s 7 LG 70— SHICEBOMRA KR NESNL ST A—=ZPBIFS I, T oy 7S

¥osEsler —27a—NHENET,

Unused Variables (F&FZ#)

FAE A ZEHL RN —ME 3 DDLR—MELDIZbD T, REEED, BtHAEIL TR, £2T5E
B ASNTORNWERZL B a—F 2 EIa@ R TEEd, b 3 SOBRRIZIY, 2—F
WO SRR DO EAEN R A R ETEET, 7oL T IRDISRY — A3 —FhboHELET,

int globalA, globalB;
int func2 (int paramX, int paramY) {

paramY = globalB;
globalA = paramY¥;
return globalB;

}

int funcl (void) {
int localW = 1;
int localX, localY, localZ;

return func2 (localX, localY);

}

LIR—RT A R DA=2—/3—D “Displays %, 22401221 T never used, never read, never set
ENUTRELTNIZE ST ARSI DL AR — MO IR ES RV ET, never used CRAE ) (23R E
T oL, V= AT—R Tt AA AL BEALLIN TN E M ESNE T, LAR—MNJT, B35S
WGP T 215 HE A DT HELEBDVANSNE T, ZROITICEOES THLHEEbHVET
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D 2a—5{THET, Fov I LY 7 NI = T TOLBIDO R —Ee 8 BRI EEN IR RSN D85
NHVET,

Variables Which Are Never Used

Settings:
Usage Type: never Used
Global Variables: displayed
Static Variables: displayed
Local Variables: displayed
Summary
Variables Total Set Only Read Only Unused
Global 2 1 1 0
Static 0 0 0 0
Local 6 2 2 1
Variable File (Line)
localz unused vars.c (13)

IROBIRETTHL B OHDOERIL, BT —F3MEASINTORUVIREEZ/RL TOABE 0 HY
F1, ZOHE . BEOFHMIC L TIANEEDNTHILENTEE T, 22 TIE VAT O %
F 7T HEEDINT, LR —MNrb7 a— S VB RERAASIVET,

Variables Which Are Set Only

Settings:
Usage Type: set only
Global Variables: omitted
Static Variables: displayed
Local Variables: displayed
Summary
Variables Total Set Only Read Only Unused
Static 0 0 0 0
Local 6 2 2 1
Variable File (Line)
localW unused vars.c (12)
paramX unused vars.c (4)

LR —MIFRAIAEINL TODEN Y MEN TR WEBNR TR R INDINIRETHIET, i AAAEN
T-EXTTFHILARWEE BN RAELYD, MIHHEES N CORWERTA Y ORIEA R BT A2 N TEET,

Variables Which Are Read Only

Settings:
Usage Type: read only
Global Variables: displayed
Static Variables: displayed

Local Variables: displayed
Summary
Variables Total Set Only Read Only  Unused
Global 2 1 1 0
Static 0 0 0 0

Local 6 2 2 1
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Variable File (Line)

globalA unused vars.c (2)
local W unused vars.c (12)
paramX unused vars.c (4)

Uninitialized Variables Read (F#JAFIE A4 Y Z#)

Uninitialized Variables Read L /R — R, 70— V8% A B IO\ — VB 0> E, W1
LET B FENDENTH A IS N CODEEEZ R LE T, ZOXI7RIRAEITHICE RO H LIk
IZEBHDTHD0, a7 D RGBTy I DR R E R TR REENHD £9°, IRD X572 5%
ZTHFELLED:

int globalA, globalB, globalC;

int func2 (int paramW, int paramX) {
int localA;
localA = globalA;
localA = globalB;
localA = globalC;
return localA;

}

int funcl (void) {
int localw = 1;
int localX, localyY, localZ;
int decision = 1;
globalA = localW;
if (decision) {
globalB = localW;
globalC = localW;
} else {
globalC = localW;
}
localY = func?2(localW, localX);
return localZ;

}

localX LN localZ IZHIHU L ENRWEE funcl DR TSI TWOAET-D  fESER AL R—]
WZUARSIVTUWVET, [AIBRICZE %X globalB &, = DAL if S KA T T Db s SvET 23,
globalC 1% if &KAEICA BT 20 Eomicnmb oL T ks n £9,

Uninitialized Variables Read

Settings:
Global Variables: displayed
Static Variables: displayed
Struct Container Summary: omitted
Union/Bitfield Members: separate

Task Definitions

Name Members Root

autotask 0 - funcl 2 funcl

Variable File (Line)
Function File (Line)

Assignment
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globalB
func?2
6 localA = globalB;

localX
funcl

22 localY = func2(localw,

localz
funcl
23 return local?Z;

uninit vars read.c (1)
uninit vars read.c (3)

uninit vars read.c (12)
uninit vars read.c (10)
localX);

uninit vars read.c (12)
uninit vars read.c (10)

AT EFRINZOLR—NIEENTNDIEITEREL TLEEN, LR —NIT =47 — 0O 3 8 & Tk
ETDHERNH A EFR/HEBIZANET, 72771, ZOL AR —F Task Flow Check L AR —MMZ @1 5%
DTN\, FEICH AV EERT HMENIHY FHA (L —FH AR D Task Flow Check &7 =

B,

Useless Assignments (ZEHDfEA)

Useless Assignments LN —MZid, 72— 30§, B—2 L DB ZEEHA~DRADRINET, i
DDA, ZBEDHEAAAENDRNCFHE By hSIohy ETRER ICEBDHAAEIN T

Nl SN EY A, BHOMA AL, 4

DEF, ROIOBIEEZTHELL,
int globalA, globalB;

int func2 (int paramX, int paramY)

paramY = globalB;
globalA = paramY;
return paramX;

int funcl (void) {

int localX, localyY, localZ;

localX = 1;
localY = 1;
localZz = 1;
globalB = 2;

STETIRELn Dy I3 0T LR G Ea M0

{

localZz = func?2(localX, localY);

return localZ;

}

T 7 VR TIL, LR —MIIEFE A FNDRNCES B RN HE R ESND)> (localZ) | el En5b
ZEN2u N (globalA) | BEEDZEFDOMA DWRENE T, ZNSIXEHEANCER R A THHE RS

nEJ,

Useless Assignments

Settings:
Global Variables:
Static Variables:
Local Variables:
Transitively useless:

Union/Bitfield Members:

displayed
displayed
displayed

not displayed
separate
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Variable
Function
Assignment

globalA
func?2
8 globalA

localz
funcl
17 localZ

paramY;

1;

File
File

useless asgn.c
useless asgn.c

useless asgn.c
useless asgn.c

F7arb LT, MR RANT =y 7 SNDINL R — MR ETEET, ZOHE,
paramY } X globalB DAL R —MIEENET, func2 (23175 global A DA AIZIE, EHEAYIC
7, paramY ORI global A DIEH DRAIZO AE SN DT80 EIIZHITHZORANIL
MRS RrsiEd, ST 1B LTIk, paramY OED ETO globalB O fif % [FI4

2720 E,

Useless Assignments

Settings:

Global Variables:
Static Variables:
Local Variables:

Transitively useless:
Union/Bitfield Members:

Variable
Function
Assignment

globalA
func?2
8 globalA

globalB
funcl
18 globalB

localz
funcl
17 localZz

paramY
func?2
7 paramY

Function Flow Checks (BA#za0—Fxv%)

paramY;

globalB;

displayed
displayed
displayed
displayed
separate

File
File

useless asgn.c
useless _asgn.c

useless_asgn.c
useless _asgn.c

useless_asgn.c
useless_asgn.c

useless_asgn.c
useless_asgn.c

BT a—F oo 2|Zid, 2—FNO BN U ZENT 75, 2 DOLR—MEENET, Zh
HDF o7 Lo TUR—FENERIT, LT 1LY 7 =7 OfEEZ R THOTIIHVFE A, X
DI, Y7 =T OFIE 7 v —IZ 8B DI TER B DI MR ES AL, £ DR DL E 2 —t Gk

TENWRNLHET,
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Recursive Functions (BEA5#)

PR B R — T, ERE LT OO BEFFOH L 2@ U TGRS LD, 73T
RS ESNE S, BHRBIEE M T 528 TERIEP IRV ET 0 ERL— T RFRAELR2NE
INTHEEL., IR T R EY) ThHZ L2l T DM ENHVE T, MIMAZY T T =T IZDNT
V& ALY I DF—"=F L DIz LT | IR BEEITFHEEL THEM 22N EE T,
UAR—MEREZLE 2—F 2528 T, BIROR KRBT M BT ARSI, +070 AZ 0 7 AR — 705
RSNDINTTDIENTEET, RDIHRPIABEZ THELLD,

void funcD() {

return;

}

void funcC () {
funcA () ;
funcD () ;

}

void funcB(int paramX) {

while (paramX < 10) paramX = funcB (paramX) ;
funcC () ;
}
void funcA() {
funcB (1) ;
funcC () ;

}

ZDY—Aa—ROFIFEF T DA FBmEEL A —NIT, EEEIRRENICHIRT 59T
DAL FIRDIEAET D/ APV ANSINE T, ZOVANIIIRIEADMEHSET, ZNENDOF
R/ SADYANTIE, FIRICBFR T 2572 R FoRESnEd, TNENOFIREEICOWT, B
IR SARHDGAENHVET,

Recursive Functions

Function File (Line)
Recursive Path

funcA recursive funcs.c (16)
0 . funcA
1 . funcB
2 . funcB see (1)
3 . funccC
4 . funcA recursion
5 . funcC see (3)
funcB recursive funcs.c (11)
0 . funcB
1 . funcB recursion
2 . funccC
3 . funcA
4 . funcB recursion
5 . funcC see (2)
funcC recursive funcs.c (6)
0 . funccC
1 . funcA
2 . funccC recursion
3 . funcB
4 . funcC recursion
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5 . . . . funcB see (3)

Shared Functions (#/85#)

Shared Functions L' 78—k Tl /AT A ST HEL D BIS B HE E 7L RIBA IO ST
T RTCOBEENPL R =PI FET, ZIUTED, A TA RSN DR IF R A R TN TEE
T, 2L, SESFRZ AT DON—REEED S T GRIRU - B DT 3BT 2 s 2 &, ¥
2770 —F =7 DAL AR —NMIEEIL CWET, ZOLR— M T 51203, Ry 577
4RO DON—EEE NATANTDLERHOET,

Unused Code(X&HFDI—F)

Unused Code L' AR —h Tk, 7By = Z7hO/L— DT X TYARSNE T, Zhbid, 2—RADD
EDREEOLIFFOHENRWV B THY , 22—V NERLIZE DX AT DTN BHTHIRNZEND,
Ty RI—RFEIHRA~D AV O LR DA REMERHD ET, ZHHD B DN O T, ZDFETEY 2— /b
BIE~DADATHLINGLIVEE e HDUVNE, BHYTIRE TERWVEBARA L 2 2@ L T S
WTWBRTREMER D ET (R — AR O MHFEHT EOEE S OHESR), 20D FE#lickol v
— LTI N, LAR—MIUIT v Ra—R~D A O L7205 5T _RCTOEFTBAY AN NET,

Fo, LIR—MIE, B NEENSREEL- R O —ROFhFE S RSET, Total
Functions & Total Lines DfEIZIE, /L—REEE B R L Z 3 ME—REONH B O 5 3 & FEE T,
BT, =D 1 OO N—FEENLDOF O LICE > TORRIET D, SHIMOEETT, Z0F
hEPHIL, LR —FNDY 7B L T T 74T FRSnET,

Task Flow Checks (#RX270—Fxv%)

B2 X IR TR DI T VA AL TR 2T 2 AT LOFEET, BERKEZ RI-LEd, ¥ A7 T70—
LIR—NE, Y7 T =T DFAT DFEIELF B BRIZOWTTF =07 T5, —HDOLR—RTT, FATD
HENIEME T, MEOIRRIZR G ERHVET, ZNHDOF = 7o TUR — ISR, &
FLLY 7 =T DKMz Rk THDOTIEHIEE A, ROV, Z AT RIOTER T JE N ESHL, %
D% DUVE 2—RGOREIENHET,

H AT CIC++7" 07 T A CHRIICIR ESNDH DO TR ZHDL AR—R Tl Task
Definitions Z A 7R INLH AT HEFRTEET, KX AZIZOWTOV—MEEE IR ET DL, T
DEATIN—EEE O D/ — NGB E 7 LM O S 723X CO B3 T
REbHE BasnEd, Task Definitions # A 70/ CH AT EEFRLILWEES, 70 = 7N OL—h
BT LicZ AT PN H BN ERSIVET,

ZOLR—=NCIL, BIVABREE L F13E~ T+ 10 &> TRESILTND, AT — A ND T IT A V7R
FEIRCHIPHL RSN E T, ZRBIZOW T, Y —Aa—R TR ES T ER A, Critical

Region Definitions 2 A7 02 "C, 77 4 NIRFEABIZ AL FIIABIEE L1~ T ) ( FI21Z2VT 17

IVIRiEIE 1A (BIVIARFF A2~ 7 4) T2 I S VA B % A FR & C& £97, Mismatched Critical

Regions LN —NCIL, ZUT 4 VIR FEIICAD /AT OB EFR T HMENRHVES, ZOM
DUR—RNTIX, ZVT 4 VIR AD /M BT-0 OO ERIFMEE T,

< IVF BRI AT WNIBITD, BT DARAOFE L, 2 SOREDH AT Tr—F = IR
—I. Event Calls in Tasks F3J 0" Event Transition Between Tasks TIEMTSNE T, ZAT7UT (H1)L
TRREIRE RARIZ AU PA =X LY, CIC++7 07T AT RIIORESN TR0, ZRHD LR
— e FATTHRNFFEL TR ENRHVET, Z 1T, Event Definitions ¥ A7 07 bR ITLET,
ZDHEATaT T A X —T T VAT AOARU AR ELET, XAZPOOMNHLIZEY,
ZNHD AR L T (pend)., i (post), LIV T OT 7T 48T 4 BLERSNET, F2ZD
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HATaT TIHEARUIE, AXUMNIBE CHEHINA SR —T 4 TV AT DIFV Y — 2395
V= A =RV OiR T (v 7m, FIEE) T IV BROEBRER)EHEELE T,

Task Flow Check L AR —h4&324TL7-1% 1. Imagix 4D OEREREAZFIHL T, Y7y =T ZAEL, LR
—RCT7Z7 SN TCWLREZ R T HZENTEET, KRR EICLD, F A7 Tl I TR WES
BaRrET 528128 o T, ZOREBEIE Graph 7 1> R 35 LU File Editor O] 7 CHIHCTE &9,

Variables Set in Multiple Tasks L#A"—F

Variables Set in Multiple Tasks L A8 —h Tl #E DX AL D7 00— )V 25 e ORI B o il
FEPRESIET, 2IUT—HOL AR - L TEXLHIELTEET, By T 7 EADHELE 2
— 350, B BIORAROOT /A% L Ea—T 505 RIRTEET,

LAR—hDOEEZRHH BT, By DT 7B AD A FIRDHZETT, ZDOLIRLEEA~DRAIZEY,
ENODEEHAE T DX AT INIVT 4 IV CIRES I TR WA, THILZROEMENF
T DZERHY, ZIVINREA LD REMERNHVET,

int globalA, globalB, globalC;

int subX(int paramX) {
globalB = paramX;
/* some calculations */
paramX = globalB;
return paramX;

}

void taskX() {
int localX = 1;
globalA = localX;
/* some calculations */
localX = globalA;
DisableInt () ;
localX = subX (localX);
EnableInt () ;
globalC = localX;

}

void taskY () {
int localYy = 1;
globalA = localy;
DisableInt () ;
globalB = localy;
EnableInt () ;
localY = globalC;

}

<7+, £721% Disablelnt X°> Enablelnt 72 & OEIA A HIFH B A AL T, 2V 7 1 1V 7R S8 AR
T DT, S IVEBEEE R LMD Z AT LD T U T bIR#ES N E T, 72
EZ IR, subX THiAIA FE5 globalB DOEIL, subX 73 taskX ¢ DisableInt THRESILHT= . subX T
JE1T globalB IZARASIVAELFICITARD E T, EOFER, taskY (2L DHEIIAIZITL ST, subX D
globalB DFER IE &t A-IA B DI CH AT HFH R HIZ globalB WA INHZLITHVER A,

ZAUTKLC, taskX (235172 global A DR E & FE A A IIRFESIVE T A, HEIAILFHEIAIATDIH]
T taskY IZEDENA B FEA LI 5A 1T, global A DIEIMETESH, taskX O T ES BRI T ¥
L/i‘g—o

Variables Set in Multiple Tasks L' 7R —h Tl ZBEORABTVT 4 A1V G8IR CHRAE T DMEIDDFE
BrafThoiu, ZDERNBT A ATV ARRINET RSN TODERDE-HE 7 ANV 2 ThRA



102 Imagix 4D 22— T4

HZELTEET, ZOHATE, RESILTWAEEDOE S LRHESI T RWEROE S O T HE
IRSNVET, FRESNI-HETOT 78 2RRPUL, UFRESIL TR0 E21T PERESILTOD)IZE
STRSIWET, RESNTZT 7 BRIZOWTL, ZVT A VRO A IR RSNET, 22T L

SOIVT 4 JVIRFEEAY Critical Region Definitions &4 707 CEFS L, int LV ETINTHT B
TVET,

Variables Set in Multiple Tasks

Settings:
Critical Region: int ( DisableInt / EnablelInt )
Usage Type: set only
Protected Variables: displayed
Unprotected Variables: displayed
Global Variables: displayed
Static Variables: displayed
Struct Container Summary: displayed
Union/Bitfield Members: separate
Variable File
Task
Line Number of Usage
Critical Region
User of Variable
globalA multi set vars.c
Task X
13 U taskX
Task Y
24 U taskY
globalB multi set vars.c
Task X
5P (int) subX
Task Y
26 P (int) taskyY

LAR—bDH9 1 2O HRIE, BEDOX AT BT EEEA~D B MBI OGO T 72 A% N4
HIETT, ZORETOMATRERIL, M T UOHBTERZeREZ R SR RO EH AN, XAV T
BHENDLERD FELEEDIRREIZ DWW T, A CRAMZ RikE 1 LET,

Variables Used in Multiple Tasks

Settings:
Critical Region: int ( DisableInt / EnablelInt )
Usage Type: set or read
Protected Variables: displayed
Unprotected Variables: displayed
Global Variables: displayed
Static Variables: displayed
Struct Container Summary: displayed
Union/Bitfield Members: separate
Variable File
Task
Usage Type

Line Number of Usage
Critical Region
User of Variable
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globalA multi set vars.c
Task X
S 13 U taskX
R 15 U taskX
Task Y
S 24 U taskY
globalB multi set vars.c
Task X o
S 5P (int) subX
R 7 P (int) subX
Task Y
S 26 P (int) tasky
globalC multi set vars.c
Task X
S 19U taskX
Task Y
R 28 U taskyY

Yy R T A DM T MENT SN DE . T 7B ADREZA T I HE WAL AR —MIBIESnET,
T IRADEAT 1L S(y M) £ REEAB)IC L > TRENET, globalC 728 F DD ZERIL. H5
H AT TDIEESI DX AT THRAOHIDHE ATV AMI T RSINET,

CIC++ OREIEREILHAR, BELO C++ DI FATHERIN TWDEREEFHLET, ZOLR—F LKW
PLUF OV DDLU AR—MIE, EiH SN EEOL R — N FiEEGIET 54 7 ar BRHoET, A=

=—/3—0® Display—Include Struct Container Summary |25 = 7% {+F5E, ZIHDEFFOWT I
AT F OB THE S IET, 7‘_&1 X, BEIERO AL N3 1 DOZATIZEN Y THi, Bl
DA SINPIDZ A EN Y THNT 6, & AL 73X Variables Set in Multiple Tasks L7 —RMZZR
SHVER AN, RS IRZEE izﬁréﬂiff

THUTHLUTREINE, A2 Ty 7 AN ER SN D LD, BT E ORSIEFR ) S THH TV
DPETHITERNZD | OOV AR — IR R Z — DB L TRARLET,

7R AT I o CRIREZRHIPH T, Imagix 12E DA 7P =V MNRA L ZIZBIREN TO D) EBIRL
F, RALZEINIB R T A—2(T | BRSO/ RTA— B E B BRI E B AR ELE T,
BLANZEE ESIVCESN DA > T 7 AfE S IVARA 2L | BlFINZEBESLET, Imagix TIER
A BT ~V&:M%Hﬁ“é:&75§ﬁ‘ﬁ;eéhﬂ ET, COLGERALZIREE DI ESN, £
DOEF FT2CHEREL | BEEE 9D AV REIICED Y THILCQODE &« OEEIZRIR T 72 AT 5
ZEIEHVERA,

Reentrant Functions Lfi—fF

BELDZ AT IHIEFRHENAB50E. Reentrant Functions L AR —RIVANSNE T, Za— L EHY.
FIRIRST 4 a— D7 ED | ATV _EICERIIZED Y TONDEE A EE AT F T 5 A TR
e TGN R I—JLF%@%Z%”?U\&?‘%OD{mO)&X?&@:'PﬂﬁLﬁb BB AT HIENHVET,

int globalZl, globalZz2;
void funcC() {}

void funcB() {
int localB;
globalz2 = 2;
/* some calculations */
localB = globalZz2;
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}
void funcA2 () {}

void funcAl () {
int localAl;
globalzl = 1;
/* some calculations */
localAl = globalZzl;
}

void funcA() {
funcAl();
funcA2 () ;
}

void taskX () {
funcA () ;
DisableInt () ;
funcB () ;
EnablelInt () ;
funcC () ;

}

void taskY () {
funcA () ;
DisableInt () ;
funcB () ;
EnablelInt () ;
funcC () ;

}

Reentrant Functions L'AN—RCld, A7 3BEL, 5 AR, FEONH L AEBRE SV ) HEEDME S AVE T,
ANV, ZATN— RS B OOV — NP BEEEEIIFERICE RS NS T X TO RS S
H A FAERR T B #HOBE T, AR (B OX A THAIND A B 1, FFABEE
IEREOH LB DO W T I S IVE T, ABEEIE, 1 SERIXERO A SN AN
U Lo TREONHE A A RIS T, OO0 R, /L —MEFAREE RS s B 8bH0E
9, FEOH UAE B 1, oo L BIERIC K> TR SN A I BT |, E D7 3 I % D
FEONH LB IC o R ARSI ER A,

LAR—RTCit, EFARBEEOVANT, ZNENOFABEE MO T ZA7720T Tl FO BN
VT 4 VIR RN SIRE RSN TN ED B R UET, O T, XAV OB 7d B oL
E o —MRA[FETT,

Reentrant Functions

Settings:
Critical Region: DisableInt / EnablelInt
Protected Functions: displayed
Unprotected Functions: displayed
Functions not Using Globals: displayed
Library Functions: displayed

Task Definitions

Name Root Members Reentr Callees
Task X taskX 8 3 2
Task Y tasky 8 3 2

Reentrant Function File (Line)
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Callees
Task
Line Number of Usage
Protected / Unprotected Usage
User of Reentrant Function
funcA reentr funcs.c (22)
funcAl reentr funcs.c (15)
funcA?2 reentr funcs.c (13)
Task X B
28 U taskX reentr funcs.c (27)
Task Y N
36 U taskyY reentr funcs.c (35)
funcB reentr funcs.c (6)
Task X N
30 P taskX reentr funcs.c (27)
Task Y N
38 P taskY reentr funcs.c (35)
funcC reentr funcs.c (4)
Task X -
32 U taskX reentr funcs.c (27)
Task Y N
40 U taskY reentr funcs.c (35)

ZITHE VAR —MERICT & TTCL BB AT A RSSO E A 7 — AT 52
EMTEET, I a— SV EHREDOAEY FIZERICEN Y CTONAEEEF LA funcC 72X D
BT ETHY, T 7 HNN TV R —ME R DA S E T,

7a—,VEEME RS ND ATREMENL, 2V T A VIt A A L TR SR E T, e,
funcB ~DOFERNH LIZxH - 2E0 AR FEIL, globalZ2 235k EN Bl £ CORNC R/ X A7 125>
TEBEISNFIAITF AN LRWINITREL T, —MRINTIE, RESIVTNDIIT 1 VIR EIN
THABREEE AT 213903, tRESIL TRV EIL TR 50 L2 THY | [FERIZ7 152 TR
TEET, I 2 0O T7 VARSI, [FCLAR—ROFIZRLET,

Reentrant Functions

Settings:

Critical Region: DisableInt / EnablelInt

Protected Functions: omitted

Unprotected Functions: displayed

Functions not Using Globals: omitted

Library Functions: displayed
Task Definitions
Name Root Members Reentr Callees
Task X taskX 8 1 2
Task Y taskyY 8 1 2
Reentrant Function File (Line)

Callees
Task
Line Number of Usage

Protected / Unprotected Usage
User of Reentrant Function

funcA
funcAl

(22)
(15)

reentr funcs.c
reentr funcs.c
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Task X
28 U

Task Y
36 U

Functions Not Used in Tasks L—F~

void funcA() {return;
void funcB() {return;
void funcC() {return;
void funcD() {return;
void funcE() {return;

void Taskl () {
funcA () ;
funcB () ;

}

void Task2 () {
funcB () ;
funcC () ;

}

void Task3() {
funcC () ;
funcD () ;

}

Task Definitions

Name Members
Task 1 3
Task 2 3

Function
funcD

funcE
Task3

Mismatched Critical Regions LA—Ff

taskX

taskY

—— e e e e

Root
Taskl
Task2

File

test.
test.
test.

reentr funcs.c (27)

reentr funcs.c (35)

Functions Not Used in Tasks 7N —RZid, BIEE RS TODX AT THERHSL TR, 7aye
IhT —HR—=ZANO RN ARS I E T,

ZDOLR—NE, ¥ A7 )3 [Task Definitions]Z 4 70/ CH/RIICERSIN TNDLIEAMELLET, E
TINTNRNE TRTON—REEEIE B BRI H DX AT D)V — ¥ E 72D EOBIHb R FEHT
HDHE RSN ET, ZOMHTTIEL, XAZIELREED Taskl BE O Task2 (25 L TOREZHSIL
TWET, Lo T, B%L Task3 B O AMEONHSNZBIEIL T X TREHA CThHLE ResivET,

Functions Not Used in Tasks

FERED Functions Not Used in Tasks L' AR —MIMNA CZOMEHTr OFE RS 47 a @& EIZLD, Graph
74> R L O File Editor (2 DRE5 A 5 E T A7 DICRIHTEE T, FATENTOX G5 CTh 7=

BARSTA CEHZEIE, ZNHDT A R EEHL T/ 7 =7 23R A L | #f % 72 Task Flow Check

VIN—NIT7 77 ST R Z R fiE 959 2 THRILOTLLED,

HZAIWNTO, FIALMEONH L E72l LB~ 7+ OFF AR IR BRI DI ERI 722 R, Mismatched
Critical Regions L' AR —MMZJ> TS VE S, AT Tl 27V 7 1007 (RES V) SO B AR L #4&
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TOR—EPERMINET, FLIOLR—ITIX, 2—FNOFFEDITHI VT 4 JVIRFEIBIZ S D>
EOMP AR E R ESINVE T, ZOIORMEIZES T, R#ESNTORWEIVIAZIZRIL T/
TR 2TV AT BRNERGEIC/20 . FlenYy 2T 5 OMOREN A THHEENHET, 7V
TATVILFEI B EFONH L OB & TR ETHZETERLET, 7 uy =/ MOZNE
OBRBEFEFORNHEUIZDOWT, LR—MIT 0 I LERIIF AT DS FETT N TOEIT/ R TF =
I LT, T THK TREBMEOHLARBELET, KELTWELONRHLGE X, LA —MNIIXE
EREONH L OGS & T IEOH LS RE LT B bt O NADSUREIVE T, IRIZ, LA —ME #& TR
FEONHH LS T RN TODFEIT/RAZHITU TR, 707 FAEIH AT DNTEICRDE T, v~ T 75
BRAGBAEIFONMH L AR L E 77, Ao WEGE1E, LAR— NI T BEEIFO L O5GaTE | BilAh
FEONHH LA RE LT I b TV VSRR /R ET,

LRHAT DAL ST = Aa—NNOITOREIRIEN S22 D56 . AAMRE TV ECE S, LR
—h T, ZOfro—HEL T L EIIRF O L el 20T R TORAENTF = 7SI ET,

int globalX;

void funcC () {
int localC = 1;

if (localC) {
globalX = 1;
EnablelInt () ;
} else {

globalX = 2;
}
}

void funcB() {
int localB = 1;
if (localB) {

DisableInt () ;
globalX = 1;
} else {

globalX = 2;
}
}

void funcA() {
funcB () ;
funcC () ;

}

EFRROHITIE, ZVT AT NZRFRAD A TIIHRFE DR SALDRFES L TR, W
BRI HVET, K5 ROLAR— ML ST ORENF RS, BAAE T THAREL TODIHIT
WSAPRFESNET, Zhaikil, A =DV E 2—& a5 LN TEET,

Mismatched Critical Regions
Settings:

Critical Region Critical Region: CR ( DisableInt /
EnableInt )

Regions Missing Starts: displayed

Regions Missing Ends: displayed

Ambiguous Functions: displayed

Ambiguous Regions: displayed
Start of Critical Region Missing End of Critical Region
Function Line File Function Line File

funcB 17 mm cr.c funcB 22 mm cr.c
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Missing Start of Critical Region
Line File
7 mm cr.c

Function
funcC

Ambiguous Functions

Function
funcC

Ambiguous Regions

File
mismatched cr.c

Lines
(all)

Variable Flow Between Tasks Lifi—f

Variable Flow Between Tasks L 7R —~Cld, # A7 MO SN DY 10— VAR L S50
LR =&, BEA IR E TR A T2l BERICEED LM I iE SN £,
SELLWMER LD 1212, 74—R I V—TBH0ET, 74—\ 70— X, HHX AT DK
DEAINZE S THFIAENDT O— SNV EREFRTET D ZATETa— SOVER O AEEHA T, =
D 2% HDOZATPRIZBND (FTIXFIC) BEAEFREL . TAVNIRD I AL S THEAAENET,
ZIUE, AIDOX AT B EBUR T HE THRITSNE T,

o7 —F = Z IR —RERIFRIZ, 2O I L > T T LE FEDM R RINA LT RY AN, #
AT DB DLE 2— B WRRERPESNET, ROIH7pa—RFREZLNET,

int globalA, globalB, globalC, globalD;

int globalkE,

void taskX() {

}

int localXl, localX2
globalA = localXl;
globalB = localXl;
globalC = localXl;
localX2 = globalG;
globalE = localX2;
void taskY () {
int localYl, localyY2
globalA = localYl;
localYl = globalB;
globalC = localYl;
localY2 = globalk;
globalF = local¥Y2;

}

Line File
4 mismatched cr.c

Function
funcC

56 7 10 11 21 25 26

globalF, globalG;

1;

End of Critical Region

Line File
8 mm cr.c

ZOBITIFEHN A AT THEASIINTOETN, LR —NIERENDHINT, EERIZT7 —R v 7)1
— 7 EHVFEE A,

Variable Flow Between Tasks

Key:

R or RR:

S or SS:

R,S or RR,SS:

variable is read once

(RR) in task
variable is set once
(SS) in task

(R) or multiple times

(S) or multiple times

variable is always read before being set
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in task

variable is read first in at least one path;

it is set and read in various orders

variable is set first in all paths where it
is read;

it is set and read in various

orders thereafter

Fn or Fn..:

variable and task involved in feedback loop

labeled n (and others if ..)

Settings:
Critical Region:

Single Set / Single Read:

No or Single Set / Multi Read:
Multi Set / No or Single Read:
Multi Set / Multi Read:

Global Variables:

Static Variables:

Struct Container Summary:
Union/Bitfield Members:
Feedback Loops:

Variable Taskl
Task X
globalA ...t e S
globalB ...ttt e S
globalC ...ttt S
globalE ...ttt S

int globalA, globalB, globalC, globalD;
int globalE, globalF, globalG;

void taskV() {
int localvl = 1;
globalD =
localVvl =

localVl;
globalD;
}

void taskW() {
int localWl = 1;
globalD =
localWl =

localWl;
globalD;
}

void taskX () {

int localXl, localX2 = 1;

globalA = localXl;
globalB = localXl;
globalC = localXl;
localX2 = globalG;
globalE = localX2;

no critical regions defined

displayed
displayed
displayed
displayed

displayed
displayed
omitted
separate
displayed

Task2 Task3

Task Y

o ™ n

WITRTA—=RTE, JIOELDIRI B TEROLLEBPIASNTEY, 74—y 7)L—T Dl ke
PERHVET,
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}

void taskY () {
int localYl, local¥Y2 = 1;

globalA = localYl;
localYl = globalB;
globalC = localYl;
localY2 = globalE;
globalF = local¥2;

}

void taskz () {
int localz2;

localZz2
globalG

globalF;
localz2;

}

I—RIZEIERR 7 A — R0 I =T RS 58E 15, LIR—NMIFEIREN., EOZ AR 71k
MEDT 4—R R 7 =T\ THRNET D08, F(X) CRSIET,

Variable Flow Between Tasks

Variable Taskl Task2 Task3 ...
Task V
Task W
Task X
Task Y
Task Z

globalA ........... . . S S
globalB ........... . . S F2 R F2
globalC ........... . . S S
globalD ........... S,R F1 S,R F1 . .
globalE ........... . . S F2 R F2
globalF ........... . . . S F2 R F2
globalG ........... . . R F2 . S F2

Out of Step (2) ¥

B AR TIIEEI T EZIAA TOHDEEARIARE T, Out of Step Z240(Z ) 1. 5t AIAAL TOBRR
ETHEDFEITNEFIT > TND T B — SV EBE I E SRR E L E T, FATR—ADY T ) =
T, FHECHEHSNAE B BB LTS ERHVET,

WDIHea—RRnEZLNET, 24 globalA B3 HIHU LS, taskA DIEHNTIEFOHE 728/ Th,
global A I[ZfE2 G-z HIE T, 72721 taskA 12k~ T, 58 THIIZ globalA DN EHF SN ET, &I
taskA 2SFFONHE LD L global A [ZHEAHIA EADAEITHTEIORE N L D Fc 2 I AFAELTZABIC R0 £,
INREELOVENETHLZELHVET M, ARKITHFANC globalA |2 (B — DA 712 dk-
ORASNDGEDT T II T —ThHIELHVET,

int globalA = 1;

int subX () {
int localX;
localX = globalA;
return localX;
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}

void subY (int paramY) {
globalA = paramY;
}

void taskA() {
int localA, localB;
localA = subX();
localB = localAh;
subY (localB);

}

Out of Step L AR —h TILZNHDFEAIABDPR S I, ZATND T 00— SOV F - 1T F OB O

DR ESNET,
Out-of-Step (Z) Variables (Read Before Being Set)
Key:
r or R (letter): variable is read
s or S (letter): variable is set
S or R (upper case): variable is used in current function
s or r (lower case): variable is only used in called functions
r,s (order): variable is read in at least one path
before being set
s,r (order): variable is set in all paths before
being read
r,* (order): variable is read first in at least one path
it is set and read in various orders
s,* (order): variable is set first in all paths where it
is read; it is set and read in various
orders thereafter
Settings:
Global Variables: displayed
Static Variables: displayed
Unset Variables: displayed
Struct Container Summary: omitted
Union/Bitfield Members: separate
Variable Funcl Func2 Func3 (in order of calls)

Task: Task A

Event Calls in Tasks LAfi—f

Event Transition Between Tasks L 78— R & [E£EIC, Event Calls in Tasks L AN — R, /L FH AT 25
NZBITD, AT DA XU NOERET = 73T 570IFEHESNET,

ARUIAN = A LT CICH 7 0T A THHRINIRSIL TR =D | LR — R ClIEsm g A -~ b
A=A DEREETHHENHOET, AU LU M E R1X Event Definitions #4727
THELET, ANUNEL, AU MI@EE TEHIND, AN —T 4 7 VAT DIFY Y — R Tk
5 —A—R L~ L DRI (=7, FIZEVT I BLOEREH) T, AV —T 4 TV AT A
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[ A7 DA U RBIEAE L T, AU hOFEE (pend)., A i@ &I (post, FAE DX A7 HAFY ) —
ANDT I AEMESED) AR D IV T (A MNIE Al RE72il@ % 3~ THIBRL . X ThH
A0 % P E IR EBIC T 2) DM TV E T, 27U T DA XUEE T, DA~ MO ZEFEL r7p s
M k72 T A= Lo T ATl 2 T AT T AZENER SN E T,

PUFIZART, taskX 25 taskY (ZENVEBH G A REIC /R o7~ Z LA B A 35614 R CAEL X9,
#define EVENTA 1

extern void PostEvent (int event);
extern void WaitEvent (int event);

void taskX () {
// EIOAL TR, B HEOREL FAT
PostEvent (EVENTA) ;

}

void taskY () {
while (1) {
WaitEvent (EVENTA) ;

// RN TENMEZB LG
}
}

Event Calls in Tasks L' "R —hFTlik, EOXRTINARUREBOREOH LA ELTUIZ003A XU MBI+
WZEoTEEDOONTWET, ZOFEHREF AL T, HFAXUIB—EHDOIEL WX A7 2[R T 57012
ST DIE A MBI AR BN LN HER TEET,

Event Calls in Tasks

Key:
P: task posts this event
W: task waits for this event
C: task clears this event
Settings:
Post event function: PostEvent
Wait event function: WaitEvent
Number of events defined: 1
Event File
Task
Line Number of Usage
Usage
User of Event
EVENTA c60la.c
taskX
9 P taskX
taskyY
14 W taskY

Event Transition between Tasks LAA—/
ZATROFRIENC BT AEEALRED 1 ST vRayr SENTRTOZAT PO AT Z L AHA N
UNBHE KB HODIFAZETY,  Event Transition between Tasks LAR—R L, IEER/2TF VR
2y 7 BIOFOMORBBEE AT D7 DIB L HET, ZOLR—MNI, XAV AL T D
A WRAET BT T 0l T 8T TR T HHFE L LR ET,

Event Transition Between Tasks

Settings:
Post event function: PostEvent
Wait event function: WaitEvent

Number of events defined: 1
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Events Taskl Task2 Task3 ...
taskX
. taskY
EVENT A ittt ittt et e eeeeeaaeeeeann P W

LAR—RTIX, v N7 RAERT, EOXRAII @A, 5, 7V 7 2 ETT 500 RmSIVET, ZOLR
— R FHRDIZHT=S T HER T REEDNOBHVET, KK 1 OO L AR 72720 A
YR FIGNCT yRay 7 OEBELTEZLNET, IDUEM T v Ray VAR T, 2
DDERI(FNIPEELDA N NAT) AL TEEET-TRY, LN BT DRI DZ AT
BOWTEETWAHETT, ZO5GE . ENOLOHIEH7n—B L OGEHEIZ Lo T, FAZBAEWICFRHEL
TN ENMRFEENDNET =/ LT2EE 2 5 TLE), Event Calls in Tasks LA —~af# LT,
8l 2 DFRFEDMENHLUEFTEZT 77 AL, 7 v Ry 7338 L TN ENERTEET,

DAL =M, A R B I ONE A SO B IE O LIS SN A U h3T %
— XX, FRINCREFTRE CHDOME N HHEVIFIRRHHZ LITHEEL TIZE, ZHUTSED, 3T
A—=EPAREIR (= a, BRI TV FITEBRER) . AU MR 3 HifliZp{ ("EVENTA |
EVENTB”72Y) . /T HAED B ANICH DB DA UM L CTRESNLT— LV EHOWT
W CTHHMENDHHENIZETT, 7 a— 7 IVEESCBIED B IES D /T A— R AR b XT R
— T HIEFTEER A, IHIT, L FIORTERY ., BEURA 2 DAV 152 B3 58 R 235

NEd,
Flow Check L7R—b - A %R UHIR
ZXODIEE

Task Flow Check LN —NMZid, # AZ13—M(FE2iZ= M) Bic k> CEESI., 7/ I LD H
MO RIS BT 227K 7 as T ANICBUWTCEITRIREL T AHIH 7 o —0SERF S E T, @
W, AV RIRFFEAT (7 a7 T 2O BIOE 3 O FELTHIZFATIND) X HERIRFFEIT (R 5D A
T T FATL, BIDX AT ~OE&EEHIHT ) 12T D2 enTaEd,
FLIIAFFDY) T IVAHA DDV AT DT, L F DO —Ra 2 A7 CEBLET,

- B0IAFZFE AR ZIE R L B S v HE7 2 Bk

- HIELIe DAY 2 — T XS TRIBRS L, HlfHl 72— D58 T RN (LS A RE T, DA ¥V a—
SOHEEZRDZ AT TEHRE

- Tl AOMO RSy & (HE) [RIRFSEATIND AREME DB DB AR (F7=idv—b) Bi%k

WOBEEIL, B—DHRAI LT, 3RO Z AT TCERT DIENTEET,

- ATV a—F XS TEICHRUNARF THEITEN., 70 T LOMOE 3D IERCEDIA A D
T —E# O B

- FICEBENRFICMOZ AT OBIGHNZFATIND VAT 22 WL T 584, #IH1b1-Ba%uE, 4
N =TT VAT LR T ORI EOLTENTEET,

ZDEBFRINEDETTT TN L DUINF AT DI G AT, WD O Task Flow Check L AR — 3%
FOBWREF R0 DIZRET, £ TH, W<ODNDLR—MNIUIEDHVET, FFiZ,
Mismatched Critical Regions L' 78— NI & 27 D27V T 1 77V 72 FEI COMEZ#H AL . Out of Step(2)
LR — NIGERZ A7 CORAERRNA AT OREZ R LUET,
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AN DIEE

A~ REE D Task Flow Check Tl AU MEZ IR (pend). fEHL (post) . I8 LNV T DEREAE
BTl SN A SN —T 4 L TV AT DDA MO & T, 1@ RAR
VT IERIC SIS KV ALERE N, =7 a2 i3858 7 I ViR Z O BBICES T, RANDEETIHA
LIVT OBAENPTONET, ZOMEEIZRTS T 5728 Event Definition % A7 227 A% ESILTWE
7

RAREZUTIZH 2 ORI DME DIV TNDF R —T (LT AT KA L TOBE AT S5 1E

LT, =7uxb) 1 OOB|EICRAIOER L2V 7T A ERLET, FILWITEEEZES L

%, EEOZVTEAEEH LB A~EER L ET, FlZIE, EBED VT B D4 Ri% ClearEvent &L,

1ODONRITA=RETHEDELET, FEHL TNONDaL RATRERRT 7 A LU F O TR BN ET,
void IMAGIX ClearEvent (int event, int mode);

#define IMAGIX CLR 1
#define ClearEvent (E) IMAGIX ClearEvent (E, IMAGIX CLR)

NEATI DI RGN HTLOEIDT 7 AL TF, 2077 A VEFRLIZH  -inc 47 v
LT, T _XCTOY—RT 7 A IVINFEEINA v 70— (#include) S b Iolic L £ (BR L= 7
FIAPORELEA T v ar | DEEBR),

Zb0#define BN AL,V — AT F T A YA ClearEvent & = 2L 3 ARSI TR U S Ay —
NHAEINDLZERHVET, L., §ERERDT — 2 _X—AIMEITECET A,

% D1% Event Definitions % 147 22123 T, IMAGIX_ClearEvent Z7R ARA <k, IMAGIX_CLR %
JUVTARRDNRTA=RELUTHRELE T, ZNHOEFTIZEY, A~ MEE O Task Flow Check T
I FIRARDENEL 7T DEMEL 2 KR THZENTELTLLD,

T—SEDME

CIC+ DS R L IR, C++O>&77\9:i¢ ERIEHE DO ROy MR L E T,
Task Flow Check L' AR —hD—fITIE, ZHHDOEKED L AR — ENDFIEE T T 547 2 arn
HVET, l/n“i’—bz“7°~‘/a‘/czc]:of Container Summary %> 7 /L —R 34 5%  HEHIZEED A 332
T T ER OB THEASET, 71&71 ;t“ TEIE RO AN L ODH AT ES KL, [AIUAERE R
DRNDA SIPBIDZ AT ZER ESHVT=H54, Variables Set in Multiple Tasks LA —MZIT AL 7303 F
IRESNETAN, HEEREKI i%réhiff

ZHUTHLUTEANE, LR =ML TH—OZEHEL THRbIEY, £OB I, BLSIFEE S BIAZR
KERDGEDDHDHNOTT , LIe3> Tl FIIE DB R —1 hR3EI Y THIL T DD Ak
oLl RN = o N e G

"Analyze Union/Bitfield Members Separately"4 7> a2k, I B W CH A EZIZE v 71—
/I/I\ D—ETHDHA N\ EEIWINERIELET, ZOF T ar G T 58 HEROSELFRT
V2 R NITRIOMSE LT B 5L GRS IVE T, ZOF T v ar B hicT oL, BAIO
EI—JLJ:O ZAUNBERCEE CTHLEHIRENET, BHDOYE A A /Y un.memberl ~
@Ft]\&:t\ un.member2 72 E DT R TCOIFERAL SADRAEL TIRIRSNE T, 2. 2047 T3
IR A RIChEASNE T, R Y a—H T =X T/ F ¥ Tk, B T — LR
B YTHE, ARVNDFEEINI A NEEE T THMLENAETET, LIend> T, BIOX A7) 5[HE
BRIZRIDOE Y R T7 4 — VR ~DEN Y TRHHE, ZOE Y T L THET Ao Y b7 40—V RIZ
A R T R BV ET,

7 BT IZ X o TR HERFLH T, ZNHDL R —NIE DA TV = VMR A L Z BRI OB )
IBMLET, RALHENIS T A—2 L FEERO /T A=A B IBERR R H A R E
LET, BAIRESNTESIDA L T v 7 A ASINARA L ZIZED, BEFIREEINET, Zhb



Imagix 4D DV 7 115

DUR—FTIE, RALZH N7V — AN MR TAZENBESNTWET, ZOBRERA 2T ED
BHNTRESN, TOEE L2 CHREL . BEEE T DAV REBRICED 4 CTHCODIE &2 DZEERIZE
WIHNZT 7B AT HZEEHVFEE A,

BIBUR 1> 5DIME

FEOMHUAZ BIEORA o 22l 32 — Aa—R & T 2856 . ZhHDLR—NIT v s 7 52K
DUNT, ZDRALZNHFLTH ﬁ'éica‘«“f@%lJ@%’.f%ﬁEﬁmi% ZORER BB A 2L DT
NTORFFOHUAFERRISBIFS AL, 70— VR CREES NI BB O W T DSOS ALE T,
ZHUZES T, UIR— N CREDOFERZ X DRPH O M TOINET, Tolx X, HDHFATTEER
4’/5”7Tiﬁ fp 73 funcl I[ZEX ES AV TIREFONHE AL, IRICHIDZ A7 T func2 IR ES AL TIFON S 72
Ba . ZNHDLAR—RTi funcl & func2 O] 573l 5 OX A7 TR Sz & /psiEd, Liz
MNoT, funcl £7203 func2 DWW TN TERIES N7 a— L EEIX ., W DX AT THFHRRENET,
ZD R A A EDREFONHE UL, BIERA 2 D3 5T R TCoL R —MMImEHSNET,

Useless Assignments — DAL RADEHS VWG EDRHVET,

Uninitialized Vars Read BROFIAH BRSO DGEDRHVET,

Recursive Functions FEBEOT 0T T LA TIIRELRWVBEIRBSIOHIZL AR — b
LanbuET,

Shared Functions FEEOT 0T T L TIIR AL WIS SHIZL AR —h
ENDLAEBHVET,

Vars Set in Multi Tasks IERIR DA ET T MBHR DG AL A —RENL5EE D
HVET,

Reentrant Functions IERIFR OB AR L CGREB SN A G A DV ET,

Funcs Not Used in Tasks KA OBIENB LR — SO A RBHYET,

Mismatched Crit Reg HEIR DR —ERLR—SNDG A BBV ET,

Var Flow Between Tasks FEDHAIC BT HELBOFER DB RSNOGEDRHE
T

Out of Step Variables HERALR O out-of-step ZHL R —hENDGAEDHVET,

Event Calls MEEAR DR, W, 7V T N R—RESNEBEENHVET,

Events Transitions RO, W, 7V T N R— RSN ENHVET,

TR HE, Useless Assignments LR — a2 frE | ZNHOMBARESNDA L AX L A TEDOE ETT
2, LIR—RFCIXEOGEN RELSNAZEIHVERT A,

BT A t—
—HB8 Flow Check L' AR —hZ, IRD IO L3 & ENHZENHVET,

Statement or partial statement in file.x line xx not reachable and
eliminated from analysis

TS IT — 27—t OREZ R THDOTIEHV EE A, FIERREERS> TVDA—RDTT
T, TNNERSNTORWEE 2B BL TR T 2120 T3, 20Xyt — I3 FO IR GEIC
HnET,

- P E EIMBISRHES N DR T, I~ H DG — R R o% 6
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-- goto, break F7-1 continue 72X D, FHlFEIOBE O ZIZH LT —R

G A= E LR OBIOTERLIATICH L TRITSNE T,

#define TRUE 1
#define TEST TRUE

void funcA () {

int conditionl, condition2;
if (TEST) {

funcB () ;
} else {

not_reached(); /* EERRETHLLIERSND */
}
while (conditionl) {

if (condition2)

return;

else continue;

also_not_reached(); /* BERETHILIERHIND */
}

return;

X T EH

BAZLH IR 7 NB L OBEMO R Ziliz2 57 — %7 a—f#HrTld, Flow Check Report (Z L0
FINCEHE M TOET, PO T Br T LTI | AR E AT VTEBR N RO RN SV ET,

AEYDOMEEDN, BHEWOA N —T 47V AT LD 2GB F7-1% 4GB OfI[BZ#E 2 TLEIZ LY
HHTLEY, ZDOEIR ATV BT D726, Imagix 4D 7 — X7 a—x A 3 H OARRD
B AT LINEENTWET, 7 —F7a— T IfEHSND ATV, N—RRIATIZ_X—Dr 7S
WET, HLUT. A —FHARD[F a7 D) — R ) OE|ZERSNTVET,

Include Analysis L7R—p

Include Analysis L' AR —NZIE, &7 7 AV BEEEITMERICA IV — RSN Tc~yZ 77 A vk
DIRIFBIRDERSNET, FFED 7 7 A /L THEHASII TNDE T VR TDONT, LAR—RMTCIE, 4
B D L RN DEFREIITES WS, ~oF T 7 AN DA 7 —RE B TINOLDEFRE
TXESDE DI HEI NI DT S E T,

Include Analysis L7 — MRt 4224 C, #include BEIE 2 B b L , 1o A VIFIR 2 FTEL . =2 —R
DFF A E IR0 ET,

Similar Functions LiR—pk

Similar Functions LR —MMI4 BiB L OV F23EEOE CHEEL QWAL E T, ZoFE#
[ DA Byt S N a2 S Y By W 2/ D DAY - T AT i e N U= I =115 AWyl SE - (AL =5 e
HDBEA~DOATIEENENOBEICH SN0 ETHRLBECH AT,

BB ORI, B L, 70 77 L ADT 7 TR, BEOARN 7 ZADOEA T DA A
a7 EREALEARICE> THIESNE T, E£ED 2 ORI SN T, A RTOFERMEIISCTHIN O
KRILFUNLF2 KB PICFRSNET, 77 7TV RO R 2 SO BRI L -> THEOHEND
RSO B IE S EE T, AN w7 ZDBMEIZ SV TiE, McCabe Cyclomatic Complexity., Halstead



Imagix 4D DV 7 117

Program Difficulty, 35J: 0% Number of Statements @ 3 DD AR w7 2R B EXIVET, AR v 7 ZH L
PERZTIZIE, BB RIEDIRN AN » 7 AR KBS E T,

IO 2 DFRIMEAT T %45 G T HARIL, =2 — LA ENFTRET T, ZOLAR—NIT 74+
JVRTIE, 90%DFAIL 7244 il Q0% DAL 727 7 T M FF-2h 90%DFAIL 7244 T 90%DFH
UL TZ AN 7 2 iz FE2 7, 90%DIERIL 777 T T k& 90%DFELL L 7= AR v 7 A fifi 452 BA%
ARLET, ZOARIT Similarity Formula # A4 7 0/ %@L CTEE 52 ENTEET,

LIR—NZE 2 2D HIETIEITTEET M, Reports A= —nBENHSNZHE5121E, 7 ey =7 N
DT X TOREEIZHOWTHAR T 2EHN T =y 7SIVET, ZOHE | WEDD OB B EI
NI, AHTOES, 70X 77 AO7 777 b, 3L McCabe Cyclomatic Complexity (25t
L ThR/MEZEFRTEET,

HDUNEL, Analyze #4171 775 Similar Functions LR — R F2( 7952 L1250, HDFFEOBIEIHHE
AL 7 B3B3 22 LN TEET, Analyze X AT 17 NIETAT FZVBEIC 74— DAL TN HEX
ILHFNZ, ZOX AT a7 TORPFINFRET T,

Import Report ##g

Import Report #48E1% 2 DO HRICFIHT5ZEMTEET, BB ICZOMEE T, EBEDOLR—1 %
HFITIT LA, WUNARTES L Flow Check LN —h 4, TUBAMERS Ty ar it i
Ly ary CHA—7 VU CERTHIENFRETT, 5 _IZ, M7+ —~<vhS=MHBL AR —h
%, Imagix 4D DIERTRY —Aa—NlERELH A S, Imagix 4D [Zr—R LU CERTHI LN ATHE
<7,

Flow Check Report DRZELEFAS—T>

Flow Check L R —hD%L 1L, AR L2 DT — 2 70— N ISR o 55728, AR T DD D
A ETAZENHVET, fERIL ASCH 77 A M H I RTEETT N, ST SNI= o 212 > THR
SNAHFRL T —a ik bivEd,

Import Report #AE Tl Imagix 4D TOHDFRR Dy ar DL, LR—MNeEE AR T 287
UR—Maef A —7 355 ENRtS N E T, ML R — O RAFRHR R 2L AR — M (4dr) %
FEHTLZLICEST, TRTOVZIZETHERPL R —ONEFEEOLDOLILIRIFENET, ©
D% T ISR NDERIC, Bipb~ir EORRD =PI THRINAEAE TH-Th, #E
WL Adr 77 ANDA L BR—RESET,

I BBL AR —F DA 7K—F

Import Report A=A L%, S5 — /L CTERSIZT —# & Imagix 4D L&A 35720 O )
BRI E 3, FRIC ANET — XS E o T/ &N MEA AT 5 HBYTO, Imagix 4D DY 7k
U= T TERITRERE O AR B LE T, T —H DA R — L LR —FICFR RS E D
ZHUTHHET DY —AT—R~EEEBEL T, 205 Imagix 4D OfFEHAZBRtE T HZ L3 CEET,

Import Report B4RETlL, 7 — X RFED 7+ —~<v N CHL <K EID(.csv) 7 7 A /THFTEL T Db
BRHVET, WOFNZONWTEZTHELLD,

Anything here is ignored.

File,Line,Col3 Descr,Col4 Descr,Col5 Descr

C:/full/path/to/file.c,123,something, something else, third thing
C:/full/path/to/anotherfile.c,456,again, xxx,anything thing

CSV 7 7 ANDT —ZENNT D7l 3ODHTIREENTORITIERDERA, 4 DL EDODHT
LINFIET DA AR —NMLBLICIE 7 7 A NVEITE S OE RSN E DI T LA R— T _&EN
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NRIONET, 77 AV D TN RL TR DO BT N FEREI, Imagix 4D D7 o=/ Ml S

TN SR L TORITIURRVER A, FT2 1TH 513 2K B OI 7 AIZFRRES N T OlTh

2RV ER A, T—FITORNS, T —F 0T LOL I E & T~y X 1T (e WIIX"File,Line,") 2 AL 502
BHVET, .csv 77 ANVNTZONHITIVRNZH D TIET N CTEAINET,
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EDMD T T L1

Main /SR DT A4 AT VLAY 4R EAHTET D, 2 DDTALRUAHOET, Main /S0 O /AN
Project V4 R 30, 7 ay = VNI M EL | VI N =7 DR EDE T AT DD
B = ar NFRRSIVET, Main /S 3 LD 2D Symbol SV, LIRS L DOFFED T VR
JZDNWT, IRAE RGP R RSIET,

ZIBDEIED/ STV DIED, Information 4 — L AL, W T IWNDT A AT L AT 4 RIIZER RS
TNV A VEBIOBERICEET 2 E S RSN ET,

Imagix 4D D KOKFED 1 5%, ZHHDT 4 RN+ X AICEEIL QA EZATT, Znb
DT AATVAGFAE DO THHTHIET, V7N =TT 130T TR RO DI ENTX
ES N

Project /ARJL

Project /XL T vy =7 M BT 25El72 L ~ VOB ENR R RS, Y 7N =7 OIS F7 o/
G T 5720 OF IR0 FET, EED S FN K TERIERPIRMES L, 2—FOREDE
ANDOAT I AIR0ET, FOMOX T |IE, T a2 I NEIRO 7 T A =R NG ENTNET,

File Index #7121, Imagix 4D 77— _X— X Z@—RZINTNBETXTO T 7 A /L DY ARNE RIS INE
T, Ca—R& CH+a—ROBGE | ZORDIITFEESIFFED.C. .cpp 77 AV LA 731D
VBERHDHTXTOD.hT77ANBEENTOET, Java :%F‘O)ia/\ Java 7 7 A NVEZNBRA IR
—h¥%.class 77 A NVOE G NEENTWET, ZOMO—HED X7 1X, File Index D5 ~EATART
IR HIENTE, LENZ 1 DDRFEDT 7 AT L TAN, BfR, AN YA B —AF =y
7 O RSIVET,

YERILT= 2 oOX 712, B T Clde<in B Ny 7 OA U Ty JADREINET, 1 2D
ZAMVIZ, CIC++ 13/;7#0)&5/\ X Namespace Index . Java 7'my/ =7 b ua—RDFEIE Package
Index Tﬁ“ 2% H D Class Index /X% /UIZIE, Imagix 4D 7 —H RX—RIZEENDHTXTDITA, T
»7L—hQava DEEIFALH—T A R) | A2, ISR, IR ARSAUE T, File Index &
FERIC, 70y = hONFIZBET OEEAHRL  FrEDT AR Z T IEOE R D721 LD
F£7°, F7- File Index L[REEIZ, HRNZHDOATART T NS —8 DX 7|2, FFE D4 AT 22 72137
T T DA BAR, AN 7 ZAD TG AR R T HZENTEET,

AT TIERW URVE DT E S — T A2, 47 B O 7 ThHS Symbol Index Zff i T
T, 2—PRRETDHLPLL VR HONT, TV MNDOZEDRIDYT VRNV E TR T—E
FKRLET,

Database Lookup # 7 12137 =Y AN = X LRSIV TEY | ZIUlL > TRy =7 MND T RIS
DWTIVE PRIV AN AR T HZENTEET, A ORHMIEMEICEE TV VR VEFEE
?‘ 2.’) VAT AL BEORAT =T AN 7 2R E D @A L T2 T 42U 8
HETY,

TaV e NERO I ZY AT =X LD 2 -2801%, Grep Tool %7 C9, Grep Tool i, Unix @ grep 2~
RZ2HWT, V=23 —RIZE ENDRFED L FHN DY a8 E LD HT L a2 AIRRIZLET, grep &2 =
JLINETIEZRS Imagix 4D N GFEATTHZEICED, CFHIEE T — AT 7 A Vil D H 5 1T
RO DZENTEET,

BITED Graph U4V RUIZERIRSNIZT R TOV LR NVEVANE R T 521285, Graph Symbols #
T2 D AR E DB D7 T 7\ B A L Ty 7 A% L E T, VRS ARS LAID 2T
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ERERIZ, RNV BB T VT 7 Xy MEDUANI T 50, FI2ET7 7 ANV AT ANONLEIZRES
TEEODIDEHEHTHIENTEET,

Z LTt Project Summary /X5 UZIE, 7 Y= MEIRICE A ESNDY 7 8T =T AR v 7 ADAED
FRENET, INBDAN) w7 ALY, PP =7 OFPHZ T IECH R T N TEET, £
Main /3581 D Metrics 27 2L T, FeE D7 7 AV 4 R12E0, 7T A, B R D AN v 7 2%
FORLUCTHITHZELAHET T,

Symbol Context &L 28—

Project /X RV DWKONDE T T, VRV DY AN T 7 AN AT DONLENZ S TEEDDHIEN
TEET,

Imagix 4D 7 — &~ — Rl # DT RNV INE ENDG A BILET, ToE 21X B AT TAB
TEHRINTNTC, ZTFABILTZ7A/L C TEESNTNT, 774V CIIT 4L 7N D IZHBRICE
PILTNBENST=Z LB E T, T —Z_X—2AD VR WITZN T ar 7 2R TOET A,
LA TUIOV— T AL 7N DISD) a2 TN nZeb b0 ET, Fio, T — 4/ — AN AT
LTATZVEBOIN) 2 7 I 2 mE & EFR VG EbHV ET,

AT I AR T D—ENI NINDL RN T E T RV O E Y 2— T DA = A LR L
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RIFRIFf T — D ZENTEET, segfault Z2E B3R AEL, 22— R IEHO TR a1k T L8
AT, EBETET, 202 =Y EZa/ AL QDL O L RSN ET, 252 2<D12iE, £D 21—
FIZEDEXFEH L Ce~v v BT Imagix 4D ZEEEIL , EHRO FRiZaR TR TLTHLHWNET,
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W=/ \AR—IXDITA—71 2754t X

P RR—ZAD T —F (T TG Ae AV AN— LT AD TR0 T, EEDOT A A% A
VANV T BT, BE T Y RNV ERETHLENRHVET, F7o, Imagix 71t A — EEE
SHETWAY YU NHEBEITHLX T A — N HEIC R EISN AL AT LA R E
THOMNELHNET,

Imagix 71> A — 31 teplip V7 b S L CHEEED Imagix 4D 77 A 7 7 7V r—arv LidfE
LE7, License Installer Tl A4 A —"DEMET 5D IP TRV A (FETEAUTH S T

DNV EIRET DMERDHVET, Fio, @EHAR—N Xy M RETONERHVET,
ZAUE 1~9999 OEHLCTHIEL | 1@ 1% 8000~9999 D& DEAEH T2 L1/ >TVET, &
T LB R AT RE R — R R L CLIZ &,

Imagix 4D DI Z7 AT 8T 7V —3al By Imagix 74 B A — L350 ae’—o Imagix Y 7 kY =
TINBFETINDGE (T72b b, 1 AEITENLLED Imagix 774 /LH—/37% Imagix 71 2 A+
—NNEFNO= L DB ITIE, AR ATTA B ASNTNDITAT v Db A
AN—/LTHMERHYET, Zih Imagix License Installer 258U CTITWET, ZOIWNZIE, 711
A= SHEFIT IP 7 RUVA KOVRIUAR—N, 23y MR ELET, iUk, 71720 Ah—
IR & DT 7 A N —/NIZONTEN LI TR ERHVET,

7L 21X, Unix w32 1 15 (PaloAltol) & Windows << > 1 13 (Redmond1) % Imagix 4D 77 A /L4 —
SNELTEMESETWDELEL LY, ZOHA. & 2 D Unix <> (PaloAlto2) D =— A3 Imagix 4D
ZHeE) AL XTI, PaloAlto2 A3 PaloAltol 7°5 Imagix 77 A 7 o T 7V r—3 a7 ) = 7 i dr
A, FEATLET, Windows ] TH IR LT, Redmond2 7% Redmondl @ Imagix 7 b7 = 7 % &t A
I, FATLET, T8 AP — 308 PaloAltol 72 & 3% &, PaloAltol | C Imagix License Installer %
FZ1TL . server-based floating license - server machine L COA L AN—/L AL THOMLERHY F T, F7=,
Redmondl |="C% Imagix License Installer 252171 . server-based floating license - client machine &L T
DAL AN—IVEATOLENHVET,

F72, Windows <2 N300 TRy NI — &ML TOD, T4 A — "\ ELELD1E 1/ T,

7T BEDOL—YP v OENEIIUC Imagix 4D VY 7y = 7 H 1 —F WAV AR— /L L TGS B R

THELEY, ZOHA 2%, Redmondl (Z server-based floating license - server machine &L COA A

h—/L%&1T7\ Y, Redmond2~8 M-~ /1213 server-based floating license - client machine &L T
A= IVEATUVET,

S4BV RAY—INEREITS

J—=Ray T4 A T7ANR—=ADTO—T T TA AT, Imagix 4D 137 7V r—ar %
BRENV T THEATEET, 7270, = "R—2D T 0—T (7T ZADHE 1L, Imagix 4D
DZEZMEFRT DRI Imagix 74 E A — " EBEIL TODMERHY ET,

Unix/Linux > A7 LD6E . T4 A% — 3, . Jimagix/bin/imagix-licsrv Z L&) 352 L2k~ Tid
BSET, £, Imagix 7B A —N"EZEESE TOD v U HIEEI T AL EICT M A —
NN BB EEISNA LIV AT LA ET DM ENHVET, Unix/Linux > A7 A TIXZIUE
—fRIZ, Imagix 71 & A — SORFOH L Z2411{E 227V 7k (lete/rc?) (BN 5282 KL £ T,
Unix/Linux iR I, L fimagix/bin 7 AL 27 MINZH 70 re A7V TR EEILTOET, Ziud
BREICAEDE UEETLIENTEET,

Windows 2000/XP/Vista/Win7 3 27 LTk, A A=/ D7 o A THENZ T AL AP — 303~
D —EADONDEL TRy Ny EINET N, HIDTIA B REA L AN—/L T HEEITIL,
Services 7L ML CREITIA BV A — \EEEB T AL ERHVET, TNHOBREEIZOWT
I, ENENDTVAT LRF 2 AN CTROFELWEHRZS L TLIEEN,
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VDD DREA T v ar WHESNWTWET, Fov I TN ONTF 2 /A SN ITFAT T 7
r—arul BT AL, -licsrvlog FILE 47 v ar a L T/t A — "EiEEIL £9,
FILE L, 74 B ADT 7T AT A BELERINDHT T 7 A NDT NV r324 T4, Windows TIEZBID T
EELT, regedit Zf# L C3C551 Loginfo 2 HKEY _LOCAL_MACHINE\Software\Imagix\4D L3> A
MIZIBINT 528280, vl 77 AV ERET HZEL AIHETY, KRIC Loginfo DfE% FILE IZF2 EL
ESr R

BHEDTA B ADREEIL, 2~ R DHO WG DRI RVEG T 5Z L3 TEET, Windows
FTA LAY —RZONTHINWEDE DT, T4 A — <3 T “imagix-licsppt -licstatus' %
FITLE 7, Unix/Linux TiX, “imagix-licstatus' Z B L %9,

Imagix 4D V7 AT v T TV r—a  ETTELY U AR T AL TEET, BRI, T '
A= NIT IR ATEDLY VAL, BN TELROITAT T TV r—abinbF =y 7T RT
ETE T, 72720, 77 AV [imagix/data/clients 238055 51X 7 7 ANV D EEIRAEI, VTAT NI AL
WZRANMAINRRSND VI T2T D5, Imagix 4D 77 AT N7 7V r—ainbF =y /TN TEE
T o ZO77ANVTIE, AJFECF ClIRAR— ATV U A K Y ET,

2V)—20—T420 54t X

Y= RR—2AD T —T 4 T T AT ADEEZ Windows 77 v | C Imagix 4D ZH/EL C\5
A X, Rrv b —2 L OBHRIT IR L2223, DTy 7 vy ETO Imagix 4D OEAEIEFE T 72\
LT ENBHHTL LD, Imagix License Server £, A==—[Help] > [License]Z-i@ L Tfii F Al HE7R
Free-Float License #§AE CZHL7-fE FERESL VAR —RL £, ZOMREAZFIH 34X, £ Windows
Ty T T DT AR T DL TEE T, 2—PELTOMAMERIZZ DTy Ty 728
T LM ETHRREESIL, T8 AT — " EDOEFN TN TWDHEXITE Imagix 4D ZiEEI 7523 C
EET, HOTZO TRy NI —2ICHEEL . T B AR TNV EGAICH, EELOAT =X L% 1@ T
B~ ETF oA T HULRNZIT T,

A RAY—NERETS

Windows 2000/XP/Vista/Win7 > A7 AZEW T, Imagix 71 B A — EErET D720 ORID T
IBIE, 712 A — 3w B Services 77 Ly MZEN T A | A — \ZAZ (L 528 TT, WKIT,
FIC~ v o \imagix\bin 7 L 27 N2> imagix-licsppt -remove' & 321 TL T, —E AD VAN
Imagix 74> A — _"ERVREET, ZOFIANTE T3 4UX, EEED Imagix 712 A — L7
TV r—a VTN 2T 5%~ DA AN G DR E T HZENTEET,

Unix/Linux > A7 L TlE, T2 A — %45 1L LT, FI A2 7 Mlete/re)ITMNZ T2 B 2581
RS MERHVET,
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Imagix 4D DAHAXZV1 X

A== —IHH A —T TV AT A TCOVAT LT AL 7N O4 1, kSl R—k

\ZEDHET, Imagix 4D DV ORI AL~ A XA HETT, T DHIH LI, Jimagix/user 5

SLINID FIZHDVT T AL NIRRT 7 AN EE BT HIEIIVERINE T, 77 AV EFOEE S
EICETHHELOVBIT 7 7 AV B IRICE TN TOET, 22T, Ehi /JRE/RRW O D I AF <A R
WZOUWTCTH B e it 2Rl L £,

V=V OBELHMELICBILR T DR E DR EIL, Imagix 4D DX AT a7 CIRETHZENTEET, =
REAT TR EBL ORI N S0 EHO 7T ey = 7OV ANL, 22— LIk OBy a $T
FRAFSHE T, Unix TiE, ZOTEBILT 7 A /L~1.ADrc6 [T ST, Windows Tl, LY AR
HKEY_CURRENT_USER::Software::Imagix::4D 4Drc6 23 S ivE 9,

ZDOMOFEEZDWTIL, B OFT 74V MEZFEEL ., Imagix 4D BRI Z A —R 35280
TEET, 2N, 4Ddefaults 77 A /v &8 L TITHOAVE T, 4Ddefaults 7 7 A /VIZHANHD 77 A0 &
2—PEG DT 7 ANDOW S EFESELIENTEET, ZOIIRGEAIIE, W DOT 7 AL D5
o, 82 O —FEA O ENTANHOR EIESLL TEHASNET,

77 A /. Jimagix/user/sample.4Ddefaults (2%, —HFIDO BT 74V MZOWTOREMEY T IVERE
bEENTWET, ZOMDT 74V MEE T L5813, FEIC DWW TT 7=/ AR — T [
HBbhELTEEN,

F 7 H VIR EITINZ T, Imagix 4D [ZVEZ DMLIZh B AR~ A XA RERE 3 indHD £4, T 4L 7k
U..fimagix/user {21, Imagix 4D OERAVEIZB T B4 E DER D 2 HH T 5, WKODD 77 A VindH0E
7

user_doc.txt Imagix 4D @ H B4R 2 A MZDOWT, T 740 D=
VT ERRRE I AR~ AR L E T, user_ed.tel  FE
Imagix 4D =7 4 # %X %7, £7=. Imagix 4D @ File
Editor Z 3% A8 Bl AT L EHES T E T,

user_mnu.tcl Imagix 4D DA=2—% I AZ A ALET,

user_prt.tcl TTT49T T4 Ry T VMU HEED I WE T AL
~ARLET,

user_rpt.tcl BIMOUVR—AERKL, Zha [Reports] A== —(ZiBHIL
F7%

ZHEDTT AL, RIEROEABRABE TN TOET, 77 AVEEET DA, itk S55
WZBH BRI 72 ik e . HOFED BN NMLETT,
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READHEE

Imagix 4D (X IR R IV 2D ARV A FHLE T, 2072 | KRBT 1Y = 7 MNef> T
T YD T = Ak ] ESW T o720 E T, T aty OB E A FIF D50, AEY
BT AHINNLNTLLEY, SHARTIUT, KAWL XTIFTT — I AT —a AT D AT
VIS DR EELILTWATLEY,

Imagix 4D Zfi > T A&, 2 XA MEEIN Y TIHEL T TAEIDR AR R LIZEVI) Ay B — U NR RS
HZEMBHVET, ZIUTEE VAT LDRAT Y T AR — 25 W) 7-Z LA R L COVET, ZoRE
BRI DITNE, T A AT A= ZNGIBINDOAY 7 A— 2% AR L E T, Imagix 4D 3 H—D 7 1
P MNTEWEL TWAEEITIE, T AT P AR—2NLIEWIZHIINL £, ZOAEY ARk
L. N\ T =< R ET DD ANEET O T Y 2/ M 4 BIEELZIEO NIV TL YD,

FRICABVRED A=V — T AN 2N R E LT XL DI ERHNFE T, AT S A— %
FFITESTNEDIZ, FIEAYE—UNHAEEITIE, i AR EER e — T AR — R &R L T2 &,

ZHUE, T AN =T ZAR—AD[RE DS 64MB D HP-UX 3+ A7 LA CELMBEICZARD £4, KR
a2 Mo TOAEEIZIE, D7t 500MB 13 AT BEIC L72IE) A3 LV T L k9 (Solaris

AT DT 7 4V MEIX 2000MB T9),
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D&

et 3 Imagix 4D 23R/ R B ET 2 LR A RLET, 2 Th, JiULX b CTlEME Y — LT
B0 U IES I AT AL NBNET, 2OV — ML, T 0l BB A=A NE | ERITET
TR —RT AN B AT DA =R LA IAEN TOET,

. Imagix 4D DEMEL CTODEXITNER CI—NRAET DHE, I—Y VR —HFICAT L — K2R
(MR AT —) DIBICELL  BAEOEWEIZfEILL, =7 —a /NS Ed, T ORET, il
IE2—VFOFIZEVES, D=V IVOBALIZR SN2 AT, AT T2 B EICs L TTb 2 kL
TN EDBME— DT —RED AR LRV ET,

Unix 8855 CIE, Imagix 4D =T —uZ ZAE T 57O 3567 74V 77 AL
IZ..fimagix/user/.errorlog IZENILE T, ZOT 7 A NP EZIALRAIBETRWIEEIZIE., 18PV
~/.4Derrorlog DFFTAME HSLE T, 1FEAE D/R—T 220 Windows TlE7 71

L. \imagix\temp\error.log 23Mdi FHEA1E 97725, Vista & Windows7 Tl d3517% C:\Documents and
Settings\(user name)\AppData\lmagix\error.log (2720 E 4, n/\2id, Hid =T — A RZ| O FLEkD
ENNS, =7 —DRKZPER T ETHRAREROEENTOET, ZRSAITH, EHICTT —n
777 AN DIFEETEZR L . 1% support@imagix.com £ TR IEV-EITHEENT T,

FIRE AN Imagix 4D 2 L T CE O T2 EIZ DWW TH-ALT 7 = IV IR — hD R A 7128
W DN TE N TNDEEITIE, N —RARZ ZBEDNIEZERHVET, hb—Ar 71X, Options % A
7 uZ (A==—[Tools] > [Options] > [Environment] > [Technical Support]) CAEKINAIHZTHIL
NTEET, Unix TIEAERRSITZ 7 7A V1T~ ADtrace_(hostname) _(timestamp)iZ E&ZAFNFET,
Windows Tid~7 7 /L1 trace_(username)_(hostname)_(timestamp).log &V )4 | C error.log 7 71 /L
ERICT AL 7R (RSB ICEDIVE T, Imagix 4D OB, £k th 24 FEfE A 2 DR — A
T AT T XTHIBRSIVET, M —AALERE Imagix 4D O/ 37 4 —< U AR T, JEFICRE
W7 ANERRENDZENR S DT, BN AEL CODGAEICOAMEH T2 B IO LET,
I79Y a2 IR—ME—RTh =A% FEITTHE, SHITNTH—v U ANMETFLET, N — R TR
BT — 22T RIS T2INTRET IR, N7 —< U RET 7 AN A R T DTN HD R B %
INTTHZENTEET,
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fif#% A. Imagix 4D DEZ

Imagix 4D . ..\imagix\bin\imagix.exe (Windows ™354) £7-1 ../imagix/bin/imagix (Unix/Linux @
LR EAT T AL IEEIS N ET, @i, Imagix 4D 1347 v ar afhrPiciEEiEnEd, 1o
YL EDOFAT > ar 40T Imagix 4D B §-5L ZOEMENEHINET,

-cmmd filename  Imagix 4D /Ny FE—RTEBIL, 77 A /L filename [ZL > THRES N~ N
EFEITLET,

a2 T —ZOEEN. FTEIEL R —FOR X 2 A ROVERR Y . BTV IRL DL\ NZ AT
SNTIE, T RIS T VB TY — LR RBIL T\ 2 B0 LS A, ZORREICBIL T
1L, filename 2R 922~ REBIOERXDL GO (18 B TRELGBHALE T,

-demo  Imagix 4D Z&EHL , HENICH T AT mY s M EE T,

TEE—RTEREITHE, Imagix 4D (XA BT VT ay e/ en—RLET, Uo7 ay
IRV DT — 4 —2En—RTHZ LI TEERA, TEE—RTIE 8T/ A0ME
HEnEtdi, ZOEMEX, Imagix 4D %7 €74 AX—2f L CREIT 5L XL AT,

-project dirname  Imagix 4D ZEEIL . HEHYIC dirame LW W 7 mY =7 BIEE T,

-project 47> a2l L CEEEI4 A&, Imagix 4D 13 H IR e Sz 7 oy = 7 haBI<IEN
PR B S [ RRICBEL 97, Imagix 4D Tlda—H A X —T A REELC, o7 ay =/
BAWED, 7 —& Y —REBIILTZ0 T 52N TEET, -project A7 vaid, v v F2—VEEIZE
WL BB EV N2 — P EO T 0V 2/ M 5591292 ECTiROBI RN T,

-regen dirname  Imagix 4D Z{EZEIL . HEIIC dirname LV O 7 By =V MR 2B BV
T =2 E AR LET,

-regen 47 > a & LT Imagix 4D ZiEEh 35 & -project A7 T al A L7 X L EERIZEIEL
FTD, BRDAIL, TRV NN —Aa—ROBIEOE 2 — %R T I ey = VT — 2N
HIZFHERSNAZETT,
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18R B. /Y FE—,IVN

Imagix 4D (X2 ~v U RIA LD DEESHAZENTEE T, Zhut, Ny T EfELL TR ES ATV o —
IVTIATLIZNWT BV 2 Vb RX 2 A MOIERZRE D EE 72 0IRUATHEEIZIT, FEF I/
FIT9,

Imagix 4D I imagix -cmmd cmmd_file_name TREONM 281280, Ny F T b 2L L TEITTHD
EMTEET, ZOF—RTIL, Imagix 4D [TEBL , =~ R 77/ cmmd_file_name [ZF5ES 1722
U REFEITLIEET R TLET,

FDEEMZR R =2 A A3, . Jimagix/user/user_cmd.txt 7 7 A /UAZHVET,
avwok
A RT7AND—EEL T LW E BN D R E TN < 00 £,

cmmdOpenProject AL/ (= SN I he )
cmmdUpdateProjectData A= DZES/ i I I
cmmdRegenerateProjectData Tav N /AT D

cmmdReport LViR—bhE 195

cmmdReportExport Lt DA R— NIV R— 25
cmmdReportMultiple BHEOLVR— TS
cmmdReportExportMultiple DAL R RITEROLR— 5
cmmdMetrics AN I 2% W T1T 5

cmmdCalcMetrics FHREITHITET TAN v 7 A& T U720
cmmdDocument N et A )

cmmdDebug 7Ny h— 2% AERK T % cmmdOpenProject project_name
Z7'r =7k project_name ZESEIRAEIC T2 FHiE T, project_name X T TIT/FAEL TWH /By -
IR U FE A, 2T Open Project B%AE (==— [File] > [Open Project]) IZFH ¥4 L %77,

cmmdUpdateProjectData

BUEMEEEIRRBIZ 2> QD7 ey =/ M BT 5 Ffe & T4, ZhUd Update Project Data 52 (A==
—[Project] > [Update Project Data]) (ZfH24 L %9,

cmmdRegenerateProjectData

BUEMFEIRRBIZ 2> TV D7 ey =V MR T 5T & T3, Z4UE Regenerate Project Data #7E (£
—==—[Project] > [Regenerate Project Data]) {ZFH 4L £,

cmmdReport report_name [ file_name ]
cmmdReportExport report_name [ file_name ]

L 7R —N report_name %7 7 /\ file_name (2 7795 FHi X T9, cmmdReport DI
cmmdReportExport 2 9-5& . 77 AV &% T Imagix 4D |2V R—RLCTHEL, LT — 3
DD RNV A DT RTRFERIIETRTSNIIRAE TERIRSNDINT, FERDT 7 A /AT
BRIpT — Sy S A AE N E T,

report_name |ZA==—[Reports] TE/RSNDHL RN —hDARINLEVE T, AN—RLT L H —/3—
OIZEZ, 74—~y MIEVAR 5722 (L) THUIDHERHVET, 72&z 11X, A==—[Reports] >
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[File Summary] TR RENDHLAR—H T3 58561213, File_Summary S48 EL, A=a—
[Reports]>[Source Checks]>[Expre55|ons]>[Conversmn Issues]> TR RSNDOLAR— M )T 585
A121%, Source_Checks..Conversion_Issues S8 &L £,

file_name |X7 7 A VD 5E 4/ 3X24, T, file_name 2413 5& . cmmdReport 1%, HiflA] Imagix 4D 73
AETIT 4T ()—</)V) =R CREESNTZEED Print X A 7 a7 (I ESNIZ 7 7 ANV E 21331
TIZVIR—b L ET, 2084 cmmdReport 231 T3 AR1IC, 7V M A AT 28 5%
<V UR T AMTEELTNEE 2 Db LIVER A, ZIHDOZEEIL Print X4 707 O EICKHELE
T, TNBDOEEOREZLY, §ilRl DAL Z2T70T 47 2y a TOREN LEESNET,

vtgPrint(Comment) string
vtgPrint(Output) { ToFile | PipeTo }
vtgPrint(PipeTo) string
vtgPrint(FileName) file_name

Windows D354, vtgPrint(tH 71)% PipeTo IZ5% &3 52 &1, Print &7 12 C'To Default Printer' 233
E/NE A1) J‘Eébiﬁ“

LIR—hDZLUTE, WO DA T vary B ENHESITWET, 7 74/LE Tk, cemmdReport 1
Imagix 4D A AR EEGE )T — R CEITSNTEZORELEHALET, TNHORE

1%, ../imagix/user/user_cmd.txt 77 A /WIZU ARSI EE AL T, 2~ K77 AL CHIZRIIZHI
22N TEET,

cmmdReportMultiple [ directory_name [ report_list [ skip_list 1]]
cmmdReportExportMultiple [ directory_name [ report_list [ skip_list ]]]

INHOFRHEXT, Bl 2 OFEESIIZLAR—RT 4L 2R directory_name NO 7 7 A /W &g
IH1zLE9, emmdReportMultiple D139 1Z cmmdReportExportMultiple £ 328, 77 A V&
T Imagix 4D IZA YR —RLTRL, ZRETFTE S —Tar DIl RV A DT R TNFERIIH T
FHTENTRAETERREND TN, FER DT 7 AR R T — 25RO ST AEIVE T,

H 17 7 AV OL4RNE BB HIVET, directory_name 23 RESNLDE, LAR—MNIL 7 m
¥ =7 MemmdOpenProject Z i@ L CRIMN=7 0 = 7N D&H 5T 4L 7R ND ., reports %75 4L 7k
iz EnET,

774/ ClL, cmmdReportMultiple (% Reports A==—0 FIZHNLT X TOLR—EZITLET,
report_list 33O skip_list (2L~ T, FATTHLAR— MR T 52N TEET, HLAR—MNIT
cmmdReport TOF5E & [FARIZ, report_name DI RAEH L TL7EES W, £UANTL, {File_Summary
Source_Checks..Conversion_lssues} D2 FEINTH A2 £, skip_list THESNIZb D LS DT
RTOUR—=FARR L2 AL, report_list 513 {3& M 450 all 245 ELE T,

cmmdMetrics [ directory_name [ symbol_type_list ]]

cmmdCalcMetrics [ symbol_type list ]

cmmdMetrics (3, 772~ XEID(csV) DT 4 —~ v AL T, SV RIVAN I 2% T 7 A AZA IR —
FLET AN I ZZRFOT RN DRI LT, Jllx DT 7 A NVIMERSIVET,

HA7 7 ANV OLFIT BEIRIZAHTHIvET, directory_name BAEIEEHE, LR—NIHL |
=7 cmmdOpenProject ZiE L CRA N7 By =/ ) DH5HT (L7 ) ND ., metrics 77 (L7
N hEnET,
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%

cmmdCalcMetrics (%, AR ZITIHLDD, TV RIVD AN w7 2% 27 ZAR—RUEH A, ZHUE
cmmdMetrics (25D T, Imagix 4D D7 1= 7 kA DR EN Very Large IZiR ESHL TS
EXICOBBFRERY, FHREENTZAN v I ARy a i TF —F R —R TSN D IO L ET,
GELLIZ, K=Y HARD Ty = DOV —A | DIEEZS L TLTZE,)

T 7 H/VNTIL, ZRHO FiX 1L Reports A==—O FIZHNDT X TDAN) w7 AHT IV TA
N 27 ZR—KLET, symbol_type_list iIZE>T BT BAN w7 AT 7 A N ZAHIR$T L0
T&EET, symbol_type_list OF 74V ML, 6 DD LR ARG T AR E S {directory file
namespace class function variable} T4,

cmmdDocument [ directory _name ]

T 4L 21 directory_name |[ZRF 2 A MAERCT 2 Ffi & T, directory_name 23 E IS 172 & X 1TIE,
HiEh L v a7 emmdOpenProject 218 L CRAZ L 7 0y = 7 N Do D55 FTIZ F ST
74127 K (.Iproject_name.4DD) (ZHH & E T,

Document ¥ A4 70/ O EIT By v a I CRAFSNET, 7 74V TiE, ZORENRF2 A ME
A S ET, BIORE A FALIZWEA 2, DocGen o —hCATEDBR ELEFREL, RFa
MERR T BB AZED Y — i 52 R TEET, LLTFOZEIE DocGen > — RSN Tl I LD
R A MR EZFEIL 9, Document % A 707 |RSIVTWDHERY | [RIREHZE FTX72\ > Format
L File DA EDENRHVET,

sE¥ e

dcgOptions(Style) { UseOptionsSettings | ApplyDocGenSheet }
dcgOptions(DocGenSheet) file_name_of .dgn_file

dcgOptions(Format) { ASCII |RTF |HTML }

dcgOptions(File) { SingleFile | FileperSection | FileperSymbol }

cmmdDebug [ contents [ crashsppt [ tracefile ]]]

ZOFHEXIE, [Tools] > [Options] > [Behavior and Appearance] > [Technical Support] #4717 %L
THNSNIZT N7 e —2ADPR— b BEESE ET, fERERDIN—RT 7 AL, KT dbgf
A REEBIEHESNDIGEIT, v R 7 AV DUGEITE LD ZE N HV ET,

contents [IX A7 07 NHDAL T LY OFREDIE 100>, T3y 7 N —RE N T HDITFEY
9% Off ICT 2 ERHVET, 7 74 /LMEIT Essentials T9~, crashsppt i% 072> 1 IZ T 243 HY
9, 7 74/VMEIX 1 TY, tracefile (ZBEFIET DT ALV NIND T 7 AN THDHLBENRHIET,

77 #/VMEIZ, Technical Support A 707 (ZF RSN T,

LTI, BREM 2o~ R 7 ANV ERLET, ZO77A/UIZ1E, FEEED cmmdXXX 2< 2K
L FORIE CER ELFEE T D set"a~< R "source" a2~ RV g £ CWVEd, I~ K77 AL
WNO"#' TEEEDITIX, A ML TN ET, o7 T 7 AV IND/ AT Windows DD T
D, XA BN EINAD I, NI ATy a"\"TIERK T4V —R ATy =" " BME I T

WHZEITHERLTIZEN,

# RAOTrY=IME eV =M RARKL T TRV NI — Aa— RO BIEDIRRED
# SN DINTLET, KIT, 2 DOLVR—NEEEZTV LR T 7ANDD (RO D% E & i O
# gui RENSL)VH T HZLIEY, 2 DOLR—( AR LET, LR—FNREDTZEARY AR

# 13X, ../imagix/user/user cmd.txt ZZML TIEIVY,

cmmdOpenProject c:/test/projects/project 33.4D
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cmmdRegenerateProjectData

set dfgRpt (Unused Variables.global) 1

cmmdReport Variable Flow Checks..Unused Variables c:/test/rpt/uv.txt
set dfgRpt (Recursive Functions.order) alpha

cmmdReport Function Flow Checks..Recursive Functions c:/t/r/rf.txt

$ 2B/BHOT OV MEREET, 1 2Oav K77 AV TEEO 70 = MM TEEY,
# LW aYx /MBI S, BIER N TS T ey 7N B ET,

# TV ISR AN ARG EIN TN A, SR A LRI ET A,
cmmdOpenProject "c:/test/projects/space dir/project 600.4D"

FTRTOUVR—MAERLET, BIEOav U R 7 AVEYLIET D, rpt_settings 77 A/V%&
BEARIABFT (source ZMHH) . ZAUL C/CH+D " #include" SUTHY L ET,
rpt_settings 77 AL, IO~ K77 AV THAS NS —BOL R — N EETEE
T T D" set" AV RREFEENLZERHVET, AT L YR —b~DA R — %
BT D), LAR— e csv JTBAUTHAILET,

# I SREAN—ARE ENDHTD | BIAFEERAT20ERHVET,

source c:/test/reports/rpt settings

set vtgPrint (Format) csv

cmmdReportMultiple "c:/test/space dir/reports"

H = H= H

# T YT HIC fprint £ FEROXLEERLET,

cmmdDebug Essentials 1 c:/test/trace.log

dbgf About to start report export - format is $vtgPrint (Format)
cmmdDebug Off

# Imagix 4D ~DWiA7R—F([Report] > [Import])ZA[EEIZL, T XTDOIHRILE

# AT ETERSHETOUT ILED TS =2 a IReS A7, FFEDL R —Me . 4dr

# LAR—FELTEMLET, LR—MBAES TR AN LI, Asc1T TERAM AL ET,

set vtgPrint (Format) ASCII

cmmdReportExport Source Checks..Expressions "c:/test/space dir/expr.4dr"
cmmdReportExport Task Flow Checks..Reentrant Functions "c:/t/s d/rf.4dr"

# HTML R¥=a A MAERKL ET, .. /imagix/user/doc_gen 7 AL Zh72*bmy style.dgn
# LUIDARZA N = e L T, R a A Ol a TV 2L £, A1/ SR A=
¥ BENDSGE . BINMEEN TN ERHYET,

set dcgOptions (Style) ApplyDocGenSheet

set dcgOptions (DocGenSheet) my style

cmmdDocument "c:/test/space dir/demo.4DD"

2FZBBDOa~w L R77ANDF T IL, BEIIEE O —RE VRO —EE L CEITSNDEE 2
OIET, BH2—VREETHEE, Imagix 4D T —H_R—ANEHTOIREETHY , FEF ITHS T —F
INDZEIZEZS L TLED,

# ENARENDT—RERT o =M BHEET,

cmmdOpenProject c:/test/projects/project dev.4D

# V= AA—ROBIEDON—Ta ZEHTLET, ZIUCE o T, 7 rY= MK EID L&

# Imagix 4D T —FN—ARNEHOY —Aa—RZEE£L, GEHIcn—RFENET,
cmmdRegenerateProjectData

# ANV I ADT —HEFHEALET, Imagix 4D D7V I A XN Very Large I[ZFRESH
# QIR FHRE D AN Y I RINT A AT DT — AR =R RGNS DD T, T =7 N3 K]
# BRI EEICHFITAET DU ETHVEE A,

cmmdCalcMetrics
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Flow Check LR —hDW O N EHIBNCH SN COBEE AT, L FIOR T~ R 7 7 AV E R
R AR CEHAL LR =77 A A AT U OBy ar ORNICREIZL R — R 77 A1
R—RC&, 22— PRI IR =TI BT TL L,

FENVRSNDA—F R T T ry =M REET,

cmmdOpenProject c:/test/projects/project dev.4D

# VA —ROBTEON—Va BRITLET, ZIUZE- T, ey MR EIBI T L&

# Imagix 4D T —FX—ANKHFHODY —Aa—R&EFKL, HEHIZn—RInET,
cmmdRegenerateProjectData

# Imagix 4D ~DWif 7" —h ([Report]>[Import]) & AREIZL, TXTCOILRNEX T f&
# TRARSETCOUL ILEDTE S —ailx & ®57DIs, FEEDL R —NMe . 4dr LAR—RELT
# AERLET, LR IMIEGICHAIADEIC, ASCIT BAEHEHLET,

set vtgPrint (Format) ASCII

cmmdReportExport Task Flow Checks..Reentrant Functions "c:/t/s d/rf.4dr"
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1188 C./Y—> v F I D

Grep Tool 74> K7, Filter A==—® Add #4717 72L | Imagix 4D CIEIEIFREEEN N —r~
Y F T EHNTa—FREDRE—AE BT D FHNEIIARTE N ET, ZOXI7HERET
X, 20D NRE—0 =T U T 74— 2095 L OWMEHIIET, glob AZ AN DR —~yTF T
1 Unix &=L TS TODRIHIZ 7 7 A VA RBICE L E -, IEHRB Y —r~yF 71T
Unix @ regexp 2~ R TS TODEIRIZBE L £,

glob RAAJLIRB—2TyF oY

glob AZ A/, 572 DDA OI LTIV ERIZH T2, J0HINRHET, glob AZA/LD/H
—UNZE RO IR IR LT B O DTN TEET,

? RO 1 Fe~yFLET,
* R O L & L) DLFN DR oT LFHN e~y T LET,
[chars] [INITHR ESN T2 XCFOEA (chars) DIHLOATLED 1 XF-L~vyF LE

T, CEOEA DN a-b DIERD STFEFINRE FF T
UL, anbbETO (@, bbETe) WT IO LT~y TFL
ESch

\x XFEXxEeyTLET,
ERRB/E—2yFT

ERFIIL, ST 2D RXDOHIBTIVEMERFZHITT I, IVRNTT, 2O TIE, L TOR
A2 AW TRE—r O~ TF 753,

ERFHLIT ALEME QAL ET) O — AN DR 5T-HDE W I IO — R~y TF 50
DHEIZ, 2FHDOE —AwyTFFTHHD, 3FHDOE—REVYTTHHD - LT NI —
L~ FLET,

=&, TRADZETHY | JEIZLoTUT*, +, FIX RIS EET, *BHE I T DY
BIIE, ZOT RAE2y T THLODEE (0 HL & Te) DFE~yTFLET, +DBHEISFNTNDY
BT FOTLE=yTTH5HOD LHLL_ EDFIE<oT LET, 23NV TNDBEEEIZIE, D
TRl T THHD, HDHNIZELFSE~wyT LET,

ThAEX, AFRINCTHENZIERFRE (ZOEREBL~yTTHHDE~yTF) LV (TRLsi) ., .
EED 1 XFE~yT)  NANLFINORADZELTH e~y TF) . $ (AT SLTFFNDFe % DZE LT
Fll<oTF )  \EZDHEIHK 1 LF (ZFOXLFE~yT ), HBOINIMEDIRN 1 LT (D LFLE~
IF)VDILTT,

LoD T [ITCHENTZOL>OXCFHN O LT, @FIxF 0O LFINEGEFNHEED 1 LT~
vFLFET, LFHIPNTIEEDLG AT, BVOLFINEFNRAMER D 1 CFe~yTF LET, X
FHNDIRINZ-TOIRDST2 2 LT NHDHEITIE, ASCH 2—R _ETENLD— O CF LA 5D
LFFETOTRCOXLTFTEYyFLET (F2E2IL, [0-9FT R To 10K T~y T LET), LT
SNV T TN E D DR, ENERPIDOLTFAILET (BN T HZEIEARE) , VT IV -5
DI, FnaE R IREO XTI ET,



